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Copyright

 

© 2000 Cycore AB. All rights reserved. All rights to the trademarks/tradenames 
Cycore, Cult Effects and Cult shall remain at all times the sole property of 
Cycore. All other trademarks are the property of their respective companies. 
The Cult Effects software described in this document is furnished under a 
license agreement. The software may be used or backed up only in accordance 
with the terms of the agreement. Information in this document is subject to 
change without notice and does not represent product specification or 
commitment on the part of Cycore AB. No part of this document may be 
reproduced, transmitted, transcribed, stored in a retrieval system, or translated 
into any language in any form without written permission from Cycore AB. 
Adobe and After Effects are registered trademarks of Adobe, Inc. All other 
product names mentioned in this document are used for identification purposes 
only and may be trademarks or registered trademarks of their respective 
companies. Registered and unregistered trademarks used herein are the 
exclusive property of their respective owners. Cycore AB makes no claim to any 
such marks, nor willingly or knowingly misused or misapplied such marks.
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General explanation

 

CE 3D Glasses combines left and 
right 3D views for stereoscopic 
viewing. Images for each view can be 
produced by 3D programs or 
stereoscopic cameras. Several 
methods for 3D viewing are available. 
Use Stereopair or cross-eye for on 
screen viewing, interlaced for 
polarized or shutter glasses and 
anaglyph for colored glasses. Controls 
are available for adjusting the 
convergence point and removing 
shadow effects common in anaglyphs.
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Controls

 

Left View

 

Select the layer you wish to use for the left view.  

 

Right View

 

Select the layer you wish to use for the right view.  

 

Note:  You only need to apply CE 3D Glasses to one layer in a 
composition. If a second layer is used for one (or both) of the Left and 
Right Views, simply select it from the pop-up menu. The second layer  
need only to be imported into the same composition, it does not need  
to be visible (i.e. It does not need to have its video turned on in the 
Time Layout window). The layers to be combined should be of the 
same size.
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Convergence Offset

 

This control is a calibration tool for minimal correction of the view offsets. Use 
Convergence Offset to realign un-calibrated camera views of rendered 
material. If your original footage was shot with correct convergence, there is 
no need to change this value.

Regular photos or images rendered from 3D programs which lack stereo 
alignment are generally mis-aligned and require a negative Convergence 
Offset value

 

Un-calibrated camera Left Right

Calibrated camera Left Right

 

Note: This control should not be animated. It is not subpixel accurate, 
and will result in an unpleasantly jumpy animation.
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To adjust the Convergence Offset do one of the following:

1. Adjust the Convergence Offset slider in the Effect Controls window 
(preset to values between –60 and 20).

2. Click on the underlined Convergence Offset value and enter an amount 
between -128 and 128 into the dialog box.

 

See More on Convergence section at the end of this document for more 
information. Also visit the web links (listed in the Tips section at the end of 
this document) for reference information on how to shoot or create 
stereoscopic views.

 

Swap Left-Right

 

Check this box to swap the views selected above.  

This option is also very useful if your views have been flipped. This happens 
when the left and right source images have been mixed up, or while using the 
interlaced option when the source images have moved vertically

 

3D View

 

Select  one of the following rendering modes for viewing from this pop-up. 
The default mode is Stereo Pair.

 

Stereo Pair

 

Stereo Pair is useful for quick reference. This option scales both layers to fit 
side by side within the layer’s bounding box. Swap Left-Right to create cross-
eyed vision. 

 

Note: Convergence Offset is disabled when this option is selected.  

 

Interlace Upper L Lower R

 

This option takes the upper (first) field from the layer you have selected as 
the Left View, and the lower (second) field from the layer you have selected 
as the Right View, and combines them into a single or a sequence of 
interlaced frame(s).
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Use this option to produce material to be viewed with Polarized or LCD 
Shutter glasses, where video fields represent interleaved Left and Right 
Views. Use Swap Left-Right to switch fields. The most common choice is Left 
in Upper (first) and Right in Lower (second) field, however, it is best to check 
with the projection manufacturer before rendering.

The Comp and source must have the same vertical size to avoid problems 
with flipped views. One pixel difference gives the same result as moving the 
position one pixel vertically.

 

Anaglyph Options

 

The following options are anaglyphs. Anaglyphs are viewed with colored 
glasses, red and green or red and blue. They are produced by combining two 
views into one, colorizing each view with respective colors. This creates a 
stereoscopic effect when viewed with the colored glasses.

When working with Red and Blue images, the blue color in red and blue 
glasses is actually cyan, not blue. Red and cyan are complementary colors, 
producing the best separation because they filter each other out more 
efficiently. 

When working with Red and Green images, it may appear that the green is 
somewhat 'weaker' than the red. However, when the images are viewed with 
red and green glasses an even result is produced because green has a 
higher luminance value than red.

 

IMPORTANT: Notes About Fields...

• Any floating pixel value for position, 0.xxx completely ruins the fields. 
For example, if the layer’s position is shifted even slightly—i.e 
position coordinates should be set at 320, 240, but instead are set 
to 320, 239.3.

• Because the filter creates interlaced frames, it is important to render 
without any interlace option selected

• If your left and right source images are already interlaced you’ll need 
to de-interlace them before using CE 3D Glasses, to avoid field mis-
match.



 

CE 1.5 Manual

www.culteffects.com 10

 

Red Green LR

 

Applying Red Green LR will convert the layer you have selected for Right 
View to red, and the layer selected for Left View to green. The filter uses the 
Luminance values of each layer in performing this conversion.  

 

Red Blue LR

 

Applying Red Blue LR will convert the layer you have selected for Right View 
to red, and the layer selected for Left View to blue. The filter uses the 
Luminance values of each layer in performing this conversion.  

 

Balanced Red Green LR

 

This option is very similar to Red Green LR, but adds the option to balance 
the colors in order to reduce shadows or ghosting effects.  

The balance is calculated on areas where details from one view shows 
through to the other. Balancing reduces this effect. Setting Balance at a high 
value will reduce the overall contrast.

 

Balanced Red Blue LR

 

See Balanced Red Green LR.  

 

Balanced Color Red Blue

 

Balanced Color Red Blue converts the image into a 3D view using the original 
image’s RGB channels. This option allows you to try to maintain the image’s 
original colors. To create the 3D view, colors of each view are balanced 
against each other. 

As a result Balance set at 0.0 will give no 3D depth whatsoever. Conversely, 
setting the Balance too high will result in overly saturated output. The balance 
produced by this option is by default the 'ideal' value, but may need 
adjustment depending on the source footage.

This option has been known to produce shadows and ghosting effects.  If you 
are not completely satisfied with the resulting image after balance has been 
applied, it may be necessary to slightly de-saturate the image before applying 
the effect. This option is best suited for photos and film, rather than CG 
images.  If you are using CG images, try raising the black level of both views 
before applying the effect.  In both of these cases, the view layers must be 
pre-composed to perform these modifications.
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Only Balanced Color Red Blue can maintain color information from the 
images. All other (anaglyph) options maintain only luminance values from 
images.

 

Balance

 

If a Balanced 3D view option has been selected, the Balance control is 
enabled. Balance helps to reduce shadows, or ghost effects often visible in 
anaglyph movies. 

Ghost effects are produced when the Luminance of one color value exceeds 
the other to such a degree that you can actually view that color through the 
wrong lens of your anaglyph glasses. For example, viewing red through the 
blue lens. Whenever a balanced 3D View is used, it is best to view or “test” 
the output on the final output media when adjusting the Balance value. If 
Balance is set too high, a reversed shadow may appear.  

 

Tips: CE 3D Glasses provides an excellent way of checking your 3D 
animation for unnecessary shadows (anaglyph only) and convergence 
mistakes using colored or polarized glasses. This can be both a time and 
cost effective method of  compositing stereoscopic footage.   

 

There are countless resources for more information about working with 
stereoscopic images on the internet. Search for 

 

"3D Glasses"

 

 or try some of the 
following links as a starting point:

http://www.stereoscopy.com/

http://www.3dglasses.net/

http://fireworks.rainbowsymphony.com/

http://www.stereo3d.com/main.htm

http://www.webring.org/cgi-bin/webring?ring=2eyes&id=26&list

If you are creating CG 3D material, refer to your software manual for more 
information. Many 3D applications document how to create stereoscopic output.

 

REFERENCE: For more information on using CE 3D Glasses see the section 
More on Convergence at the end of this document, or the Basic Tutorial for CE 
3D Glasses. 



 

CE 1.5 Manual

www.culteffects.com 12

 

More on Convergence

 

The examples below illustrate what happens when two images, shot with a 
regular camera are composited as a stereoscopic image. When compositing, 
the images selected for the left and right views must be offset (using 
Convergence), just as the camera positions were offset when they were 
recorded. If the images are not offset, the proper depth will not be perceived 
by the viewer. All objects in the resulting view will appear as if they are 
positioned in front of the screen on which they are projected. This result is 
incorrect, and will cause severe eye strain for the viewer.

 

Left image Right image Camera positions for left and right images

Mis-aligned views Objects appear in front of screen

 

This mis-alignment (or lack of offset) can be seen in the sun in the top left corner 
of the ”Mis-Aligned Views” illustration. Notice that the sun has the same position 
in both the left and right views. When viewed with 3D glasses, the viewer’s eyes 
converge on the screen surface (the perceived depth of the sun). All other 
objects will appear even closer – the road, possibly even passing through the 
viewer’s head. Objects appearing closer than halfway between the screen and 
the viewer’s eyes will often not be recognized at all.
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Corrected view Objects appear behind the screen

 

Use the Convergence control to offset the images for the intended view. The 
desired offset amount is determined by the distance between the cameras when 
shooting and the size of the screen that the images will be projected upon.

In the final illustration “Corrected View”, with the proper offset amount, notice that 
the road converges at its closest point. This will result in it appearing to stretch 
from the surface of the screen into the distance beyond. The sun, now separated 
(or offset), leads the viewer’s eyes in a more parallel direction, giving the sun a 
virtual depth far beyond the surface of the screen. This is the desired result.
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General Overview

 

CE Basic Fill is a non-destructive 
paint tool that allows you to fill a 
selected area with solid color. It 
works much like the paint bucket tool 
in Adobe Photoshop.

Using Basic Fill’s controls, select 
both an area to fill and the color to fill 
it with. Both the Fill Point and Color 
can be animated. Control the Toler-
ance and Edge Behavior of the filled 
area , and search for “leaks” using 
View Threshold. Great for colorizing 
cartoon-type outlined drawings or 
replacing selected areas of color in an 
image.



 

CE 1.5 Manual

www.culteffects.com 16

 

Controls

 

Fill Point

 

Use the Fill Point control to select the area of the image that you wish to fill 
with the new color. 

Although the Fill Point control uses X,Y coordinates for it’s setting, these 
coordinates are important simply as a reference to the pixels located there. 
The Fill Point extracts an average value by sampling the RGB and alpha 
information from the pixel(s) located at that position coordinate.

The Fill Point control samples between 1 and 4 pixels’ RGB and alpha values 
(depending on the exact placement of the control over the pixel(s)). An 
average pixel value is extracted from this sampling, resulting in the Fill Point 
value. 

This value is then used to determine the way the area gets filled. The Fill 
Point acts as the point where the Fill Color is dropped; the point of origin for 
the fill Color. The color will spread outwards from this point as far as 
Tolerance will allow. The Fill Point value, the option chosen in the Fill Selector 
pop-up menu, and the value set for Tolerance all contribute how the area will 
be filled. (See Fill Selector and Tolerance controls for more information.)

To set the Fill Point do one of the following:

1. Click on the Fill Point cross hair and drag over the area of the image you 
wish to sample. Click once to place. Click and drag the Fill Point control 
to change the selection.

2. Click on the underlined X, Y coordinates and enter new coordinate values 
into the dialog box.

The Fill Point control
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Fill Selector

 

Use this pop-up menu to select the type of information upon which you will 
base your fill area. This menu contains five options.

The first two options look at the RGB and alpha channels’ information for the 
Fill Point value.

 

Paint Bucket

 

Looks at both RGB and alpha values of the Fill Point selection, and fills the 
area where it finds pixels with similar RGB and alpha values while taking the 
Tolerance setting into account. 

 

Opaque area filled Transparent area filled

 

Straight Color 

 

Looks only at RGB values of the Fill Point selection, and fills the area with 
similar RGB values, again taking the Tolerance setting into account.

 

Opaque area filled Transparent area filled
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The following three options look only at the alpha information for the Fill Point 
selection.

 

Transparency

 

Fills only transparent areas in the alpha channel.

Result: When the Fill Point is positioned over a transparent area in the 
image’s alpha channel, that area is filled with the new color. No fill will occur 
when the Fill Point is positioned over an opaque area of the image’s alpha 
channel.

 

Opaque area filled Transparent area filled

 

Opacity

 

Fills only opaque areas in the alpha values.

Result: When the Fill Point is positioned over an opaque area in the image’s 
alpha channel, that area is filled with the new color. No fill will occur when the 
Fill Point is positioned over a transparent area of the image’s alpha channel.

 

 

Opaque area filled Transparent area filled
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Alpha Channel

 

Fills either transparent or opaque areas of the alpha channel.

Result: When the Fill Point is positioned over either transparent or opaque 
areas of the image’s alpha channel the respective area is filled with the new 
color.

 

Opaque area filled Transparent area filled

 

Note: Basic Fill will have minimal impact on a Solid layer.
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Tolerance

 

Use the Tolerance control to adjust the size of the area that gets filled with 
the new color. This value is based upon the option selected in the Fill Selector 
pop-up menu. Higher Tolerance values allow a larger area to be filled by 
expanding the range of similar values to include more pixels. Lower tolerance 
values reduce the area that is filled by searching for similar values within a 
smaller range.

To set the Tolerance value do one of the following:

1. Use the Tolerance slider in the Effect Controls window (preset to values 
between 0 and 255).

2. Click on the underlined Tolerance amount and enter a value between 0 
and 255 into the dialog box.

 

Tolerance set to 25 Tolerance set to 115
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View Threshold

 

The View Threshold check box, when checked, displays the threshold values 
in black and white (based on the tolerance value) in the Composition window. 
The white areas within the Tolerance range will be filled with the selected fill 
color. This is especially useful in tracking leaks. When there is a small gap, 
the color can flow over and fill areas not intended to be filled.

If a leak is found, try reducing the Tolerance value, or retouching your image. 
Use CE Paint, or the application in which it was created to draw a more 
defined boarder between the areas.

 

Leak in target fill area View treshold on. Leak is visible

 

Edge Behavior

 

Select the treatment of the edges of the filled area from the Edge Behavior 
pop-up menu. 

Use the dynamic slider below the Edge Behavior pop-up to adjust the various 
edge treatments’ respective values. Each of the options has a corresponding 
slider except for AntiAlias.

 

AntiAlias

 

Antialiases the edges of the filled area.

 

AntiAlias with Tolerance 5 AntiAlias with Tolerance 150
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Fade

 

Creates a gradually faded edge for the filled area.

Use the Fade Softness slider to soften the faded edge by fading out the pixels 
with values furthest from matching the Fill Point value. Higher Fade Softness 
values will result in a more gradually disappearing edge.

 

Fade set to 1 Fade set to 10

 

Bleed

 

Creates a bleed or overflow of the filled color along the edge of the filled area.

Use the Bleed Radius slider to set the amount of bleed beyond the fill area 
(in pixels).

 

Bleed set to 1 Bleed set to 6
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Unbleed

 

Contracts the edge of the filled area. (The inverse of bleed.)

Use the Unbleed Radius slider to set the amount of that the fill area is 
reduced (in pixels).

 

Unbleed set to 1 Unbleed set to 6

 

Border

 

Renders the fill only along the border of the selected area.

Use the Border Width slider to control the width of the border (in pixels).

 

Border set to 1 Border set to 6
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Invert Fill

 

Use this check box to invert the fill area. All currently filled pixels are returned 
to original colors and transparency, and unfilled pixels are filled using current 
settings.

 

Invert Fill off Invert Fill on

 

Color

 

Choose the Color that will fill the selected area. Click on the color swatch to 
use the Color Picker or the click on the eyedropper to sample a Color from 
an image on the desktop.

 

Opacity

 

The Opacity control adjusts the transparency of the filled area. 

To set the Opacity value use the Opacity slider in the Effect Controls window, 
or click on the underlined Opacity value and enter an amount between 0 and 
100 in the dialog box.

 

Transfer Mode

 

Choose from various Transfer Modes to select the operation between the 
new fill color and the original layer. These Transfer Modes are identical the 
ones in the After Effects Modes panel with the exception of Fill Only. Use the 
Fill Only option if you don’t wish to composite the fill with the original image. 
Only the fill itself will remain visible.
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REFERENCE: For more information on using this effect and its controls see the 
Basic Tutorial for CE Basic Fill.

IMPORTANT: If you apply multiple instances of CE Basic Fill to a 
layer, be sure not to set more than one to use “fill only”. This will result 
in only the first application of the filter being displayed. The fill only 
option knocks out the original image changing the fill point selection 
for the following applications of the filter.



 

CE 1.5 Manual

www.culteffects.com 26

 

CE Cell Pattern

 

Contents

 

Contents ............................................26
General Overview .............................27
Controls .............................................28

Cell Pattern ...................................28
Invert .............................................29
Contrast ........................................29
Overflow ........................................31
Disperse ........................................32
Size ...............................................33
Offset ............................................34
Tiling Options ................................35

Enable Tiling .............................35
Cells Horizontal .........................35
Cells Vertical .............................35

Evolution .......................................35
Evolution Options ..........................37

Cycle Evolution .........................37
Cycle .........................................37
Random Seed ...........................38

Example ............................................39
To Create a Seamless Loop .........39



 

CE 1.5 Manual

27 www.culteffects.com

 

General Overview

 

CE Cell Pattern generates cellular 
patterns based on cellular noise. Use 
this filter to create static or moving 
background textures and patterns. 
Use these patterns as textured 
mattes, transition maps, or  as a 
source for displacement maps.
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Controls

 

Cell Pattern

 

Choose the type of cellular pattern you wish to use from the Cell Pattern pop-
up menu. 

Some notes about Cell Pattern types:

• The first five options in the menu render faster than those that follow. 

• Types marked HQ (High Quality) are similar to the main options with the 
same name, but render the pattern with higher precision. 

• Mixed Crystals is only available as an HQ option. 

• The Plates option shifts the lightness of the Cell Pattern while evolving, 
Static Plates keeps a constant lightness value. 

 

Bubbles Crystals Plates

Pillow Crystallize Tubular
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Invert

 

The Invert check box allows you to invert the Cell Pattern. Check this check 
box to create a negative or inverse of the cellular noise layer. Black areas 
become white, white areas become black

 

Invert  off Invert on

 

Contrast

 

The 

 

Contrast

 

 control adjusts the contrast of the Cell Pattern layer when the 
following Cell Pattern types are selected: Bubbles, Crystal, Pillow, Mixed 
Crystals and Tubular.  

The default Contrast value is 100. Higher contrast settings create larger, 
more sharply defined areas of black and white in the noise, generally 
revealing less subtle detail. Lower contrast settings result in more areas of 
gray, softening or muting the noise. 

 

Note:  The layer’s contrast is altered by the option selected in the 
Overflow pop-up menu. (See Overflow below for further information.)
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High contrast Low contrast

 

As noted above, the Contrast Slider is a contextual control. When any of the 
Plate or Crystallize options are selected in the Cell Pattern menu, this control 
becomes a 

 

Sharpness slider

 

. Sharpness defines how sharp the edges 
between cells in the pattern will appear. Increasing the Sharpness value 
creates more defined borders between the individual cells. As Sharpness is 
reduced, the edges of the cells appear softer, almost feathered.

 

High sharpness  Low sharpness

 

To adjust the Contrast/Sharpness do one of the following:

1. Use the Contrast/Sharpness slider in the Effect Controls window (preset 
to values between 0 and 600).

2. Click on the underlined Contrast/Sharpness amount and enter a value 
between 0 and 10,000 into the dialog box.

Animating this control allows you to increase or decrease the Contrast  or  
Sharpness of the layer over time. 
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Overflow

 

The Overflow control offers three options. Each of these options uses a 
different method of re-mapping values that fall outside of the grayscale range 
of 0-255. (This occurs when Contrast is set at values higher than 100).

 

Note: This control is disabled when Sharpness based cell patterns are 
selected.

 

Clip

 

Any value above 255 is displayed as pure white. Any value below 0 is 
displayed as pure black. 

Result: Contrast amount controls how much of the image falls outside of this 
range. Higher Contrast amounts will result in a mostly black and/or white 
image with less gray area. Therefore, less subtle cellular detail is displayed 
at higher contrast settings. If you are using this layer as a luma matte, the 
matte will have sharper, more defined areas of transparency.

 

Soft Clamp

 

Re-maps values on an infinite curve to force all values to fall inside of the 
range. 

Result: Contrast appears reduced. The cells appear mostly gray with very 
few areas of pure black or pure white. If you are using this layer as a luma 
matte, the matte will contain very subtle areas of transparency.

Clip

0

255

Original value Clip values

0

255
Soft Clamp

Original value Soft Clamp values
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Wrap Back

 

Uses triangular re-mapping of values above 255 or below 0 to fold back into 
the range.

Result: Appearance of more defined subtle detail when Contrast is set above 
100. If you are using this layer as a luma matte, the matte will reveal more 
detailed/textured areas of transparency.

 

Disperse

 

The Disperse value defines how much the selected pattern is “dispersed”. It 
controls how randomly the pattern is drawn, affecting the angle of the cells as 
they sit next to each other. Lower Disperse values result in more uniform or 
grid-like cell patterns.

 

Disperse 0.0  Disperse 0.5 Disperse 1.0

 

To adjust the Disperse value do one of the following:

1. Move the Disperse slider (preset to values between 0 and 1.00).

2. Click on the underlined Size amount and enter a value between 0 and 
1.5.

 

IMPORTANT: If you set the Disperse value above 1.0, set  the layer 
to best quality to avoid rendering artifacts. 

0

255
Wrap Back

Original value Wrap Back values
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Size

 

The Size control adjusts the size of the cell shapes. Default size is 60.

 

Small size Large size

 

To adjust the Size do one of the following: 

1. Move the Size slider (preset to values between 25 and 600). 

2. Click on the underlined Size amount and enter a value between 20 and 
10,000.

Set keyframes for Size to increase or decrease the scale of the cell shapes 
over time, causing them to grow or shrink.
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Offset

 

The Offset control determines the portion of the cell pattern that is visible in 
the Composition window.

Because the cell shapes used to construct the Cell Pattern are infinite in all 
directions, what appears in the Composition frame at any given time is only 
a small portion of the entire cell shape. With the Offset control, the Comp 
window behaves like a fixed viewing area, and the Offset control allows you 
to reposition the cell shapes within that view. Animating the Offset control 
repositions the cell shapes, bringing a different portion of it into view. 

 

Offset 
control point                        

Anchor point 

 

This control is especially helpful in animating the cell pattern to travel across 
the composition frame. Simply set keyframes for the Offset control.

To alter the Offset do one of the following:

1. Click on the Offset cross hair, position it the in the Comp window, and 
click once to place. Once it has been placed, click and drag to reposition 
it.

2. Click on the underlined Offset value and enter new X,Y coordinates into 
the dialog box.
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Tiling Options

Enable Tiling  

 

The Enable Tiling check box renders the cell pattern in seamless tiles. 
The shape and number of tiles is determined by the settings for Cells 
Horizontal  and Cells Vertical.

 

Note:  Enabling Tiling will increase render time.  

 

Cells Horizontal

 

Controls the number of horizontal cells on a tile.

 

Cells Vertical

 

Controls the number of vertical cells on a tile.

The cell Size and the Cells Horizontal and Cells Vertical amounts make 
up the size of the tiles. To determine the size of your tiles use the 
calculations below.

Tile width  = Cells Horizontal x  Size.

Tile height  = Cells Vertical x  Size.

EXAMPLE: To create a tile size of 256x256 pixels, set Size, Cells 
Horizontal and Cells Vertical to 16.

 

Evolution

 

The Evolution control effects subtle changes in the shape of the cell pattern. 
Animating this setting will result in smooth changes or “evolution” of the cell 
shapes over time. 

To change the Evolution setting do one of the following: 

1. Adjust the Evolution dial in the Effect Controls window.

2. Click on the underlined Evolution value and enter amounts for revolutions 
and degrees in the dialog box.
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In the case of Evolution (as with a few other effects’ controls, such as Twirl 
Angle in AE Twirl), the image continues to change with each added 
revolution. The appearance when set to a value of 0° is different from that at 
1 revolution, which is different from that at 2 revolutions, and so on. The 
Evolution state continues to progress infinitely at each new value. The only 
way to force the Evolution setting to return gracefully to its original state 
(necessary to create a seamless loop) is to use the Evolution Option, Cycle 
Evolution, explained below.

Set keyframes for Evolution to determine how much the cell shapes will 
“evolve” over the period of time allowed between keyframes. The more 
revolutions that are made within a given amount of time (between 
keyframes), the more rapidly the cell shapes will change. Large changes in 
Evolution values over a short period of time may result in flashing rather than 
smooth changes in the cell shapes.

 

 

IMPORTANT: Although the Evolution value is set in units called 
“revolutions”, it is important to realize that these revolutions are 
progressive. The term “revolution” usually refers to a setting that 
returns to the same value at the same point on the dial control every 
360°. For example, the value set at 0° usually appears the same as 
the value at 1 revolution (i.e. As with the transform property Rotation 
or the “Direction” control in AE Drop Shadow). 
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Evolution Options 

 

Because of the complexity of the cell shapes that generate the cell patterns, 
render time can be consuming. For this reason, the Evolution Options 
provide controls that allow you to render the effect for one short(er) cycle and 
then simply loop it to repeat for the duration necessary for your project.

 

Cycle Evolution 

 

Checking the Cycle Evolution check box creates a cycle of evolution that 
loops over the set amount of time. Cycle Evolution forces the evolution 
“state” to return to it’s starting point in order to create a looping animation.

Although copying and pasting Evolution keyframes will return Evolution 
to the same value, the animation will act like a ramp rather than a 
smoothly transitioning cycle, repeating itself as it interpolates between 
the keyframes. Use Cycle Evolution and the Cycle controls to create a 
smooth, progressive, non-repeating cycle (or loop segment).

This control can save a great deal of rendering time. Use it to create one 
short seamless evolution cycle (where the last frame matches up to the 
first) to be pre-rendered and looped as a new source layer in a 
composition, rather than setting Evolution to animate over a greater 
number of frames. (See Creating a Seamless Loop below.)

 

Cycle

 

Note: This control is only available when the Cycle Evolution check 
box is checked.

 

The Cycle value determines the number of revolutions (of the Evolution 
setting) that the cell pattern will cycle through before it repeats. The timing 
or speed of these Evolution cycles is determined by the amount of time 
allowed between Evolution keyframes.

 

Note: The Cycle control affects only the state (Evolution) of the cell 
pattern, not geometrics or other controls. (e.g. Two identical states 
of the cell pattern will not appear the same if viewed with different 
Size or Offset settings.)
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Random Seed

 

This control sets a unique random value from which to generate the 
noise.

Animating the Random Seed will result in flashing from one set of cell 
shapes to another (within that cell pattern type). For smooth transition of 
the cell pattern use the Evolution control.

 

Tip: Easily create new cell pattern animations, by re-using 
previously created Evolution cycles and changing only the Random 
Seed value. Entering a new Random Seed value alters the cell 
pattern without disturbing the evolution animation. The Evolution 
keyframes and Evolution Options can be left untouched.

 

For further examples of how to use the Evolution Options, see To Create a 
Seamless Loop (below), the Evolution Options Appendix and the Basic Tutorial 
for CE Cell Pattern.
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Example

To Create a Seamless Loop

Follow the steps below to walk through the Evolution Control and Evolution 
Options.

1. Set two keyframes for Evolution. 

2. Adjust the time allowed between keyframes, and the number of Evolution 
revolutions until you are satisfied with the animation of the noise.

3. Check the Cycle Evolution Check box.

4. Set a value for Cycle.

The evolution will now cycle the number of revolutions determined by the 
value set for Cycle. This cycle will take place within the time allowed for that 
number of revolutions between the Evolution keyframes.

Determine the value for cycle by considering the following: How much of this 
cycle do you need to render before it repeats? The length of your piece and 
your use of the cell pattern created will determine this. Do you need 5 
seconds of a non-repeating animated cell pattern? Is 3 seconds enough? 
You will want to choose the shortest length appropriate for your project to 
save rendering time.

IMPORTANT:
1. When using Cycle Evolution to create a seamless loop set 
Evolution keyframes using full revolutions only. Avoid using degrees, 
as partially completed revolutions may create hiccups in your 
seamless loop. 

2. Choose a value for Cycle that either matches or is evenly divisible 
by the number of revolutions set for Evolution. This will ensure that 
your cycle is able to complete full revolutions rather than partial ones, 
again, avoiding any glitches in the cycle.

3. If you have set keyframes for any of the other controls, you must 
return them to their initial settings at the point on the timeline where 
the cycle begins to repeat. Otherwise, these properties will not loop.
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A cycle is created. Initially, however, the last frame of a cycle is identical to 
the first frame. To create a seamless loop, you want to skip the last frame to 
avoid a duplicate frame in the loop. To do this, set the out point of the layer 
one frame before the last frame of the cycle. Continue following the 
instructions below. 

5. Move the time marker to the point on the timeline where your Cycle 
completes. (i.e., if your Cycle value is 2, find the frame on the timeline 
where your Evolution value is 2 revolutions.

6. Move the time marker back one frame.

7. Trim the layer’s out point at this frame.

8. Pre-render this layer, and import it into your project. 

9. Set this pre-rendered footage item to loop by selecting it in the Project 
window and choosing File> Interpret footage. Find the Loop field at the 
bottom of the Interpret Footage dialog box, and set the number of loops 
required for the duration of the layer within your project.

REFERENCE: For further examples of how to use the Evolution Options, see 
the Evolution Options Appendix and the Basic Tutorial for CE Cell Pattern.
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General Overview

CE Change Color HLS allows you to 
select a color in an image and change 
it to another color using Hue, 
Lightness, and Saturation values. 
Perform color changes either by 
transforming or interpolating into the 
new color. This filter is useful for 
quickly changing one selected color 
to another, while leaving other colors 
in the image unaffected. 

CE Change Color HLS offers flexibility 
and options unavailable in After 
Effects’ Change Color effect. These 
options include: Tolerance sliders for 
Hue, Lightness, and Saturation for 
exact color matching, and the ability to 
select the exact RGB values of the 
target color that you wish to change to.  
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Controls

From

Select the color that you wish to change. This selection determines which 
pixels will be affected by the color change. Click on the color swatch to use 
the Color Picker, or select a color using the eyedropper.

To

Select the color that you wish to change to. This control determines the target 
color for selected pixels. Click on the color swatch to use the Color Picker, or 
select a color using the eyedropper.

Change

Select HLS channels to be affected. The options are: 

Hue

Affects Hue only, leaving the original lightness and saturation untouched.

Hue and Lightness

Affects Hue and Lightness only, leaving the original saturation untouched.

Hue and Saturation

Affects Hue and Saturation only, leaving the original Lightness untouched.

All Channels

Affects Hue, Lightness and Saturation.
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Change by

Select the color change operation you wish to perform. The options are 
Setting to Color or Transforming to Color.

Setting to Color

Setting to Color performs a direct change of affected pixels to the target color.

Transforming to Color

Transforming to Color transforms affected pixel values towards the target 
color, using HLS interpolation. The amount of transformation depends on 
how close the selected (To) pixel color lies to the source (From) color, and on 
the value set for the Tolerance control. It is generally easier to use the Setting 
to Color option.

The images below have the same From, To and Tolerance settings

Original Set to Color Transform to Color
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Hue. Lightness and Saturation Tolerance

Use separate Hue, Lightness, and Saturation sliders to control the Tolerance 
values.  Higher Tolerance values allow more color values to be changed by 
expanding the range of similar values to include more pixels. Lower 
Tolerance values reduce the number of pixels that are changed by searching 
for similar values within a smaller range. Separate Tolerance sliders provide 
greater control in selecting the color range by allowing you to specify the 
amounts of the individual HLS tolerance properties.  

Note:  Use the View Mask option to better identify which pixels are 
affected.  

To set Tolerance values do one of the following:

1. Use the Tolerance slider in the Effect Controls window (preset to values 
between 0 and 100).  

2. Click on the underlined Tolerance value and enter an amount between 0 
and 200 into the dialog box.  

Original Default Tolerance Low Tolerance
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Softness

Adjusting the Softness control smoothes the edges of the selected “change” 
areas. Increasing this value creates smoother and more seamless transitions 
between areas affected by the color change and those left unaffected.

Softness 0 Softness 50 Softness 100

View Mask

Check this check box to view a grayscale mask of the color values. White 
areas indicate pixels that will be affected by the color change. Black areas will 
be left unchanged. Gray areas will be slightly affected by the color change.  

Default Tolerance Low Tolerance

Tip: To change from one color to the next over time it is necessary to 
first select the color you wish to change (using the “From” control). 
However, only the “To” color needs to be keyframed over time.  

REFERENCE: For more information on using Change Color HLS see the  Basic 
Tutorial for CE Change Color HLS.
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General Overview

CE Channeling is a combination and 
extension of the previous CE Set 
Channel and CE View Channel filters. 
CE Channeling allows you to extract 
and view channels in ways previously 
not available in After Effects. 

View a specific channel by setting 
“To...” and “From...” selections to the 
same option. (i.e. To view Lightness, 
select “From: Lightness” and “To: 
Lightness”.) Or, use CE Channeling to 
create an alpha from any channel 
selection.

Extract channel information using the 
“From...” and “To...” menu options. 
Once the channel information is 
extracted, it can be manipulated using 
adjustment filters such as After 
Effects’ HLS, Levels, Curves, Color 
Balance and/or Brightness Contrast. 
Apply a second instance of CE 
Channeling to set the channel back to 
it’s original state.
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Controls

Source Options

Click on the triangle to expand the Effect Controls properties for selecting 
Source Options.

Use 2nd Layer

Check this check box to manipulate a channel or value from another 
layer. If this control is left un-checked, the original layer is used.

Source Layer

Select a 2nd layer from the Source Layer pop-up menu. The 2nd layer 
must be in the current composition, but does not need to be visible (to 
have its video turned on). If the layer sizes differ, the Source Layer will be 
resized to match the size of the current layer.

From

The “From…” pop-up menu provides several options for selecting color or 
alpha values from the source.  Some of these options (such as RGB to HLS) 
do not require a “To…“ selection – it has already been set.  The “To…” menu 
is enabled when selecting an option that specifies only the color channel, 
alpha or HLS values you wish to shift.  

The “From…” menu options are as follows.

RGB to HLS

Transforms the RGB colorspace to Hue, Lightness, and Saturation.  

HLS to RGB

Transforms the Hue, Lightness, and Saturation colorspace to RGB.  
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RGB to YUV 

Transforms the RGB colorspace to YUV. 

Note: YUV colorspace is used in component video. YUV represents 
the Luminance in the Green values, the Luminance Difference 
between the Red and the Green values, and the Difference between 
the Blue and Green values.   

YUV to RGB

Converts YUV colorspace to RGB.  

Straight to Premultiplied:

Converts the alpha channel from Straight to Premultiplied alpha. Adding the 
transparency information to each of the visible RGB channels.  

The following options enable the "To" control.

Red 

Selects the Red Channel as the source channel.  

Green 

Selects the Green Channel as the source channel.

Blue 

Selects the Blue Channel as the source channel.

Alpha 

Selects the Alpha Channel as the source channel.  

Lightness 

Selects Lightness values of an image to use as the source.   
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Luminance 

Selects Luminance values of an image to use as the source. 

Saturation 

Selects the Saturation values (independent of Lightness) of an image to use 
as the source.   

Saturation Premultiplied:

Selects the Saturation values (including Lightness) of an image to use as the 
source. 

Note: Saturation Premultiplied is the way that we most often look at 
Saturation. Saturation is multiplied by the minimum distance to black 
or white (Lightness). For example, a dark or light blue pixel has less 
Saturation than a bright or “pure” blue pixel.

Min RGB:

Selects the lowest component of the Red, Green and Blue color channels of 
an image to use as the source.

Max RGB:

Selects the highest component of the Red, Green and Blue color channels of 
an image to use as the source.

To

If you have selected an option in the “From...” control that requires a 
destination channel, this control will be enabled. The option selected 
determines where the "From..." property should be written.

The “To…” menu options are as follows.

Red 

Applies selected values of the “From…” option into the Red Channel.
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Green 

Applies selected values of the “From …” option into the Green Channel.

Blue 

Applies selected values of the “From …” option into the Blue Channel.

Alpha 

Applies selected values of the “From …” option into the Alpha Channel.

Hue

Applies selected values of the “From …” option into the Hue values.  The new 
Hue values are combined with the existing Lightness and Saturation of the 
image.  

Lightness

Applies selected values of the “From …” option into the Lightness values.  
The new Lightness values are combined with the existing Hue and Saturation 
of the image.  

Saturation

Applies selected values of the “From …” option into the Saturation values.  
The new Saturation values are combined with the existing Hue and Lightness 
of the image to produce the result. Straight Saturation values are used here, 
rather than Premultiplied Saturation (which is combined with lightness) 
described in the "From" menu.

The following options erase the original image and write only the 
property selected.

Red Only

Applies selected values of the “From …” option into the Red Channel.  Other 
color channels are removed so that only the Red Channel is combined with 
the option selected. Use this option to view a selected RGB, HLS, Alpha or 
Luminance value in the Red Channel without interference from the Green or 
Blue channels.  
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Green Only

Applies selected values of the “From …” option into the Green Channel.  
Other color channels are removed so that only the Green Channel is 
combined with the option selected. Use this option to view a selected RGB, 
HLS, Alpha or Luminance value in the Green Channel without interference 
from the Red or Blue channels.

Blue Only

Applies selected values of the “From …” option into the Blue Channel.  Other 
color channels are removed so that only the Blue Channel is combined with 
the option selected. Use this option to view a selected RGB, HLS, Alpha or 
Luminance value in the Blue Channel without interference from the Red or 
Green channels.

Hue Only

Applies selected values of the “From …” option into the Hue values. The 
existing Lightness and Saturation values are ignored. The new Hue values 
are combined with 50% Lightness and 100% Saturation.

This option is helpful for viewing the Hue values without interference from the 
Lightness or Saturation values.  

Tip: Use Transfer Modes to apply this to an underlying layer.

Lightness Only

Applies selected values of the “From …” option into the Lightness values. The 
existing Hue and Saturation values are ignored. The new Lightness values 
are combined with 0% Saturation. With Saturation at 0%, Hue has no effect, 
leaving Lightness only. 

This option is helpful for viewing the Lightness values without interference 
from the Hue or Saturation values.  
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Saturation Only

Applies selected values of the “From …” option into the Saturation values. 
The existing Hue and Lightness values are ignored. The new Saturation 
values are combined with 0% Hue and 50% Lightness.

This option is helpful for viewing the Saturation values without interference 
from the Hue or Lightness values.

Invert

Check this option to invert the previously set values in the image to their 
opposites. This control performs various inversions based on the channel 
conversions selected in the “From...” menu.  

For the first four colorspace converters, checking Invert inverts the color 
channels.

For Straight to Premultiplied, it converts Premultiplied alpha to Straight alpha.

For the "From..." - "To..." options, it inverts the values being transferred.

Solid Alpha

Checking the Solid Alpha check box creates a fully opaque alpha channel 
throughout the layer replacing any original alpha channel in your image. This 
control is disabled if the "To..." property is Alpha or Alpha Only.

Tip:  Apply CE Channeling to an RGB image. In the “From…” option select 
“RGB to HLS”. Next, apply the After Effects Levels filter. Then duplicate CE 
Channeling, setting  the “From…” option  to “HLS to RGB”. This allows you 
to tweak the individual HLS channels by adjusting the Red-channel 
gamma, Green-channel gamma and Blue-channel gamma,  while viewing 
a histogram for each HLS channel (RGB-channel shows a histogram for 
HLS), and the RGB output at the same time.

REFERENCE: For more information, see the CE Channeling Basic Tutorial.
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General Overview

CE Checker creates checkered 
patterns.

Straightforward and easy to use, this 
filter allows you to quickly create 
checkered patterns for use as 
backgrounds, mattes, transition 
maps, or geometric texture.
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Controls

Anchor

The Anchor determines the point of origin or “anchor point” of the Checker 
pattern, based on X, Y coordinates.

To set the Anchor do one of the following:

1. Click on the Anchor cross hair and position over the desired area of the 
Composition window. Click once to place. An Anchor point control 
appears. To adjust the Anchor, reposition this point control.

2. Click on the underlined X,Y coordinates and enter coordinate values into 
the dialog box. 

Moving the Anchor point offsets the pattern

Gridsize From

Use this pop-up menu to select how to define the size of the Checker 
squares. The option selected enables the corresponding controls  (Corner, 
Width and Height).

Corner Point

Checker size and shape are determined by the spatial relationship between 
the Corner point and Anchor point controls.

Width Slider

Checker size and shape are determined by the value set for the Width 
control. The checker shape will be square, as the Width value is used to 
determine both width and height of the checkers.
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Width and Height Slider

Checker size and shape are determined by the values set for the Width and 
Height controls. Choose this option to set the width and height of the 
checkers individually.

Corner

Use the Corner point control to determine the size of the Checker squares 
based on the spatial relationship between the Corner point and the Anchor 
point. The position of these two points is used to define the size of the 
Checkers when the Corner Point option is selected in the Gridsize From pop-
up menu. 

To set the Corner do one of the following:

1. Click on the Corner cross hair and position over the desired area of the 
Composition window. Click once to place. A Corner point control 
appears. To adjust the Corner point, reposition this control.

2. Click on the underlined X,Y coordinates and enter coordinate values into 
the dialog box.

Gridsize defined using Corner point 
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Width

The Width control defines the horizontal width of the Checker squares. If 
Width Slider is selected in the Gridsize From pop-up menu, this value 
determines both the width and height of the Checkers. When Width and 
Height Sliders is selected in the Gridsize From pop-up menu this value 
determines the width only.

To set the Width value do one of the following:

1. Adjust the Width slider (preset to values between 2.0 and 200 pixels).

2. Click on the underlined Width value and enter an amount between 1 and 
4000.

Size defined using Width slider
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Height

Use the Height control to determine the vertical height of the Checker 
Squares when the Width and Height Sliders option is selected in the Gridsize 
From pop-up menu.

To set the Height value do one of the following:

1. Adjust the Height slider (preset to values between 2.0 and 200 pixels).

2. Click on the underlined Height value and enter an amount between 1 and 
4000.

Size defined using Width and Height sliders

Feather

Use the Feather Width and Height sliders to adjust the feather of the 
checkers. You can set Width and Height amounts individually. Set both Width 
and Height to the same amount for a uniform feather on all edges.

To set the feather amounts, twirl down the arrow next to Feather to reveal the 
Width and Height sliders and do one of the following:

1. Adjust the Width and/or Height slider(s) to set one or both Feather 
amount(s). The sliders are preset to values between 0 and 20 pixels. 

2. Click on the underlined Width and/or Height value(s) and enter a Feather 
amount between 0 and 400 into the dialog box.

Checker with Feather
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Color

Choose the color for the checkers. 

Click on the color swatch to use the Color Picker or click on the eyedropper 
to sample a color from an image on the desktop.

Opacity

The Opacity control adjusts the transparency of the checkered pattern as it is 
composited with other layers in the composition. 

To set the Opacity value adjust the Opacity slider in the Effect Controls 
window, or click on the underlined Opacity value and enter an amount 
between 0 and 100 in the dialog box.

Transfer Mode

Choose from various Transfer Modes to select the operation between the 
checkered pattern and the original layer. These Transfer Modes are identical 
to the ones in the After Effects Modes panel, with the exception of None, 
which renders the Checkers only.
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General Overview

CE Circle creates a customizable 
circle on the source layer. The 
various controls allow you to 
determine the size, position, and 
color of the Circle. Feather the edges 
and set it’s opacity.  Use this Circle as 
a solid colored graphic element or as 
a mask through which the source 
layer is revealed. Apply Transfer 
Modes to create interesting 
interactions between the Circle and 
other layers in your Comp. All controls 
can be animated by setting 
keyframes.
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Controls

Center

Use the Center control to set the center point of the circle using X,Y 
coordinates.  

To adjust this control do one of the following:

1. Click once on the cross hair and drag the mouse in the composition 
window to the point on the layer you wish to be the center of the circle. 
Click once to place.  A center point control appears at that location. Drag 
the center point control to a new location on the layer if you wish to make 
adjustments.  

2. Click the underlined X,Y coordinate values and enter coordinates 
numerically in the dialog box.  ( In After Effects the coordinates 0,0 
indicates the upper left corner of the comp.)  

Setting keyframes for the center control allows you to animate the position of 
the circle.  

Radius

The Radius control sets the size of the circle (from the center to the edge).  
The number entered for this control equals the number of pixels from the 
center to the edge of the circle. Use this control determine the size of the 
Circle.  

To adjust the Radius control:

Use the Radius slider in the Effect Controls window (preset to values 
between 0 and 600). 

Click on the underlined Radius amount and enter a value between –10,000 
and 10,000 into the dialog box.

Note:  If you set the radius to be larger than your original source layer, 
either portions or all of the Circle’s edge will fall outside of the 
composition frame (depending upon where on that layer you have 
placed your center point and how large the Radius amount is set).  
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Edge

Use these options to control the shape and edge treatment of the Circle. 

The control slider which appears beneath this pop-up menu, is contextually 
enabled, based upon which option is selected.

None

Renders a solid circular shape. The contextual control is disabled.

Edge Radius

The Circle becomes a ring. The width of this ring is determined by the 
difference in the values set for Radius and Edge Radius. The contextual 
control becomes an Edge Radius slider.

Think of Edge Radius as adding second circle centered over the first. This 
circle can be bigger or smaller, it’s size is defined by the Edge Radius slider 
amount. The space between this circle’s edge and the one defined by the 
Radius control, creates a ring. The more space allowed between the two 
circles, the thicker the width of the ring.

Use the Edge Radius control to define the inner or outer radius of the Circle. 

 

Radius

Radius

Edge
Radius
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Thickness

The Circle becomes a ring with specified thickness.The contextual control 
becomes a Thickness slider. Use the Thickness control to define thickness of 
the ring’s border. 

Example: Thickness set to 10.0, renders a ten pixel thick border.

To set the Edge Radius or Thickness value do one of the following:

1. Adjust the Edge Radius/Thickness  slider (preset to values between 0 
and 600).

2. Click on the underlined Edge Radius/Thickness value and enter and 
amount between 0 and 10, 000 into the dialog box.

Thickness * Radius

Renders a ring whose Thickness value is scaled by the Radius control. As 
the Radius value of the Circle is increased so is the Thickness value. This 
option links the Thickness to the Radius control, scaling both proportionally

Example: If Thickness is set to 10.0 and Radius set to 50.0, a ring with a five 
pixel thick border will be rendered. If Radius is changed 200.0,  the border 
scales to twenty pixels thick.

Thickness & Feather * Radius

Renders a ring whose Thickness and Feather amounts are scaled by the 
Radius control.

As the Radius value is increased so are the Thickness and Feather values. 
This option links the Thickness and Feather values to the Radius control, 
scaling all three proportionally.

Radius

Thickness
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Feather

Feather controls the amount of feather applied to the edge(s) of the Circle.  
Increasing this amount softens the edges of the circle, blending it with 
whatever appears behind it.  Decreasing this amount sharpens the edge of 
the circle.  

Note: Feather Inner Edge is disabled when Edge option is set to None, 
since there is no inner edge on a solid circle.

First, click the triangle next to Feathering to expand the Feathering 
Properties.  You can adjust the amount of feathering for both the inner and 
outer edge of the circle.  

To adjust the amount of Feather do one of the following:

1. Use the Inner or Outer  Feathering slider in the Effect Controls window 
(preset to values between 0 and 100).

2. Click on the underlined Feathering amount and enter a value between 0 
and 10,000 into the dialog box.  

Circle with Inner Feather 3 and Outer Feather 20
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Invert Circle

The Invert check box inverts the matte of the Circle. A solid circle becomes a 
transparent hole in a solid layer. 

Invert off Invert On

Color

Choose the Color that will fill the circle.  Click on the color swatch to use the 
Color Picker, or click on the eyedropper to sample a color from an image on 
the desktop.

Opacity

The Opacity control sets the transparency of the Circle.  Lower percentages 
allow more of the background layers to show through. This effect slider 
respects the opacity of the original source layer (set in the Transform 
Properties), maintaining that amount as its value at 100%. 

Set the Opacity for the circle by adjusting the Opacity slider or by clicking on 
the underlined Opacity value and entering a percentage into the dialog box.

Animate the transparency of the circle by setting keyframes for Opacity, 
causing it to dissolve in or out over time.  

Transfer Mode

Choose from various Transfer Modes to select an operation between the 
Circle and the original layer.  These Transfer Modes are identical to the ones 
in the After Effects Modes panel.   Use the None option to display only the 
Circle itself, without the original layer.
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CE Color Composite
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General Overview

CE Color Composite composites a 
new color solid behind the original 
source layer.  This filter quickly 
creates a new solid to composite a 
layer against. Choose the color of the 
solid, control the opacity of the source 
layer, the opacity of the solid, and 
apply transfer modes all within the 
effect’s controls. 

CE Color Composite saves you the 
tedious steps of creating a new solid, 
placing it behind the layer, 
precomposing the two layers, and 
switching to the After Effects Modes 
panel to apply transfer modes, by 
consolidating all of these steps into 
one simple effect. Additionally, the 
color of this solid can easily be 
animated by setting keyframes.
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Controls

Source Opacity  

The Source Opacity control sets the transparency of the source layer directly 
within the effect. This works just like the Opacity control in the time-layout 
window.

Set the Source Opacity by moving the slider to the desired value or clicking 
on the underlined Source Opacity value and entering an amount between 0 
and 100 into the dialog box.

Color

Choose the color of the new solid.  Click on the color swatch to use the Color 
picker or click on the eyedropper to sample a color from an image on the 
desktop. 

Animate the Color of the solid by setting keyframes for this control.

Opacity

The Opacity control sets the transparency of the solid.  

To adjust the Opacity move the slider to the desired value or click on the 
underlined Opacity value and enter an amount between 0 and 100 into the 
dialog box.

Transfer Mode

Choose from various Transfer Modes to select the operation between the 
original layer and the new solid.  These Transfer Modes are identical to the 
ones in the After Effects Modes panel.  

REFERENCE: For more information on using this effect and its controls see the 
Basic Tutorial for CE Color Composite.
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General Overview

CE Color Link is used to colorize one 
layer with the average pixel values of 
another selected layer.  This filter is 
useful for quickly finding a color that 
matches the color of a background 
layer.  

Use CE Color Link in combination with 
the masking features in After Effects 
to isolate a portion of a layer and 
average only those selected pixels 
when colorizing. When using layer 
masking, selected colors can be 
animated over time by keyframing the 
size and position of the mask shape. 
(See TIP: Using Masking with CE 
Color Link at the end of this section for 
a step by step tutorial.)
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Controls

Source Layer

Select the layer that you wish to sample colors from.  CE Color Link will 
choose your original layer if None is selected.

Note: If you select None, CE Color Link samples from the original layer 
taking into account any masking or other effects which have been 
applied. If the original layer’s name is selected from the pop-up menu, 
CE Color Link samples from the source layer before masking or effects 
are applied.

Sample

The Sample menu lets you select how colors will be sampled. Choose from 
the following options.

Original logo Original gradient

Average

This option averages all RGB values from all pixels in the Source Layer 
(except transparent pixels).  This is useful if you are selecting a specific 
region of pixels using the masking feature in After Effects.  

Average
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Median

Selecting the Median value finds the pixel value that falls in the middle of all 
RGB values in the Source Layer and applies it to the layer.  

EXAMPLE:  If 55% of the values are black and 45% are white, the Median 
value would be black (as opposed to the Average, which would be gray).

Median

Brightest

Finds the brightest RGB value, using lightness, and applies it to the layer. 
(Uses the Clip control.)  

Brightest no clip Brightest 15% clip

Darkest

Finds the darkest RGB value, using lightness, and applies it to the layer. 
(Uses the Clip control.)  

Darkest no clip Darkest 15% clip
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Max RGB

Maximum RGB finds the highest value of the individual RGB channels, and 
applies it to the layer. (Uses the Clip control.)  

Max RBG no clip Max RBG 25% clip

Minimum RGB

Minimum RGB finds the lowest value of the individual RGB channels, and 
applies it to the layer. (Uses the Clip control.)  

Minimum RGB no clip Minimum RGB 25% clip

Average Alpha 

Same as Average, except that it looks only at the alpha information. White is 
used for RGB. The resulting alpha channel is an "average" of  the alpha 
channel values in the layer. 

Average alpha
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Median Alpha

Selecting the Median value finds the pixel value that falls in the middle of all 
alpha values in the Source Layer and applies it to the layer. Same as Median, 
except that it looks only at the alpha. White is used for RGB.

Median alpha

Max Alpha

Max Alpha finds the highest value of the alpha channel, and applies it to the 
layer. (Uses the Clip control.)  

Max alpha no clip Max alpha 15% clip

Minimum Alpha

Minimum Alpha finds the lowest value of the alpha channel, and applies it to 
the layer. (Uses the Clip control.)  

Minimum alpha no clip Minimum alpha 15% clip
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Clip

The Clip value is used to disregard a percentage of the highest or lowest 
sampled target values. This is useful for reducing the influence of noisy pixels 
in an image. 

A single oddball pixel at a very high or low RGB or alpha value can quite 
literally “color” your results when using the Brightest, Darkest, Minimum and 
Max Sample modes. Use Clip to control whether or not to ignore these 
highest and lowest values.   

For example: If the Sample mode is Max RGB and Clip is set to 0%, a single 
white pixel in the Source Layer will cause the layer to become white. If the 
Clip value is increased, that single white pixel will be ignored, and the 
resulting sample value will be more accurate or “stable”.

To adjust the Clip value use the slider in the Effect Controls window or click 
on the underlined Clip value and enter an amount between 0 and 50 into the 
dialog box. A Clip value of 0 results in no clipping.

Stencil Original Alpha

Checking this box will stencil the original alpha channel of your layer over the 
newly sampled color. If you sample alpha, the result value will also control the 
transparency of the original alpha. 

Leaving this box un-checked will disregard your original alpha channel and 
fill the entire layer with the average colors of the layer you have selected.  

Opacity

The Opacity control sets the transparency of the color added to the original 
source layer.  Decreasing the Opacity value will blend the new color with your 
original layer.  

To adjust the Opacity value use the slider in the Effect Controls window or 
click on the underlined Opacity value and enter an amount between 0 and 
100 into the dialog box.
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Transfer Mode

Choose from various Transfer Modes in the pop-up menu to select the 
operation between the new colorized layer and the original layer. These 
Transfer Modes are identical to the ones in the After Effects Modes panel.

Note: Transfer modes are not available when averaging alpha channel 
values in the layer.  
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General Overview

Use CE Color Picker to sample a 
color that will be applied  to the 
source layer. CE Color Picker uses 
both sample point and adjustable 
radius controls to determine the exact 
amount of pixels used when sampling 
an averaged color. Use the color 
averaging options to determine 
whether or not alpha information is 
included in the selection.

Useful for:

• Quickly picking a solid color from a sample point on the original layer.

• Picking a color value from one layer and using Transfer Modes to apply this color 
to a second layer. 
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Controls

Sample Point

The Sample Point value is based on X,Y coordinates and is used to reference 
color pixels at those coordinates. Use this control to select the area of pixel 
colors that you wish to sample.

To adjust the Sample Point, do one of the following:

1. Click once on the cross-hair and drag the mouse in the composition 
window to the point on the layer that you’d like to sample. Click once to 
place. Once it has been placed, click and drag to reposition it.

Offset control point Anchor point 

2. Click once on the underlined X,Y coordinate values and enter 
coordinates numerically in the Effect Controls window or in the dialog 
box. (In After Effects the coordinates 0,0 indicates the upper left corner of 
the comp.)
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Sample Radius

The Sample Radius control sets the size of the area to be sampled. 

To adjust the Sample Radius control use the slider (preset to values between 
0.5 and 50.0) , or click on the underlined Sample Radius amount and enter a 
value between 0.5 and 200 into the dialog box.

Average Pixel Color 

This pop-up menu allows you to control how and which color values to pick 
within the area defined by Position and Radius.

Skip Empty

Average (RGB) color values, excluding those of transparent pixels.



CE 1.5 Manual

www.culteffects.com 84

All 

Average all (RGB) color values, including those of transparent pixels.

All Premultiplied

Average all (RGB )color values premultiplied with the alpha channel.
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Including Alpha

Average all (RGB )color and alpha channel values.

The sampled color will contain the average transparency of the sampled 
pixels.

Maintain Original Alpha

Check this check box to maintain use of the original layer’s alpha channel, or 
uncheck to discard it. If sampling Including Alpha, the original alpha will be 
stenciled over the sampled color.

Maintain original alpha on Maintain original alpha off
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Blend with Original

This control allows you to choose the amount of blending between the new 
solid color and the original layer.

To Set the Blend with Original amount use the slider in the Effect Controls 
window or click on the underlined percentage value and enter an amount 
between 0 and 100%.

REFERENCE: For more information about CE Color Picker and its controls 
see the CE Color Picker Basic Tutorial.
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General Overview

CE Color Solid assigns a new color 
value to a layer, while maintaining the 
layer’s original alpha channel.  
Quickly and easily change the original 
color of a layer to a new selected 
color. Both the selected Color and the 
Blend with Original control can be 
animated.

CE Color Solid is especially useful for: 
quickly assigning (even animating) a 
new color to a layer (easier than AE 
Tint), changing or blending the color of 
imported Illustrator text, or animating 
the color of an After Effects solid layer.
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Controls

Color

Choose the color value that will be reassigned to the layer. Click on the color 
swatch to use the Color Picker or click on the eyedropper to sample a color 
from an image on the desktop.

Animate the Color by setting keyframes for this control. This will cause the 
selected Color to change to a new color or colors over time.

Blend with Original

This control allows you to choose the amount of blending between the new 
Color and the original layer’s color.

To Set the Blend with Original amount do one of the following:

1. Use the slider in the Effect Controls window to set the blend amount. 

2. Click on the underlined percentage value in the Effect Controls window 
and enter an amount between 0 and 100 into the dialog box.

Set keyframes for Blend with Original to change the blend amount over time. 
This creates an animated color shift from the original layer’s color to the new 
selected Color.

Tip:  CE Color Solid allows you to adjust the color of a layer to create 
synergetic color blends between layers using After Effects Transfer Modes. 
There’s no need to go back to the original application to adjust the color of 
the image. (e.g. Illustrator type)

REFERENCE: For more information on using this filter and its controls see the 
Basic Tutorial for CE Color Solid.
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General explanation

CE Colors Quad produces a four-
color gradient.  Each color is 
controlled by one of four individual 
source points. Each of the four colors, 
as well as the amount of blending 
between them, can be animated over 
time.  

Use CE Colors Quad to create color 
backgrounds (alone, or in combination 
with other filters and/or a source 
layer), mix color palettes, and 
generate color gradients.
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Controls

Points

The Points controls determine the positioning of each color within the four-
color gradient.  These points are based on X,Y coordinate values, and can 
be animated by setting keyframes.

To place the Point controls do one of the following:

1. Click on the cross hair of one of the four Point controls in the Effect 
Controls window, then click once within the Comp window to place the 
point.

2. Click on the underlined X,Y coordinates and enter the values numerically 
into the dialog box.

Point 1: Sets the position of the first color 
(default is upper-left of the Comp window).

Point 2: Sets the position of the second color 
(default is upper-right of the Comp).

Point 3: Sets the position of the third color 
(default is lower-left of the Comp).

Point 4: Sets the position of the fourth color 
(default is lower-right of the Comp).
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Colors

Choose the RGB color values for each of the four Points. The gradient can 
vary in colors, or one specific color value can be chosen for all four points—
depending upon the nature of your project.  

To choose Colors do one of the following: 

1. Click on the color swatch in the Effect Controls window and use the Color 
Picker.

2. Click on the eyedropper and sample a color from the desktop.

3. Click on “Color” in the Switches panel of the Time Layout window, and 
choose an RGB value using the Color Picker.

Color 1: Sets the color of Point 1.

Color 2: Sets the color of Point 2.

Color 3: Sets the color of Point 3.

Color 4: Sets the color of Point 4.

Blend

The Blend option in CE Colors Quad allows you to adjust the blending of the 
gradient. The CE Colors Quad gradient is actually composed of four circles, 
each blending with one another.  The blending of each circle is the result of 
a calculation between one circle’s radius with that of the other surrounding 
circles. The amount of blending will vary depending on where your Points 
have been set.

Animate the this control by setting keyframes to increase or decrease the 
amount of blending over time.

Low Blend High Blend



CE 1.5 Manual

www.culteffects.com 94

To adjust the Blend amount do one of the following:

1. Adjust the Blend slider in the Effect Controls window (preset values 10.0 
to 500.0).

2. Click on the underlined Blend value and enter an amount (between 5 and 
10,000) into  the dialog box.

Jitter

Determines the amount of “jitter”  or noise in the gradient, when blending is 
applied.

Jitter uses a controlled noise type to change pixel values in the gradient, in 
order to reduce banding effects. This eliminates the band-like motion 
common in color gradients. The noise generated is calculated to affect only 
those areas where it is found necessary (to reduce banding).

To set the Jitter amount do one of the following:

1. Adjust the Jitter slider in the Effect Controls window (preset to values 
between 0 and 100).

2. Click on the underlined Jitter value and enter an amount between 0 and 
500 into the dialog box.

Opacity

The Opacity control sets the transparency of the gradient. Lower 
percentages allow the layer(s) behind to show through. The slider respects 
the opacity of the original source layer (set in the Transform properties), 
maintaining that amount as its value for 100%. 

Change the opacity for the CE Colors Quad gradient by adjusting the Opacity 
control slider or by clicking on the underlined opacity value and entering a 
percentage into the dialog box.

Animate the transparency of the gradient by setting keyframes for Opacity, 
causing it to dissolve in or out over time.  

Transfer Mode

Choose from various Transfer Modes to select the operation between the 
new colors and the original layer. These Transfer Modes are identical to the 
ones in the After Effects Modes panel. 
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General Overview

CE Difference calculates the color 
difference between two layers. Use 
CE Difference’s Time Offset control 
to extract temporal changes of an 
effect, or anything that contains 
motion. CE Difference is a useful aid 
in color correction. Use it to extract 
color differences when matching a 
clean background plate with 
foreground footage. This filter is also 
great for creating mattes to be used to 
apply trails of smoke, fire or echoing 
effects.
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Controls

Target

Select the comparison layer from the pop-up menu. Choose any layer in your 
composition, including the original source layer to which you applied the 
effect. The layer’s video does not need to be turned on (unless you select the 
source layer as the Target). CE Difference will compare the layer selected in 
this menu to the original source layer.

Time Offset

Use the Time Offset control to set the time (in seconds) where the layers are 
compared. If this control is set to 0.00, the comparison is calculated at the 
current time. To compare two frames at different times (i.e. compare a layer 
with itself three frames before the current time) use the Time Offset control. 

Note: Effects which are applied to the layer before CE Difference (is 
applied) or to the Target layer, must be pre-composed in order to 
calculate a Time Offset.

If you are using After Effects 4.1, specific frame offset can be typed as 
“frames/framerate”, After Effects will automatically calculate the value.

Example: Type “3/30” to offset three frames forward in a 30 frames per 
second composition. After Effects will calculate the value for you (3/30=0.1). 

This calculation must be done manually if you are using After Effects 4.0, a 
calculator is useful for this. Simply divide the number of frames you wish to 
step with the frame rate of the Composition to calculate the time in seconds.

To set the Time Offset amount do one of the following:

1. Use the Time Offset slider to set the amount of positive or negative offset.

2. Click on the underlined Time Offset value and enter the amount into the 
dialog box.
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Contrast

Use this control to adjust the contrast of the calculated difference result. This 
slider allows you to increase the contrast of the resulting difference between 
two layers. Subtle areas of difference may not be visible at lower Contrast 
settings. Increasing the Contrast value displays the difference at much higher 
contrast, helpful in finding those areas. This control can be especially helpful 
in fine tuning color corrections.

To adjust the Contrast do one of the following:

1. Use the Contrast slider to choose a value (preset to values between -100 
and 100).

2. Click on the underlined Contrast value and enter an amount between -
10,000 and 10,000 into the dialog box.

Low Contrast High Contrast
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Absolute Difference

The Absolute Difference check box, when checked, displays the result of the 
comparison as an absolute value.

When using Absolute Difference, zero difference is represented by black, 
and any amount of difference is represented as brighter than black.

When this box  is left un-checked, relative difference is displayed. Zero 
difference is represented.

Absolute difference Relative difference

Alpha Channel

Select how the alpha channel will be calculated. Choose one of the following 
options from the pop-up menu.

Original

Use the original source alpha channel.

Target

Use the Target layer’s alpha channel.

Blend

Blend the original source and Target layers’ alpha channels.

Max

Use the maximum, or most opaque, of the original source and Target layers’ 
alpha channels.

Full On

Set the alpha channel to completely opaque.

Lightness of Result

Use the Lightness of the RGB difference as alpha.
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Max of Result

Use the highest values of the RGB difference as alpha.

Alpha Difference

Calculate differences in the source and Target layers’ alpha channels the 
same way RGB difference is calculated.

Alpha Difference Only

Calculate only the differences in the alpha channels. RGB is set to white.
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More on Using CE Difference

Used as a Visual Aid in Color Correction

CE Difference is a helpful tool in extracting difference information. However, 
once the difference is calculated, other filters will need to be applied to make 
use of this information. 

For example, once you’ve applied CE Difference to locate color differences 
in your footage, you will need to use color and levels controls to apply the 
color corrections.

Used In Combination with Other Effects

In creating trails or echoing effects, apply CE Difference to your footage using 
the Time Offset controls to extract the matte information. (To locate the areas 
of difference between frames as an item in the footage moves). Once you 
have isolated this information it can be used as a matte through which you 
will reveal your trailing effect (fire, smoke, pixie dust). Make adjustments to 
this matte using Levels, Blurs or Time Blending effects. Generate the images 
that will fill the matte using filters like Roughen Edges (fire), Noise Turbulent 
(smoke), Colors Quad (gradients) or any number of particle effects.

Tip:  Use CE Difference with Noise Turbulent to explore endless types 
of noise.

REFERENCE: For more information and examples, see the Basic Tutorial for 
CE Difference.
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General Overview

CE Fireup maps a pre-defined 
colored gradient to a layer based on 
that layer’s pixel values. A matching 
alpha channel can be rendered to the 
gradient. Use this filter as a quick and 
simple way to colorize any source. It 
works especially well on grayscale 
images.
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Controls

Colorize

Select the colors to be mapped onto the layer. Choose one of the following 
options from the pop-up menu.

Fire

White-Orange-Red

Moody

White-Pink-Purple
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Ice

White-Cyan-Blue

Organix

White-Yellowish-Green

Beth

White-Pink-Red
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Based on

Select the color, lightness or alpha channel information on which to base the 
colorization.

Choose one of the following options from the pop-up menu.

Alpha

Use the alpha channel values.

Lightness

Use the lightness values pre-multiplied with the alpha channel.

Red Channel, Green Channel, Blue Channel

Use the respective color channel values pre-multiplied with the alpha channel 
information.

Lightness Straight

Use the lightness values disregarding the alpha channel.

Red Straight, Green Straight, Blue Straight

Use the respective color channel values disregarding the alpha channel.

Min and Max

The Min and Max controls re-define the input values selected by the Based 
On control, making it possible to adjust the range of pixel values the gradient 
is mapped onto.

These work similarly to the "Input Black" and "Input White" controls in the AE 
Levels filter.

To adjust Min and/or Max values do one of the following:

1. Use the slider in the Effect Controls window (preset to values between 0 
and 100.)

2. Click on the underlined Min or Max value and enter an amount into the 
dialog box. (Value range for Min is between -2000 and 1000, and for Max 
between 0 and 2000.)
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Alpha Channel

Select how the alpha channel is rendered. Choose one of the following 
options from the pop-up menu.

Render

Renders an alpha channel that matches the gradient.

Original

Renders the alpha channel same as the source.

Solid

Renders the alpha channel as completely opaque.
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General Overview

CE Grid allows you to create a 
customizable grid. Render this grid in 
a solid color or as a mask in the alpha 
channel of the source layer. This filter 
is great for generating design 
elements and mattes  within which 
other effects can be applied.



CE 1.5 Manual

www.culteffects.com 110

Controls

Anchor

The Anchor determines the point of origin or “anchor point” of the Grid, based 
on X, Y coordinates.

To set the Anchor do one of the following:

1. Click on the Anchor cross hair and position over the desired area of the 
Composition window. Click once to place. An Anchor point control 
appears. To adjust the Anchor, reposition this point control.

2. Click on the underlined X,Y coordinates and enter coordinate values into 
the dialog box. 

Moving the Anchor point offsets the Grid

Gridsize From

The options in this pop-up menu allow you to choose how to define the Grid 
size. The option selected enables the corresponding controls (Corner, Width 
and Height).

Corner Point

Grid size and shape are determined by the spatial relationship between the 
Corner point and Anchor point controls.

Width Slider

Grid cells’ size and shape are determined by the value set for the Width 
control. The Grid cells will be square, as the Width value is used to determine 
both width and height of the Grid cells.
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Width and Height Sliders

Grid cells’ size and shape are determined by the values set for the Width and 
Height controls. Choose this option to set the width and height of the Grid 
cells independently.

Corner

Use the Corner point control to determine the size of the Grid cells based on 
the spatial relationship between the Corner point and the Anchor point. The 
position of these two points is used to define the size of the Grid cells when 
Corner Point is selected in the Gridsize From pop-up menu.

To set the Corner do one of the following:

1. Click on the Corner cross hair and position over the desired area of the 
Composition window. Click once to place. A Corner point control 
appears. To adjust the Corner point, reposition this control.

2. Click on the underlined X,Y coordinates and enter coordinate values into 
the dialog box.

Gridsize defined using Corner point 
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Width

The Width control defines the horizontal width of the Grid cells. If Width Slider 
is selected in the Gridsize From pop-up menu, this value determines both the 
width and height of the Grid Cells. When Width and Height Sliders is selected 
in the Gridsize From pop-up menu this value determines the width only.

To set the Width value do one of the following:

1. Adjust the Width slider (preset to values between 2.0 and 200 pixels).

2. Click on the underlined Width value and enter an amount between 1 and 
4000.

Size defined using only Width slider
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Height

Use the Height control to determine the vertical height of the Grid cells when 
the Width and Height Sliders option is selected in the Gridsize From pop-up 
menu.

To set the Height value do one of the following:

1. Adjust the Height slider (preset to values between 2.0 and 200 pixels).

2. Click on the underlined Height value and enter an amount between 1 and 
4000.

Size defined using Width and Height sliders

Border

Used to set the border thickness of the grid.  

To adjust the Border value do one of the following:

1. Adjust the slider (preset to values between 0 and 100 pixels).

2. Click on the underlined Border value and enter a value between 0 and 
2000 into the dialog box.

Thin Border Thick Border
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Note: A Border value of 0 will cause the grid to disappear.  To make 
the grid appear out of nowhere, animate either the Border value or the 
Opacity settings.

(Actual visible Border thickness may appear to vary 1 pixel, as this is 
dependent on Grid Size and Anchor point due to antialiasing).

Feather

Use the Feather Width and Height sliders to adjust the softness of the Grid. 
You can set Width and Height amounts individually. Set both Width and 
Height to the same amount for a uniform feather on all edges.

To set the feather amounts, twirl down the arrow next to Feather to reveal the 
Width and Height sliders and do one of the following:

1. Adjust the Width and/or Height slider(s) to set one or both Feather 
amount(s). The sliders are preset to values between 0 and 20 pixels. 

2. Click on the underlined Width and/or Height value(s) and enter a Feather 
amount between 0 and 400 into the dialog box.

Grid with Feather
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Invert Grid

This check box is used to inverse the matte/alpha of the grid. Opaque areas 
become transparent, transparent areas become opaque. This control can 
also be animated in the Timeline by keyframing the inversion “On” or “Off”.

Invert Off Invert On

Color

Choose the RGB color values of the grid.

Click on the color swatch to use the Color Picker or click on the eyedropper 
to sample a color from an image on the desktop.

Opacity

Sets the opacity of the grid. Use the slider or click on the underlined Opacity 
value and enter a value between 0 and 100 into the dialog box.

Transfer Mode

Choose from various Transfer Modes to select the operation between the 
Grid and the original source layer. These Transfer Modes are identical to the 
ones in the After Effects Modes panel. Use Stencil Alpha to use the Grid as 
a matte of the original layer.
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General explanation

CE Lightning creates simulations of 
electrical discharges that can be 
animated. The filter allows use of 
numerous controls for behavior and 
appearance. Incorporate optional 
interaction of the Lightning with 
objects in the source layer by using 
the layer's alpha channel. Stick to the 
basic controls for simplified use of 
this filter, or explore the Expert 
Settings for more sophisticated 
adjustments..
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Controls

Lightning Type

Use this pop-up to select the characteristics of the lightning. 

Note: The Lightning Type chosen determines the nature of the 
Direction/Outer Radius contextual control. (See Direction/Outer 
Radius control description for more information.) 

The options appear as follows:

Direction Strike Breaking

Bouncy Omni Anywhere

Vertical Two-way Strike
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Note: When using LightningType “Breaking” the branches are focused 
towards the Direction point as the distance between Origin and 
Direction increase. 

Origin

Use this control to set the point of origin for the lightning. To adjust the Origin 
do one of the following:

1. Click once on the cross-hair and drag the mouse in the composition 
window to the point on the layer where you want the lightning to originate, 
then click once to place it. A point control appears at that location. Drag 
this point to a new location on the layer if you wish to make adjustments.

2. Click once on the underlined x,y coordinate values and enter coordinates 
numerically in the dialog box. (In After Effects the coordinates 0,0 
indicates the upper left corner of the comp.)

Setting keyframes for the Origin control allows you to animate the point from 
which the lightning originates.
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Direction/Outer Radius (Contextual Control)

This is a contextual control point. Depending on the Lightning Type selected, 
it will appear as follows:

Not in Use

The control is disabled when Vertical is selected. 

Not in Use

Direction

Use the Direction control to indicate the direction that the lightning will 
travel when the following types are selected: Direction, Strike, Breaking, 
Bouncy, Two-Way Strike.Use the Direction control to indicate the direction 
that the lightning will travel when the following types are selected: 
Direction, Strike, Breaking, Bouncy, Two-Way Strike.

.

Direction
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Outer Radius

When the types Omni or Anywhere are selected this point controls the 
Outer Radius of the lightning. Outer Radius sets the distance that the 
lightning travels from it's origin. The Origin point behaves like the center 
and the Outer Radius like the outer border (of a circle) where the lightning 
terminates. This control makes it possible to terminate the lightning at a 
defined distance from the Origin.

Outer Radius

Adjust this point using one of the methods described for the Origin 
control.

Tip: First view all Lightning types to se the different characteristics 
of each, then use the Direction point to see how it affects each type. 

Set the keyframes for the Direction/Outer Radius control to animate the 
point towards which the lightning travels or the distance that the lightning 
reaches from it’s point of origin. 

Conductivity State

Use this control to animate the path of the lightning. Create a smoother 
animation by animating the Conductivity very slowly. One unit equals a 
complete shape shift. 

Set the Conductivity State value by using the slider (preset to values between 
0 and 50) or by clicking on the underlined Conductivity State value and 
entering an amount between 0 and 32,767 into the dialog box. Set keyframes 
in the Time Layout window to animate this control and the path of the 
lightning.
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Core Settings

Core Radius 

This control determines the radius width (thickness) of the lightning's 
core. Higher values result in a thicker strike. Adjust the Core Radius by 
using the slider (preset to amounts between 1.0 and 4.0) or by clicking on 
the underlined Core Radius value and entering an amount between 0 and 
40 into the dialog box. 

Core Opacity

Determines the Opacity of the Core. To set the Core Opacity adjust the 
slider or click once on the underlined Core Opacity value and enter an 
amount between 0 and 100 into the dialog box.

Core Color

Sets the color of the core. Choose a color by clicking on the color swatch 
to use the Color Picker or by using the eyedropper to sample a color from 
the desktop.

Glow Settings

Glow Radius

Determine the radius (width) of the glow around the core using this 
control. To set the Glow Radius adjust the slider (preset to amounts 
between 20 and 100) or click on the underlined Glow Radius value and 
enter an amount between 1 and 400 into the dialog box.

Glow Opacity

Determines the opacity of the glow. To set the Glow Opacity adjust the 
slider or click once on the underlined Glow Opacity value and enter an 
amount between 0 and 100 into the dialog box.
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Glow Color

Sets the color of the glow. Choose a color by clicking on the color swatch 
to use the Color Picker or by using the eyedropper to sample a color from 
the desktop.

Note: To disable the Glow, set Glow Opacity to zero. This can 
speed up rendering time significantly.  

Alpha Obstacle

The Alpha Obstacle value controls the influence of the original layer's alpha 
channel on the path of the lightning. The lightning will attempt to wrap itself 
around opaque areas of the layer's alpha channel seeing them as an 
"obstacle".

This feature samples the alpha channel of the layer that CE Lightning is 
applied to and interprets high values as non-conductive obstacles (vice versa 
if Alpha Obstacles is set to negative values). When using Alpha Obstacles 
(set to a value other than 0), it's not always possible to preview the correct 
result in less than full resolution –full resolution may reveal new obstacles. Be 
sure to check the result in full resolution before final rendering.

To set the Alpha Obstacle value adjust the slider (preset to values between -
10 and 10) or click on the underlined Alpha Obstacle value and enter an 
amount between -100 and 100 into the dialog box.

Original Alpha Channel Alpha Obstacle = 0.0 Alpha Obstacle = 10

REFERENCE: For an example of Alpha Obstacle use, see the Basic Tutorial 
for CE Lightning.
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Note: When using Alpha Obstacle (set  a value other than 0.0) 
rendering will be somewhat slower since Lightning then analyzes pixel 
alpha in the image as the lightning branches are calculated.

Turbulence

This control determines the amount of turbulence in the lightning path. Higher 
values result in a more complex strike containing more branches and forks, 
lower values produce simpler strikes with fewer branches.

To set the Turbulence value adjust the slider (preset to values between 0.50 
and 1.25) or click on the underlined Turbulence value and enter an amount 
between 0 and 10 into the dialog box.

Turbulence low Turbulence high

Forking

Forking determines the threshold value to fork the branch. The Forking value 
is influenced by Turbulence and Alpha Obstacle settings.

To adjust the Forking value use the slider, or click on the underlined Forking 
value and enter an amount between 0 and 100 into the dialog box.

Low Forking High Forking
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Decay

The Decay control sets the amount of continuous decay or dissipation of the 
lightning strength. This control influences where the opacity of the forks 
begins to fade (to 0). At lower settings the forks do not fall away so quickly, 
producing longer branches in the lightning strike. At higher values the opacity 
begins to drop off more quickly, and the forks appear shorter as a result.

To adjust the Decay setting use the slider (preset to values between 0 and 
1.00) or click on the underlined Decay value and enter an amount between 0 
and 100 into the dialog box.

Low Decay High Decay

Decay Main Core

Check the checkbox to decay the main core of the strike as well as its forks.

Add to Original

Check this checkbox to "add" the Lightning to the original layer. It is 
composited with an Add transfer mode applied. If this box is not checked 
the original layer is not be displayed, only the lightning is visible.
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Expert Settings

Complexity

This control sets the complexity of the Turbulence in the lightning. 
Increasing the Complexity value adds smaller details and more obstacles 
to the lightning path. Lower values produce a less detailed strike.

To adjust the Complexity use the slider (preset to values between 1 and 
8) or click on the underlined Complexity value and enter an amount 
between 1 and 10 into the dialog box.

Low Complexity High Complexity

Min. Fork distance

Sets the minimum pixel distance between new forks. Decreasing this 
value creates more forks in the lightning by reducing the distance along 
the lightning path where new forks are created. Higher values result in 
fewer forks, as forks are spaced further apart along the lightning path.     
To set the Min. Fork Distance use the slider (preset to values between 16 
and 256) or click on the underlined value and enter an amount between 
8 and 1024 into the dialog box.

Low Fork Distance High Fork Distance
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Termination Threshold

This value controls the level at which a path will terminate, based on 
resistance in the atmosphere and possible alpha collision. At lower 
values, the path will terminate more easily when encountering resistance 
or alpha obstacles. At higher values, the path is more persistent traveling 
around alpha obstacles.

Increasing Turbulence or Complexity will cause resistance to increase in 
some areas. These areas will change as Conductivity changes. 
Increasing the Alpha Obstacle value causes resistance to increase at 
alpha edges.

To set the Termination Threshold value adjust the slider in the Effect 
Controls window, or click on the underlined Termination Threshold value 
and enter an amount between 0 and 100 into the dialog box.

Low Termination Threshold High Termination Threshold

Main Core Collision Only

Check this check box to calculate collisions on "main core" only. The 
forks will not be affected. This control is relevant only when Alpha 
Obstacle is used.



CE 1.5 Manual

www.culteffects.com 128

Fractal Type

Select the type of fractal turbulence to use to create the lightning.

Fractal Type Linear Fractal Type SemiLinear Fractal Type Spline

Core Drain, Fork Strength and Fork Variation Controls 
Overview

The following controls are applicable whenever a new fork splits off the 
Core. The original branch of lightning is the Core which can be drained 
(set by the Core Drain Control). The strength of the new fork can be 
adjusted (Fork Strength), as well as how much it will deviate (Fork 
Variation) from that suggested strength. Once created the forked branch 
is now a new Core.

Core Drain

Set the percentage by which the core strength is drained when creating 
a new fork. Increasing this value reduces the opacity of the core where 
new forks appear. Because forks draw their strength from the main core, 
decreasing this value will reduce the opacity of the forks as well.

To set the Core Drain amount use the slider or click on the underlined 
Core Drain value to enter an amount between 0 and 100 into the dialog 
box.

Fork Strength

Sets the strength (opacity) of the new fork. This amount is measured as 
a percentage of the original path (or Core Drain value).

To set the Fork Strength amount use the slider or click on the underlined 
Fork Strength value to enter an amount between 0 and 100 into the dialog 
box.
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Fork Variation

Use this control to set the amount of variation in the strength (opacity) of 
the fork. This control determines how much the fork strength will deviate 
from the amount set for Fork Strength.

To set the Fork Variation amount use the slider or click on the underlined 
Fork Variation value and enter an amount between 0 and 100 into the 
dialog box.

Tip: In After Effects 4.1, effect sliders ranges can be adjusted. Click on the 
underlined numerical value for the control you wish you adjust. Enter the new 
range values in the appropriate fields in the dialog box. Be sure that these 
values fall within the minimum-maximum range for that control.This can be 
useful when working with Alpha Obstacle to achieve the effect of trapping the 
lightning inside an object, since this may require a high value (outside normal 
slider range.) Adjust the slider range instead of continuously entering numbers 
numerically while fine tuning the setting.

REFERENCE: For some examples of use, see the Basic Tutorial for CE Lightning. 
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General Overview

CE Magnify enlarges a selected area 
of a layer based upon the location of 
the center point control, the radius 
amount, and the magnification 
amount. This filter can act like a 
magnifying glass placed over an area 
of the image, or it can be used to 
scale the entire image far beyond 
100% while maintaining resolution 
(reducing jaggies) in doing so.

It includes controls for panning the 
area of the image that is being 
zoomed in on, setting the size of the 
area that is magnified, the amount that 
the area is magnified, the blending of 
that area with the layer(s) behind it, 
and the method by which the layer will 
be scaled.



CE 1.5 Manual

www.culteffects.com 132

Controls

Shape

Choose either Circle or Square for the shape of the magnified area.

Center

The Center control sets the center point of the magnified area using X,Y 
coordinates. 

To adjust this control do one of the following:

1. Click once on the cross-hair and drag the mouse in the composition 
window to the point on the layer you wish to be the center of the magnified 
area then click once to place it. A center point control appears at that 
location. 

Drag the Center point control to a new location on the layer if you wish to 
make adjustments.

The center point control

2. Click once on the underlined X,Y coordinate values and enter 
coordinates numerically in the dialog box. (In After Effects the 
coordinates 0,0 indicate the upper left corner of the comp.)

Setting keyframes for the Center control allows you to animate the area 
of the image that is magnified. For example, create the look of a 
magnifying glass traveling across an image. Or, when using magnify to 
scale an image, animate this point to pan across the image.
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Magnification

The Magnification control sets the percentage of magnification (or scale) 
applied to the selected area. 

Determine the amount you want to zoom into the selected area by doing one 
of the following:

1. Adjust the Magnification slider (preset to values between 100 and 500 
percent)

2. Click on the underlined magnification value and enter an amount 
between 100 and 10000 into the dialog box.

Set keyframes for Magnification to animate the scale of the image inside 
the magnified area so that it will grow or shrink over time. This allows you 
to zoom in or out of that area of the image.

Link

The Link options in this pop-up menu allow you to link the Size, Magnification 
and Feather amounts so that they increase or decrease proportionally. Note: 
When Link is set to options other than None, the Resize control is disabled.

None

Size, Magnification and Feather controls operate separately, none are linked.

Size to Magnification

Size and Magnification are scaled proportionally so that when the 
Magnification value increases or decreases so does the Size of the magnified 
area.

Size and Feather to Magnification

Size and Feather are linked to the Magnification value. When Magnification 
increases so does the Size of the magnified area, and the Feather applied to 
its edge.

REFERENCE: For more information on how to use the Link options, see the 
Basic Tutorial for CE Magnify.
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Size

The Size control sets the size of the area to be magnified. The value entered 
for this control equals the size (in pixels) of the magnified area. 

To adjust the Size control do one of the following:

1. Use the Size slider in the Effect Controls window. (It is preset to values 
between 10 and 600.)

2. Click on the underlined Size amount and enter a value between 1 and 
4000 into the dialog box.

Animating this control allows you to increase or decrease the portion of the 
layer that is magnified over time.

Note: If you set the Size to be larger than your original source layer, 
either portions or all of the magnified area will fall outside of the 
composition frame (depending upon the location of your center point).

It is possible to set the Size amount to be larger than the width and height of 
the original source layer so that the defined edge of the magnified area falls 
completely outside of the composition frame. This may be desirable in using 
CE Magnify to simply scale an image, taking advantage of its ability to 
maintain image resolution while scaling.
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Feather

The Feather control adjusts the amount of feather applied to the edge of the 
magnified area. Increasing this amount softens the edge of the magnified 
area, blending its edge with whatever appears behind it (either the original 
layer or another background layer). Decreasing this amount sharpens the 
edge of the magnified area.

To set the Feather amount do one of the following:

1. Adjust the Feather slider (preset to values between 0 and 50 pixels). 

2. Click on the underlined Feather amount and enter a value between 0 and 
1000 into the dialog box.

Set keyframes for Feather to animate the softness or sharpness of the 
edge of the magnified area over time.

Feather = 0.0 Feather = 25.0

Opacity

The Opacity control sets the transparency of the magnified area. Lower 
percentages allow more of the layer(s) behind to show through. This slider 
respects the opacity of the original source layer (set in the Transform 
Properties) maintaining that amount as its value for 100%.

Change the opacity for the magnified area by adjusting the Opacity slider or 
by clicking on the underlined opacity value and entering a percentage in the 
dialog box.

Animate the transparency of the magnified area by setting keyframes for 
Opacity, causing it to dissolve in or out over time.
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Scaling

CE Magnify offers several options for the type of scaling that is used when 
you magnify a layer. Each produces a slightly different result based on 
mathematical algorithms.

Standard

Enlarges the area using standard After Effect scaling. This method, using 
minimal softening of the image, maintains sharpness in the image, and as a 
result will produce jaggies at higher magnification amounts.

Soft

Uses spline algorithms to scale the image as magnification is increased far 
beyond 100%, greatly reducing pixelation and maintaining image quality. 
Edges appear softer and rounder instead of blocky or jagged. This option is 
especially appropriate at extreme magnification amounts, and may be very 
subtle, even unnoticeable, at lower amounts. 
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Scatter

Creates scatter or noise in the image as magnification increases to maintain 
image quality. This option is most appropriate with images that already 
appear textured or if a noise-like quality or texture is desired.

Transfer Modes

Choose from various Transfer Modes in the pop-up menu to select the 
operation between the new magnified area and the original layer. These 
Transfer Modes are identical to the ones in the After Effects Modes panel. 
Exception: The first Transfer Mode is None. This option displays transparent 
pixels around the magnified area, useful for compositing it over layers other 
than the original.
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Resize Layer

The Resize Layer checkbox controls whether or not the original layer’s 
bounding box is adhered to as the edge of the layer when the magnified area 
extends beyond it. If the area of magnification falls off the edge of the layer 
(but not outside the composition frame) this checkbox can be used to 
determine whether or not that area of the image is displayed. If the box is 
checked, the magnified area outside of the original layer’s bounding box is 
displayed, allowing the effected area to extend beyond the layer boundaries, 
the layer is “Resized”. If the box is unchecked, any area of the image falling 
outside of the original layer’s bounding box is cropped by the layer’s 
boundaries, obeying the layer’s original size.

Note: When Link is set to options other than None, the Resize control 
is disabled.

Resize off Resize on

REFERENCE: For more information on how to use this filter, see the Basic 
Tutorial for CE Magnify.
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General overview

CE Noise Alpha adds uniform or 
squared noise to the alpha channel of 
a source layer.  Choose from various 
types of noise and control the 
grayscale values of the noise. Noise 
can be animated or static, you 
decide. Noise Alpha is especially 
interesting when used in combination 
with other filters which operate on the 
alpha channel, such as Roughen 
Edges.
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Controls

Noise

Select the type of Noise you wish to use from the Noise pop-up menu. You 
can choose from four types of Noise.  

Uniform Noise has an equal amount of high and low amplitude values. This 
will create an even amount of black and white noise. 

Uniform noise

Squared Noise has a higher amount of low amplitude values. This will create 
higher contrast in the noise.    

Squared noise

Squared Animation and Uniform Animation are animated versions of the 
above Noise types. When either of these are selected, the Noise can be 
animated. The dial in the Effect Controls (a contextual control) changes from 
Random Seed to Noise Phase. You will use this Noise Phase dial to control 
your animation.  
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Amount

The Amount control adjusts the amount of Noise introduced into the layer’s 
alpha channel.  By default Amount is set to 0.

To adjust the Amount of noise do one of the following:

1. Move the Amount slider (preset to values between 0 and 100).

2. Click on the underlined Amount value and enter a value between 0 and 
10,000. 

Original Alpha

Clamp

The default Clamp setting introduces noise into opaque areas of the original 
alpha channel. As the Amount of noise is increased, more noise is added into 
the non-transparent areas.

Add

Add produces noise throughout all areas of the layer. The original alpha 
channel does not effect the distribution of Noise.  

Scale

Scale produces noise in non-transparent areas of the original alpha channel. 

With Scale selected, the image and alpha channel are completely 
transparent when the Amount of noise is set to 0.  As you increase the 
Amount, noise is introduced into the non-transparent areas of the alpha 
channel. The more opaque the alpha channel, the more contrast there is in 
the noise.  

Edges

Edges produces noise in partially transparent areas of the alpha channel 
only. Completely opaque and/or completely transparent portions of the alpha 
channel are left untouched.  



CE 1.5 Manual

143 www.culteffects.com

Image before adding noise

Clamp Add

Scale Edges

Overflow

The Overflow control offers three options. Each of these options uses a 
different method of remapping values that fall outside of the grayscale range 
of 0-255.
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Clip

Any value above 255 is displayed as pure white. Any value below 0 is 
displayed as pure black.

Result:

Values falling outside of the 0-255 range are clipped and displayed as either 
0 (transparent) or 255 (opaque). A value of 256 will clip to 255. A value of -1 
will Clip to 0.

Wrap

Re-maps values that fall outside of the displayable color range of 0-255. 
These values are forced to fall inside of the displayable range.

Result:  A value of 256 will Wrap to 0. A value of -1 will Wrap to 254.

Wrap Back

Triangular re-mapping of values above 255 or below 0 to fold back into the 
range.

Result:  Appearance of more defined subtle detail when the alpha channel 
contains values that fall out of the displayable 0-255 range. A value of 256 
will Wrap Back to 254. A value of -1 will Wrap Back to 1.    

Clip

0

255

Original value Clip values

Wrap

0

255

Original value Wrap values
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Random Seed

Important:  To set the random seed you must have Uniform Random or 
Squared Random selected as the Noise type.

This control sets a unique random value from which to generate noise.

Animating the Random Seed will result in flashing Noise. For smoothly 
transitioning animated Noise, select either Uniform Animation or Squared 
Animation Noise type, and animate the Noise Phase.   

Noise Phase

Important:  To animate the Noise Phase you must have Uniform Animation 
or Squared Animation selected as the Noise type.

This control sets the “state” or placement of the noise. Drag the dial to 
different positions to view various noise states. This control can be animated 
by setting keyframes for the Contextual Control in the Time Layout window.

Noise Options

The Noise Options include controls for animating the noise. Click the triangle 
to the left of the Noise Options control to expand these controls.

Cycle Noise

Checking the Cycle Noise check box creates a cycle of noise evolutions 
that loop over the set amount of time. Cycle Noise forces the noise to 
return to it’s starting point in order to create a looping animation.

Although setting Noise Phase keyframes which return to the same Noise 
Phase value will return Noise to the same ”state”, the animation will act 
like a ramp rather than a smoothly transitioning cycle, repeating itself as 

0

255
Wrap Back

Original value Wrap Back values



CE 1.5 Manual

www.culteffects.com 146

it interpolates between the keyframes. Instead, use Cycle Noise and the 
Cycle control to create a smooth, progressive cycle (or loop segment).  

This control can save a great deal of rendering time. Use it to create a 
short seamless noise cycle (where the last frame matches up to the first) 
to be pre-rendered and looped as a new source layer in a composition, 
rather than setting Noise Phase to animate over a greater number of 
frames.

For more information on how to set Cycles, please refer to the Evolution 
Appendix.

Cycle

Note:  This control is only available when the Cycle Noise check 
box is checked.

The Cycle value determines the number of revolutions (of the Noise 
Phase setting) that the noise will cycle through before it repeats.

The timing or speed of these Noise Cycles is determined by the amount 
of time allowed between Noise Phase keyframes.  

For Example, if you set keyframes for Noise Phase with 0 revolutions at 
0:00 and 4 revolutions at 4:00, and then set the cycle value to 2 
revolutions, Noise Alpha will repeat the cycle (return the noise to it’s 
original state of 0 revolutions)  after 2 revolutions.  According to the Noise 
Phase keyframes set, 2 revolutions will be complete at 2:00.  

The Cycle control is repeating the state of the Noise Phase at the time 
interval determined by Noise Phase Keyframes.  In this case, since 4 
revolutions takes 4 seconds, 2 revolutions will take 2 seconds.  Alter the 
timing of the Noise Phase keyframes to adjust the speed of the Noise 
Phase cycles.

Note:  The Cycle control affects only the state (Noise Phase) of the 
Noise, not the noise type or other controls.  (e.g. Two identical 
states of the Noise will not appear the same if viewed with different 
amounts or different types of Noise.)
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General Overview

Use CE Noise HLS to simulate film 
grain or to add noise to still or moving 
footage. Choose from various types 
of noise to add to the Hue, Saturation 
or Lightness of a source layer. 
Although noise generated in CE 
Noise HLS can be animated, this filter 
is especially useful in creating static 
noise.

Note about this filter:

Unlike many other noise filters, CE 
Noise HLS is able to create static 
noise. If you wish to generate 
animated noise, try CE Noise HLS 
Auto where the noise is automatically 
animated, and you control the speed.
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Controls

Noise

Choose the type of Noise to add to the source layer from the pop-up menu.

Uniform

Produces evenly distributed pixel noise.

Uniform

Squared

Produces sparse, high contrast noise, using a non-uniform distribution of 
pixel noise.

Squared
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Grain

Produces grain-like noise, using a Gaussian distribution of pixel noise. Useful 
for simulating film grain in a source image.

Grain

Note: If Grain is chosen the Grain Size slider will be enabled. See 
Grain Size control below.

For example: If the Hue, Lightness or Saturation slider is set to 10% and...

• Uniform noise is selected: the pixels in the image will be evenly adjusted 
+10, +5, 0, -5, or -10 from their original Hue, Lightness or Saturation 
values.

• Squared noise is selected: fewer pixels will be adjusted to +10 and -10, 
while more pixels are adjusted to +5 or -5, and the most are left at 0 
adjustment from their original Hue, Lightness or Saturation values.

• Grain noise is selected: The noise covers an area of the image instead of 
effecting each pixel value. Grain is introduced at 10% to the selected 
channel(s). (Note: Adjustment varies between -10 and 10% with 
tendency to stay near zero adjustment –similar to squared noise.)
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Hue, Lightness and Saturation Sliders

Use the values of the selected channel to introduce the noise within the 
(slider value) range. 

To set the amount of noise added to a channel adjust the slider (preset to 
values between 0 and 100) or click on the underlined value for that channel 
and enter an amount between 0 and 1000 into the dialog box.

Tip: To View the Hue Lightness or Saturation of a source layer, use CE 
Channeling to map the original channels to display the Hue, Lightness, 
or Saturation. Note, this effect can be turned off after noise has been 
added.

Hue

Sets the amount of noise added to the Hue values of the source layer. 
Colored noise is introduced at the amount set by this slider. Greater values 
produce more intense noise, replacing the original image with new noise 
values.

If the source image is black and white or grayscale, no noise will be added to 
the image, unless saturation noise is also used.

Hue noise
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Lightness

Controls the amount of noise added to the Lightness values of the source 
layer. Mostly black and white noise is introduced at the amount set by the 
slider. Greater values generate more noise, overtaking the original image 
with new noise values.

Lightness noise

Saturation

Adds noise to the Saturation values of the source layer. Colored and 
grayscale noise is introduced by shifting the saturation values in the image 
according to the amount set by the slider. Even set at higher values, this 
control produces a fairly subtle addition of noise in the source image.

If the source layer is black and white or grayscale, red noise will be added to 
the image, as red is the default position on the color wheel for originally non-
saturated pixels.

Saturation noise
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Grain Size

Use the Grain Size slider to set the size of the grain that is added to the 
source image. Smaller values produce finer grain, while larger values 
produce bigger more blotchy grain.

Set the Grain Size by moving the slider (preset to values between 0 and 4) 
or by clicking on the underlined value and entering an amount between 0 and 
10 into the dialog box.

Small grain size Large grain size

Noise Phase

The Noise Phase control sets the random seed value for the noise. 

Alter the Noise Phase value by adjusting the dial control or by clicking on the 
underlined value and entering an amount into the dialog box.

Use this dial to animate the noise. When keyframes are set for Noise Phase 
this dial cycles through phases to create animated noise. The greater the 
difference in values between the keyframes, the faster the noise will animate.

Note: For automatically animated noise use the CE Noise HLS Auto 
filter. CE Noise HLS and CE Noise HLS Auto include all of the same 
controls with the exception of Noise Phase. The Noise Phase dial is 
replaced by a Noise Animation Speed slider. The noise is auto-
animated and you control the speed of the animation using this slider.

Tip: Noise usually appears stronger when animated. Beware of setting noise 
values too high while viewing single frames only. As a general guideline, when 
previewing noise values on a static frame, reduce those values by half before 
animating. Be sure to preview the noise animation before the final render.

REFERENCE: For an example of use, see the Basic Tutorial for CE Noise HLS
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General Overview

Use CE Noise HLS Auto to simulate 
film grain or to add noise to still or 
moving footage. Choose from various 
types of noise to add to the Hue, 
Saturation or Lightness of a source 
layer.  This filter is especially useful in 
creating animated noise. The noise 
you create in CE Noise HLS Auto will 
auto-animate, you control the speed.

Note about this filter:

As mentioned above, in CE Noise 
HLS Auto the noise is automatically 
animated. To generate static noise or 
noise that changes from static to 
animated over time use CE Noise 
HLS.
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Controls

Noise

Choose the type of Noise to add to the source layer from the pop-up menu.

Uniform

 Produces evenly distributed pixel noise.

Uniform

Squared

Produces sparse, high contrast noise, using a non-uniform distribution of 
pixel noise.

Squared
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Grain

Produces grain-like noise, using a Gaussian distribution of pixel noise. Useful 
for simulating film grain in a source image.

Grain

Note: If Grain is chosen the Grain Size slider will be enabled. See 
Grain Size control below.

For example: If the Hue, Lightness or Saturation slider is set to 10% and...

• Uniform noise is selected: the pixels in the image will be evenly adjusted 
+10, +5, 0, -5, or -10 from their original Hue, Lightness or Saturation 
values.

• Squared noise is selected: fewer pixels will be adjusted to +10 and -10, 
while more pixels are adjusted to +5 or -5, and the most are left at 0 
adjustment from their original Hue, Lightness or Saturation values.

• Grain noise is selected: The noise covers an area of the image instead of 
effecting each pixel value. Grain is introduced at 10% to the selected 
channel(s). (Note: Adjustment varies between -10 and 10% with 
tendency to stay near zero adjustment –similar to squared noise.)
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Hue, Lightness and Saturation Sliders

Use the values of the selected channel to introduce the noise within the 
(slider value) range. 

To set the amount of noise added to a channel adjust the slider (preset to 
values between 0 and 100) or click on the underlined value for that channel 
and enter an amount between 0 and 1000 into the dialog box.

Tip: To View the Hue Lightness or Saturation of a source layer, use CE 
Channeling to map the original channels to display the Hue, Lightness, 
or Saturation. Note, this effect can be turned off after noise has been 
added.

Hue

Sets the amount of noise added to the Hue values of the source layer. 
Colored noise is introduced at the amount set by this slider. Greater values 
produce more intense noise, replacing the original image with new noise 
values.

If the source image is black and white or grayscale, no noise will be added to 
the image, unless saturation noise is also used.

Hue noise
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Lightness

Controls the amount of noise added to the Lightness values of the source 
layer. Mostly black and white noise is introduced at the amount set by the 
slider. Greater values generate more noise, overtaking the original image 
with new noise values.

Lightness noise

Saturation

Adds noise to the Saturation values of the source layer. Colored and 
grayscale noise is introduced by shifting the saturation values in the image 
according to the amount set by the slider. Even set at higher values, this 
control produces a fairly subtle addition of noise in the source image.

If the source layer is black and white or grayscale, red noise will be added to 
the image, as red is the default position on the color wheel for originally non-
saturated pixels.

Saturation noise
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Grain Size

Use the Grain Size slider to set the size of the grain that is added to the 
source image. Smaller values produce finer grain, while larger values 
produce bigger more blotchy grain.

Set the Grain Size by moving the slider (preset to values between 0 and 4) 
or by clicking on the underlined value and entering an amount between 0 and 
10 into the dialog box.

Small grain size Large grain size

Noise Animation Speed

This slider controls the speed of the noise animation. For faster changing 
noise, set the value higher. For slower changing noise, choose a lower value. 
To accelerate or decelerate the speed of the noise set keyframes for this 
control.

To change the value of the Noise Animation Speed, set the amount using the 
slider (preset to values between 0 and 60) or click on the underlined value 
and enter an amount between 0 and 200 into the dialog box.

Tip: Noise usually appears stronger when animated. Beware of setting 
noise values too high while viewing single frames only. As a general 
guideline, when previewing noise values on a static frame, reduce 
those values by half before applying to animating frames. Be sure to 
preview the noise animation before the final render.

REFERENCE: For an example of use, see the Basic Tutorial for CE Noise HLS Auto.
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General Overview

CE Noise Turbulent uses fractals to 
create textures and objects that 
cannot be described using simple 
geometric shapes. Taking advantage 
of the various fractal types and the 
numerous controls that this filter has 
to offer will result in an infinite number 
of possibilities. Create organic-
looking backgrounds, displacement 
maps, textures and mattes. Or, 
simulate things like caustics, clouds, 
lava, flowing water, even gas.
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Controls

Fractal Type

This menu allows you to select from a number of different fractal shapes to 
create your noise.

Choose from the menu the Fractal Type that best suits the texture or object 
you wish to create. 

Below are some illustrations of the various fractal types: 

Basic linear Basic smooth Turbulent soft

Turbulent standard Turbulent sharp Dynamic linear

Dynamic linear progressive Dynamic linear Twist Dynamic Smooth



CE 1.5 Manual

www.culteffects.com 164

Dynamic smooth progressive Dynamic smooth twist Extras max

Extras smeary Extras swirly Extras rocky

Extras cloudy Extras terrain Extras subscale

Invert 

The Invert check box allows you to invert the noise. Check this check box to 
create a negative or inverse of the current noise layer. Black areas become 
white, white areas become black.

Invert on Invert off
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Contrast

The Contrast control adjusts the contrast of the Noise Turbulent  layer. The 
default Contrast value is 100. Higher contrast settings create larger, more 
sharply defined areas of black and white in the noise, generally revealing less 
subtle detail. Lower contrast settings result in more areas of gray, softening 
or muting the noise. 

Note:  Be aware that a layer’s contrast is altered by the option selected 
in the Overflow pop-up menu. (See Overflow for further information.)

Low contrast High contrast

To adjust the Contrast do one of the following:

1. Use the Contrast slider in the Effect Controls window (preset to values 
between 0 and 400).

2. Click on the underlined Contrast amount and enter a value between 0 and 
10,000 into the dialog box.

The minimum/maximum ranges for Contrast (and other Cult Effects filter 
controls) are left very wide, and unexpected results may occur at greater 
values.

Animating this control allows you to increase or decrease the contrast of 
the layer over time. 

Note:  In After Effects 4.1, effect slider ranges can be re-defined by 
clicking on the slider’s corresponding underlined numerical value and 
adjusting the preset minimum and maximum slider range values in the 
dialog box. This is useful for greater experimentation with settings for 
Contrast as well as many other effects’ controls.
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Overflow

The Overflow control offers three options. Each of these options uses a 
different method of re-mapping values that fall outside of the grayscale range 
of 0-255. (This occurs when Contrast is set at values higher than 100).

Clip

Any value above 255 is displayed as pure white. Any value below 0 is 
displayed as pure black. 

Result: Contrast amount controls how much of the image falls outside of this 
range. Higher Contrast amounts will result in a mostly black and/or white 
image with less gray area. Therefore, less subtle fractal detail is displayed at 
higher contrast settings. If you are using this layer as a luma matte, the matte 
will have sharper, more defined areas of transparency.

Soft Clamp

Re-maps values on an infinite curve to force all values to fall inside of the 
range. 

Result: Contrast appears reduced. The fractals appear mostly gray with very 
few areas of pure black or pure white. If you are using this layer as a luma 
matte, the matte will contain very subtle areas of transparency.

Clip

0

255

Original value Clip values

0

255
Soft Clamp

Original value Soft Clamp values
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Wrap Back

Triangular re-mapping of values above 255 or below 0 to fold back into the 
range.

Result: Appearance of more defined subtle detail when Contrast is set above 
100. If you are using this layer as a luma matte, the matte will reveal more 
detailed/textured areas of transparency.

Size

The Size control adjusts the size of the fractal shapes. Default Size is 100.

To adjust the Size do one of the following: 

1. Move the Size slider (preset to values between 25 and 600). 

2. Click on the underlined Size amount and enter a value between 20 and 
10,000.

Set keyframes for Size to increase or decrease the scale of the fractal 
shapes over time, causing them to grow or shrink.

0

255
Wrap Back

Original value Wrap Back values



CE 1.5 Manual

www.culteffects.com 168

Offset

The Offset control determines the portion of the fractal that is visible in the 
Composition window.

Because the fractal shapes are infinite in all directions, what appears in the 
Composition frame at any given time is only a small portion of the entire 
fractal. With the Offset control, the layer’s bounding box behaves like a fixed 
viewing area, and the Offset control allows you to reposition the fractal within 
that view. Animating the Offset control repositions the fractal, bringing a 
different portion of it into view.

To alter the Offset  do one of the following:

1. Click on the Offset cross hair, position it the in the Comp window, and 
click once to place. 

Once it has been placed, click and drag to reposition it.

Offset  
controlpoint

Layer’s 
Anchor point

2. Click on the underlined Offset value and enter new X,Y coordinates into 
the dialog box.

Complexity

The Complexity control adjusts the visible level of detail in the fractal shapes. 
Increasing the Complexity value increases the definition in the noise pattern. 
Lower Complexity values result in softer appearance, almost a blurred view. 
Higher Complexity values display the fractal shapes with sharpness and 
clarity.
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To adjust Complexity do one of the following:

1. Move the Complexity slider to the desired value (preset between 1.0 and 
10.0). 

2. Click on the underlined Complexity value and enter a value (between 1 
and 20) into the dialog box. 

Animate the Complexity control to increase or decrease the visible level 
of detail in the fractal shapes over time.

Note: Increasing Complexity will result in longer rendering times. If 
appropriate, try reducing the Size control rather than increasing 
Complexity to achieve similar results and to avoid a rendering hit.

Low complexity High complexity

Evolution

The Evolution control effects subtle changes in the shape of the fractal. 
Animating this setting will result in smooth changes or “evolution” of the noise 
over time. (Example: clouds passing, water flowing)

To change the Evolution setting do one of the following: 

1. Adjust the Evolution dial in the Effect Controls window.

2. Click on the underlined Evolution value and enter amounts for revolutions 
and degrees in the dialog box.
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Set keyframes for Evolution to determine how much the fractals will “evolve” 
over the period of time allowed between keyframes. The more revolutions 
that are made within a given amount of time (between keyframes) the more 
rapidly the noise will change. Large changes in Evolution values over a short 
period of time may result in flashing rather than smooth changes in the noise.

Evolution Options

Because of the complexity of the fractal shapes that generate the noise in the 
Noise Turbulent effect, render time can be consuming. For this reason, the 
Evolution Options provide controls that allow you to render the effect for one 
short(er) cycle and then simply loop it to repeat for the duration necessary for 
your project.

IMPORTANT: Although the Evolution value is set in units called 
“revolutions”, it is important to realize that these revolutions are 
progressive. The term “revolution” usually refers to a setting that returns 
to the same value at the same point on the dial control every 360°. For 
example, the value at 0° is usually the same as the value at 1 revolution 
(i.e. As with the transform property Rotation or the “Direction” control in 
AE Drop Shadow). 

In the case of Evolution (as with a few other effects’ controls, such as 
Twirl Angle in AE Twirl), the image continues to change with each added 
revolution. The appearance when set to a value of 0° is different from that 
at 1 revolution, which is different from that at 2 revolutions, and so on. The 
Evolution state continues to progress infinitely at each new value. The 
only way to force the Evolution setting to return gracefully to its original 
state (necessary to create a seamless loop) is to use the Evolution 
Option, Cycle Evolution, explained below.
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Cycle Evolution

Checking the Cycle Evolution check box creates a cycle of evolution that 
loops over the set amount of time. Cycle Evolution forces the evolution 
“state” to return to it’s starting point in order to create a looping animation.

Although copying and pasting Evolution keyframes will return Evolution 
to the same value, the animation will act like a ramp rather than a 
smoothly transitioning cycle, repeating itself as it interpolates between 
the keyframes. Use Cycle Evolution and the Cycle controls to create a 
smooth, progressive cycle, non-repeating cycle (or loop segment).

This control can save a great deal of rendering time. Use it to create one 
short seamless evolution cycle (where the last frame matches up to the 
first) to be pre-rendered and looped as a new source layer in a 
composition, rather than setting Evolution to animate over a greater 
number of frames. (See Creating a Seamless Loop below.)

Cycle

Note: This control is only available when the Cycle Evolution check 
box is checked.

The Cycle value determines the number of revolutions (of the Evolution 
setting) that the fractal noise will cycle through before it repeats. The 
timing or speed of these Evolution cycles is determined by the amount of 
time allowed between Evolution keyframes.

Note: The Cycle control affects only the state (Evolution) of the 
fractal, not geometrics or other controls. (e.g. Two identical states 
of the fractal will not appear the same if viewed with different Size 
or Offset settings.)



CE 1.5 Manual

www.culteffects.com 172

Random Seed

This control sets a unique random value from which to generate the 
noise.

Animating the Random Seed will result in flashing from one set of fractal 
shapes to another (within that fractal type). For smooth transition of the 
fractal shapes use the Evolution control.

Tip: Easily create new fractal noise animations, by re-using 
previously created Evolution cycles and changing only the Random 
Seed value. Entering a new Random Seed value alters the noise 
pattern without disturbing the evolution animation. The Evolution 
keyframes and Evolution Options can be left untouched.

For further examples of how to use the Evolution Options, see To Create a 
Seamless Loop (below), the Evolution Options Appendix, and the Basic 
Tutorial for CE Noise Turbulent.
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Example

To Create a Seamless Loop

Follow the steps below to walk through the Evolution Control and Evolution 
Options.

1. Set two keyframes for Evolution. 

2. Adjust the time allowed between keyframes, and the number of Evolution 
revolutions until you are satisfied with the animation of the noise.

3. Check the Cycle Evolution check box.

4. Set a value for Cycle.

The evolution will now cycle the number of revolutions determined by the 
value set for Cycle. This cycle will take place within the time allowed for that 
number of revolutions between the Evolution keyframes.

Determine the value for cycle by considering the following: How much of this 
cycle do you need to render before it repeats? The length of your piece and 
your use of the cell pattern created will determine this. Do you need 5 
seconds of a non-repeating animated cell pattern? Is 3 seconds enough? 
You will want to choose the shortest length appropriate for your project to 
save rendering time.

IMPORTANT:
1. When using Cycle Evolution to create a seamless loop set 
Evolution keyframes using full revolutions only. Avoid using degrees, 
as partially completed revolutions may create hiccups in your 
seamless loop. 

2. Choose a value for Cycle that either matches or is evenly divisible 
by the number of revolutions set for Evolution. This will ensure that 
your cycle is able to complete full revolutions rather than partial ones, 
again, avoiding any glitches in the cycle.

3. If you have set keyframes for any of the other controls, you must 
return them to their initial settings at the point on the timeline where 
the cycle begins to repeat. Otherwise, these properties will not loop. 
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A cycle is created. Initially, however, the last frame of a cycle is identical to 
the first frame. To create a seamless loop, you want to skip the last frame to 
avoid a duplicate frame in the loop. To do this, set the out point of the layer 
one frame before the last frame of the cycle. Continue following the 
instructions below. 

5. Move the time marker to the point on the timeline where your Cycle 
completes. (i.e., if your Cycle value is 2, find the frame on the timeline 
where your Evolution value is 2 revolutions.

6. Move the time marker back one frame.

7. Trim the layer’s out point at this frame.

8. Pre-render this layer, and import it into your project. 

9. Set this pre-rendered footage item to loop by selecting it in the Project 
window and choosing File> Interpret footage. Find the Loop field at the 
bottom of the Interpret Footage dialog box, and set the number of loops 
required for the duration of the layer within your project.

REFERENCE: For further examples of how to use the Evolution Options, see 
the Evolution Options Appendix and the Basic Tutorial for CE Noise 
Turbulent.
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General Overview

CE Noise Turbulent II is the 
advanced version of CE Noise 
Turbulent. In addition to all of the 
features and controls offered in CE 
Noise Turbulent, this filter allows 
more sophisticated adjustment of the 
fractal noise that is created. Choose 
from additional Fractal Types as well 
as Noise Types. Gain control over 
Brightness, Opacity and 
Transformation of the fractals, and 
access Transfer Modes from within 
the effects’ controls. This filter is great 
for designing unique fractal maps.
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Controls

Fractal Type

This menu allows you to select from a number of different fractal shapes to 
create your noise.

Choose from the menu the Fractal Type that best suits the texture or object 
you wish to create. 

Below are some illustrations of the various fractal types: 

Basic Turbulent basic Max

Strings Swirly Terrain

Threads
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Noise Type

The Noise Type sets the type of noise used to calculate the selected Fractal 
Type. Each of the Noise Types can be combined with any of the Fractal 
Types. The characteristics of the chosen Noise Type will be visible in any 
Fractal Type you have selected.

The first two options, Block and Linear, appear rougher or sharper than the 
last two. Soft Linear and Spline are softer and more organic Noise Types.

The Noise Types are listed in order of rendering speed. Block is faster and 
Spline is slower.

There are 68 different combinations of Noise Type and Fractal Types. You 
may find some of the combinations are less rewarding. For example, Block 
noise combined with Dynamic Fractal Types may not produce fabulous 
results. However, Spline or Soft Linear works very well with the Dynamic 
Fractal Types. When using the Basic Fractal Type, choose Linear rather than 
Spline noise, as Linear renders faster and creates higher contrast results. 
These suggestions having been stated, all combinations are open for 
experimentation.

Block Linear

Soft linear Spline
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Invert 

The Invert check box allows you to invert the noise. Check this check box to 
create a negative or inverse of the current noise layer. Black areas become 
white, white areas become black.

Inverted Not inverted

Contrast

The Contrast control adjusts the contrast of the Noise Turbulent  layer. The 
default Contrast value is 100. Higher contrast settings create larger, more 
sharply defined areas of black and white in the noise, generally revealing less 
subtle detail. Lower contrast settings result in more areas of gray, softening 
or muting the noise. 

Note:  Be aware that a layer’s contrast is altered by the option selected 
in the Overflow pop-up menu. (See Overflow below for further 
information.)

Low contrast High contrast
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To adjust the Contrast do one of the following:

1. Use the Contrast slider in the Effect Controls window (preset to values 
between 0 and 400).

2. Click on the underlined Contrast amount and enter a value between 0 and 
10,000 into the dialog box.

The minimum/maximum ranges for Contrast (and other Cult Effects filter 
controls) are left very wide, and unexpected results may occur at greater 
values.

Animating this control allows you to increase or decrease the contrast of the 
layer over time. 

Note:  In After Effects 4.1, effect slider ranges can be re-defined by 
clicking on the slider’s corresponding underlined numerical value and 
adjusting the preset minimum and maximum slider range values in the 
dialog box. This is useful for greater experimentation with settings for 
Contrast as well as many other effects’ controls.

Brightness

The Brightness control adjusts the Brightness level of the Noise Turbulent 
layer. The default Brightness value is 0. Higher (positive) Brightness settings 
create large “blown out” areas of white in the image, whereas lower 
(negative) Brightness values create large areas of Black.

Low brightness High brightness
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To adjust the Brightness do one of the following:

1. Use the Brightness slider in the Effect Controls window (preset to values 
between -100 and 100).

2. Click on the underlined Brightness amount and enter a value between       
-10,000  and 10,000 into the dialog box.

The minimum/maximum ranges for Brightness (and other Cult Effects filter 
controls) are left very wide, and unexpected results may occur at greater 
values.

Animating this control allows you to increase or decrease the brightness of 
the layer over time. 

Overflow

The Overflow control offers three options. Each of these options uses a 
different method of re-mapping values that fall outside of the grayscale range 
of 0-255. (This occurs when Contrast is set at values higher than 100).

Clip

Any value above 255 is displayed as pure white. Any value below 0 is 
displayed as pure black. 

Result: Contrast amount controls how much of the image falls outside of this 
range. Higher Contrast amounts will result in a mostly black and/or white 
image with less gray area. Therefore, less subtle fractal detail is displayed at 
higher contrast settings. If you are using this layer as a luma matte, the matte 
will have sharper, more defined areas of transparency.

Clip

0

255

Original value Clip values
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Soft Clamp

Re-maps values on an infinite curve to force all values to fall inside of the 
range. 

Result: Contrast appears reduced. The fractals appear mostly gray with very 
few areas of pure black or pure white. If you are using this layer as a luma 
matte, the matte will contain very subtle areas of transparency.

Wrap Back

Triangular re-mapping of values above 255 or below 0 to fold back into the 
range.

Result: Appearance of more defined subtle detail when Contrast is set above 
100. If you are using this layer as a luma matte, the matte will reveal more 
detailed/textured areas of transparency.

0

255
Soft Clamp

Original value Soft Clamp values

0

255
Wrap Back

Original value Wrap Back values
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Transform

Use these controls to transform the fractal shape.

Rotation

Use the Rotation control to rotate the fractals in the Composition window.

To set the Rotation value adjust the dial to the desired number of 
revolutions and degrees. Set keyframes for this control to animate 
rotation.

Uniform Scaling

Uniform Scaling, when checked, enables the Scale control and disables 
the non-uniform scaling controls, Scale Width and Scale Height.

Scale

Use this control to adjust the proportional scale (both width and height) of 
the fractal shapes within the Composition window.

Scale Width

Adjusts the width of the fractal shapes.

Scale Height

Adjusts the height of the fractal shapes.

To adjust the any of the above Scale values do one of the following:

1. Adjust the Scale slider (preset to values between 20 and 600).

2. Click on the underlined Scale value and enter an amount between 1 
and 10,000 into the dialog box.
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Offset Turbulence

The Offset Turbulence control determines the portion of the fractal that is 
visible in the Composition window.

Because the fractal shapes are infinite in all directions, what appears in the 
Composition frame at any given time is only a small portion of the entire 
fractal. With the Offset Turbulence control, the Layer’s bounding box 
behaves like a fixed viewing area, and this control allows you to reposition the 
fractal within that view. Animating the Offset Turbulence control point 
repositions the fractal, bringing a different portion of it into view.

To alter the Offset  do one of the following:

1. Click on the Offset cross hair, position it the in the Comp window, and 
click once to place. 

Once it has been placed, click and drag to reposition it.

Offset    
controlpoint 

Layer’s 
Anchor point

2. Click on the underlined Offset value and enter new X,Y coordinates into 
the dialog box.
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Perspective Offset

This option makes it possible create a perspective effect when animating the 
Offset Turbulence.

If enabled, the perspective is influenced by the Sub Settings control, Sub 
Scale. (See Sub Scale for more information).

Complexity

The Complexity control adjusts the visible level of detail in the fractal shapes. 
Increasing the Complexity value increases the definition in the noise pattern. 
Lower Complexity values result in softer appearance, almost a blurred view. 
Higher Complexity values display the fractal shapes with sharpness and 
clarity.

To adjust Complexity do one of the following:

1. Move the Complexity slider to the desired value (preset between 1.0 and 
10.0). 

2. Click on the underlined Complexity value and enter a value (between 1 
and 20) into the dialog box. 

Animate the Complexity control to increase or decrease the visible level 
of detail in the fractal shapes over time.

Note: Increasing Complexity will result in longer rendering times. If 
appropriate, try reducing the Size control rather than increasing 
Complexity to achieve similar results and to avoid a rendering hit.

Low complexity High complexity
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Sub Settings

The fractals used to create Noise Turbulence are generated by repeating 
instances of a noise function derived from the Fractal Type and Noise Type 
selections. In each instance, the following Sub Controls affect how each 
“iteration” value is calculated. The number of iterations calculated is 
determined by the Complexity control.

Sub Influence

Determines how much each iteration influences the final image. This 
value also affects any subsequent iterations. At 100%, all iterations have 
the same amount of influence.

At 50%, each iteration will have half as much influence as the previous 
iteration.

Low sub influence High sub influence
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Sub Scaling

Scales the coordinates on which the iteration will be calculated. When 
this value is set lower than 100%, each iteration adds more refined 
details. Setting this value at 50% will increase the detail by a factor of two 
for each iteration. (The same way detail increases when scaling down an 
image.)

Low sub scaling High sub scaling

Sub Rotation

Rotates each iteration by this degree.

Sub Offset

Offsets each iteration by this amount.
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Center Subscale

To calculate each iteration from the same point as the previous, check 
this control.

This can result in the appearance of duplicated layers stacked on top of 
each other.

To avoid this type of repetitive fractal look, leave this control un-checked.

Center subscale, sub rotation = 0 Center subscale, sub rotation = 10

Evolution

The Evolution control effects subtle changes in the shape of the fractal. 
Animating this setting will result in smooth changes or “evolution” of the noise 
over time. (Example: clouds passing, water flowing)

To change the Evolution setting do one of the following: 

1. Adjust the Evolution dial in the Effect Controls window.

2. Click on the underlined Evolution value and enter amounts for revolutions 
and degrees in the dialog box.
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Set keyframes for Evolution to determine how much the fractals will “evolve” 
over the period of time allowed between keyframes. The more revolutions 
that are made within a given amount of time (between keyframes) the more 
rapidly the noise will change. Large changes in Evolution values over a short 
period of time may result in flashing rather than smooth changes in the noise.

Evolution Options

Because of the complexity of the fractal shapes that generate the noise in the 
Noise Turbulent effect, render time can be consuming. For this reason, the 
Evolution Options provide controls that allow you to render the effect for one 
short(er) cycle and then simply loop it to repeat for the duration necessary for 
your project.

IMPORTANT: Although the Evolution value is set in units called 
“revolutions”, it is important to realize that these revolutions are 
progressive. The term “revolution” usually refers to a setting that 
returns to the same value at the same point on the dial control every 
360°. For example, the value at 0° is usually the same as the value at 
1 revolution (i.e. As with the transform property Rotation or the 
“Direction” control in AE Drop Shadow). 

In the case of Evolution (as with a few other effects’ controls, such as 
Twirl Angle in AE Twirl), the image continues to change with each 
added revolution. The appearance when set to a value of 0° is 
different from that at 1 revolution, which is different from that at 2 
revolutions, and so on. The Evolution state continues to progress 
infinitely at each new value. The only way to force the Evolution 
setting to return gracefully to its original state (necessary to create a 
seamless loop) is to use the Evolution Option, Cycle Evolution, 
explained below.
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Cycle Evolution

Checking the Cycle Evolution check box creates a cycle of evolution that 
loops over the set amount of time. Cycle Evolution forces the evolution 
“state” to return to it’s starting point in order to create a looping animation.

Although copying and pasting Evolution keyframes will return Evolution 
to the same value, the animation will act like a ramp rather than a 
smoothly transitioning cycle, repeating itself as it interpolates between 
the keyframes. Use Cycle Evolution and the Cycle controls to create a 
smooth, progressive cycle, non-repeating cycle (or loop segment).

This control can save a great deal of rendering time. Use it to create one 
short seamless evolution cycle (where the last frame matches up to the 
first) to be pre-rendered and looped as a new source layer in a 
composition, rather than setting Evolution to animate over a greater 
number of frames. (See Creating a Seamless Loop below.)

Cycle

Note: This control is only available when the Cycle Evolution check 
box is checked.

The Cycle value determines the number of revolutions (of the Evolution 
setting) that the fractal noise will cycle through before it repeats. The 
timing or speed of these Evolution cycles is determined by the amount of 
time allowed between Evolution keyframes.

Note: The Cycle control affects only the state (Evolution) of the 
fractal, not geometrics or other controls. (e.g. Two identical states 
of the fractal will not appear the same if viewed with different Size 
or Offset settings.)

Random Seed

This control sets a unique random value from which to generate the 
noise.

Animating the Random Seed will result in flashing from one set of fractal 
shapes to another (within that fractal type). For smooth transition of the 
fractal shapes use the Evolution control.
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Tip: Easily create new fractal noise animations, by re-using 
previously created Evolution cycles and changing only the Random 
Seed value. Entering a new Random Seed value alters the noise 
pattern without disturbing the evolution animation. The Evolution 
keyframes and Evolution Options can be left untouched.

For further examples of how to use the Evolution Options, see To Create 
a Seamless Loop (below), the Evolution Options Appendix, and the Basic 
Tutorial for CE Noise Turbulent II.

Opacity

The Opacity control sets the transparency of the fractal.

You can composite the fractal with the original image by selecting an 
appropriate Transfer Mode. But you don't have to. Select the Transfer Mode 
None to render the fractal alone.

To adjust the Opacity value use the slider in the Effect Controls window or 
click on the underlined Opacity value and enter an amount between  0 and 
100 into the dialog box.

Transfer Mode

Choose from various Transfer Modes in the pop-up menu to select an 
operation between the fractal noise and the original layer. These Transfer 
Modes are identical to the ones in the After Effects Modes panel with the 
following three exceptions:

None

Renders the fractal only, does not composite with original layer.

Hue

Renders the fractal as hue values instead of grayscale. The Saturation and 
Lightness of the original layer is maintained. If the original layer contains no 
saturation, nothing will happen.
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Saturation

Renders the fractal as saturation values instead of grayscale. The Hue and 
Lightness of the original layer is maintained. If the original layer contains no 
saturation, nothing will happen.
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Example

To Create a Seamless Loop

Follow the steps below to walk through the Evolution control and Evolution 
Options.

1. Set two keyframes for Evolution. 

2. Adjust the time allowed between keyframes, and the number of Evolution 
revolutions until you are satisfied with the animation of the noise.

3. Check the Cycle Evolution check box.

4. Set a value for Cycle.

The evolution will now cycle the number of revolutions determined by the value 
set for Cycle. This cycle will take place within the time allowed for that number of 
revolutions between the Evolution keyframes.

Determine the value for cycle by considering the following: How much of this 
cycle do you need to render before it repeats? The length of your piece and your 
use of the cell pattern created will determine this. Do you need 5 seconds of a 
non-repeating animated cell pattern? Is 3 seconds enough? You will want to 
choose the shortest length appropriate for your project to save rendering time.
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A cycle is created. Initially, however, the last frame of a cycle is identical to the 
first frame. To create a seamless loop, you want to skip the last frame to avoid a 
duplicate frame in the loop. To do this, set the out point of the layer one frame 
before the last frame of the cycle. Continue following the instructions below. 

5. Move the time marker to the point on the timeline where your Cycle 
completes. (i.e., if your Cycle value is 2, find the frame on the timeline where 
your Evolution value is 2 revolutions.

6. Move the time marker back one frame.

7. Trim the layer’s out point at this frame.

8. Pre-render this layer, and import it into your project. 

9. Set this pre-rendered footage item to loop by selecting it in the Project 
window and choosing File> Interpret footage. Find the Loop field at the 
bottom of the Interpret Footage dialog box, and set the number of loops 
required for the duration of the layer within your project.

REFERENCE: For further examples of how to use the Evolution Options, see the 
Evolution Options Appendix and the Basic Tutorial for CE Noise Turbulent.

IMPORTANT:
1. When using Cycle Evolution to create a seamless loop set Evolution 
keyframes using full revolutions only. Avoid using degrees, as partially 
completed revolutions may create hiccups in your seamless loop. 

2. Choose a value for Cycle that either matches or is evenly divisible by 
the number of revolutions set for Evolution. This will ensure that your 
cycle is able to complete full revolutions rather than partial ones, again, 
avoiding any glitches in the cycle.

3. If you have set keyframes for any of the other controls, you must return 
them to their initial settings at the point on the timeline where the cycle 
begins to repeat. Otherwise, these properties will not loop. 
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General Overview

Use CE Optics Compensation to add 
or remove camera lens distortions. 
The effect has a reverse option to 
ease the process of matching CG 
elements to live footage and vice 
versa. The distortion amount is 
relative to Field Of View. A wide angle 
lens has a high Field Of View.

Why Use CE Optics Compensation?

Elements composited with mis-
matched lens distortion will cause 
viewers to notice anomalities in the 
animation. For example, tracked 
objects in a distorted scene will not 
match the scene area, because linear 
objects do not follow the distortion of 
the scene.

Original Compensated

Original  + Matched CG Compensated + Matched CG
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Controls

Field Of View (FOV)

Apply the optics distortion corresponding to this value. The FOV angle is 
relative to the size of the source layer and the FOV Orientation selected.

High Field Of View Low Field Of View

Reverse (Lens Distortion)

Check this box for reverse lens distortion. If this control is checked, the 
Resize control is enabled.

Example:

To remove wide angle lens distortion, set Field Of View to 40.0 and check the 
Reverse check box. The zoom factor used when the shot was taken will 
influence the Field Of View value. It may need to be adjusted.

FOV

ABC ABC
FOV
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FOV Orientation

Determine the axis on which to base the Field Of View value.

This is useful when matching CG elements to the rendered view angle which 
is commonly based on these options. Note: Refer to your 3D application for 
information on which axis to base the FOV value.

Horizontal Vertical Diagonal

View Center

Use this control to set an alternate center point of view.

This is useful when using custom lenses that are not centered. However, in 
most cases, this control should be left untouched.

To set the View Center value do one of the following:

1. Click once on the cross hair and position it over the point in the 
Composition window you wish to be the new center point. Click once to 
place. Click and drag the Center point control to adjust this value.

2. Click on the underlined X,Y coordinates and enter values numerically into 
the dialog box.

Optimal Pixels

The Optimal Pixels option maintains as much pixel information as possible 
through the distortion. When this control is checked, FOV values are no 
longer reversible.
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Resize

Use this option to resize the layer when the applied distortion stretches the 
layer beyond its boundaries. This control is enabled only when Reverse Lens 
Distortion is checked. 

Choose from the following options

Off

Does not resize the layer.

Max 2X

Resize to a maximum of twice the original width and height.

Max 4X

Resize to a maximum of four time the original width and height.

Unlimited

Resize as far as the layer is stretched. This option may require a very large 
amount of memory.
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More on Optics Compensation

Finding the Field Of View Value

To find the correct Field Of View value of distorted footage, find an edge or 
line in the footage that has been distorted, but should be straight. Adjust the 
Field Of View angle until the edge is straightened out. The distortion is 
corrected.

The areas marked in the green serve as good references because they 
contain long curved lines (that should be straight) and are oriented 
perpendicular to the center. Because they are far from the center of the 
image, they show more distortion, making it easier to detect when they are 
straight. The area in the red box is not a helpful reference because it’s close 
to and oriented nearly radialy from the center.

Original Reference Areas
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Adjusted Field Of View

Under Over

Match

While adjusting the above image, these illustrations show different FOV 
values, Notice the dotted blue lines used as guides to compare the 
adjustment.

Under: Not enough, lines are still curved.

Over: Too much, lines are curving in the opposite direction.

Match: A close match, all lines are straight.

Once the correct value is found, the same value can now be applied in 
reverse to CG material to match the distortion of the footage. This will 
composite the CG element with the footage using a matching lens distortion. 
This is often necessary, as nearly all 3D programs produce flat, non distorted, 
material.
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IMPORTANT: A Few Things to Know about Field of View (FOV)

Matching the FOV:
There is no general rule as to what FOV value applies to different lenses. 
Finding the correct FOV value is a manual process. A number of 
properties affect this value, including the lens, zoom factor,  and inner 
optics of the camera. Note: For footage with zooming involved, the FOV 
value must be keyframed, as zooming in reduces the FOV and vice 
versa.

Layer Sizes and FOV:
When adding distortion, higher FOV values require larger sources. When 
adding wide angle distortion, the source layer needs to be larger than 
that of the final output. A wide angle lens reveals areas that would not be 
visible with a more narrow lens. If those areas are not in the source, 
Optics Compensation cannot fill those areas and leaves them 
transparent.

For reverse distortions, the result will be larger for higher FOV values.
The Resize option can automatically set the layer size to accommodate 
the distortion.

To Apply Other Effects While Adjusting FOV:
To match FOV values, layers must be the same size. However, there is 
one exception.

If you apply CE Optics Compensation with Resize on, you can apply the 
filter again and reverse the distortion using the same value (reversed). 
Apply another effect in between the two instances of CE Optics 
Compensation, eliminating the need to precompose.

If you pre-compose a layer resized by CE Optics Compensation into a 
larger Comp, you can not reverse the distortion of the pre-comp using 
the same value because the pre-comp no longer has the same size. You 
must enlarge the pre-comp larger to accommodate the expanded layer.
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Matching FOV with CG

Original footage, shot with a wide angle lens. The distortion equals a Field Of 
View at 46 (degrees). It is not possible to match a flat surface to the wall. 
Notice how the roof edge is curved by the lens distortion. See previous 
section finding the FOV Value for more information on matching the FOV 
Value.

Step 1.

Flatten the footage, using Reverse FOV of 46. It is now possible to match the 
flat surface to the wall.
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Step 2.

Precompose the matched surface (from step 1). Turn off or remove CE 
Optics Comp from the footage layer. Apply CE Optics Compensation to the 
precomposition layer, using the same FOV angle as above. It is now possible 
to match the surface to the original footage. This shows how to match footage 
to CG and CG to footage. In either case, the footage must be ‘flattened’ as 
shown in step 1.
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About the CE Paint chapter

The manual is layed out in the order that the controls appear when CE Paint is 
applied to a layer. A brief Getting Started Tutorial gets you up and running  
immediately. Following are detailed descriptions of each of the Effect Controls, the 
tools in the custom Toolbar, and the CE Paint Contextual Menus. Finally, discover 
more precise control within the CE Paint Preferences, and  more efficient workflow 
with the Keyboard Shortcuts.  

Read the entire chapter from start to end, or click on the bookmarks to the left to view 
topics interactively as needed. But, most of all, enjoy... AT LAST,  paint within After 
Effects!
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General Overview

CE Paint is a vector-based and non-
destructive filter for painting directly 
within the After Effects’ Composition 
window. Each stroke is recorded in 
real-time and can be animated. The 
filter supports Wacom and Creation 
Station tablets pressure stylus and 
erase functions. All paint settings can 
be modified interactively, or through a 
custom toolbar and contextual menus 
which appear in the Composition 
window.

CE Paint is useful for all kinds of 
painting...from matte touch-ups to 
animated signatures,  character 
animations,  or even full scene 
paintings.

IMPORTANT: To perform Paint actions in the Composition window, the CE 
Paint effect must be selected (highlighted) in the Effect Controls window. 
Also, to access the CE Paint interface in the Comp window, the After Effects 
arrow tool must be selected (e.g. you can not paint using the magnifier tool).
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Vector Based Strokes

CE Paint uses vector based paint strokes. All paint strokes are recorded and 
stored as they are drawn, making it possible to control the playback speed and 
appearance of the strokes. 

The paint strokes are rendered in supreme quality, using spline based 
interpolation and high antialiasing. Because the painting is vector based, it's also 
non-destructive. Your source material is always left untouched.

For animated strokes, the exact timing  (realtime) used to draw strokes can be 
played back  and rendered. It can also be sped up or slowed down to fit a given 
time frame.

Many of the stroke settings can be altered for any paint stroke at any time.
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Getting Started

Before reading through the specific tool descriptions and menu explanations that 
follow, begin with this brief Getting Started tutorial to familiarize yourself with 
some quick and easy ways to put CE Paint to use immediately.

Follow the steps in this tutorial to create an animated signature.

1. Create a New Composition.

2. Create a New Solid. Set the Solid size to the size of your Comp frame, and 
choose any color you like.

3. Select the Solid layer and choose Effects > Cult Effects > CE Paint to apply 
the effect.

4. To begin painting select the effect’s name CE Paint in the Effect Controls 
window. This activates the paint controls and display’s the CE Paint Toolbar 
along the left edge of the After Effects Comp window.

5. Use the Brush settings in the Effect Controls window to select the type, size, 
feather, opacity and color of brush to paint with. For this exercise choose 
Brushtype Paint, set Radius to 20, and choose your favorite color. (Best to 
make sure that the color will show up over the solid color you have selected.)  
Leave all other settings at their defaults.

TIP: To Interactively set your brush Radius and Feather press 
Command (Mac) or Control (Windows) and click in the Comp window. 
Drag in or out to resize the brush. Release the Command or Control key 
and drag inward to resize the feather.

See Effect Controls >  Brush Settings for more information regarding these 
controls.

6. Choose Animate Strokes from the Playback Mode pull down menu. This 
option will playback the stroke as it is drawn, beginning at the current frame 
when it’s drawn.

See Effect Controls >Playback Mode for more detailed descriptions of these 
options.

7. Leave In Original selected in the Composite Paint options in the Effect 
Controls window. This will composite the paint strokes on the solid layer.

See Effect Controls > Composite Paint for more detailed descriptions of 
these options.
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8. Press the Control key (Mac) or right click (Windows) and click anywhere in 
the Comp window to access the CE Paint Contextual menus. Choose 
Options > Shift Paint Record Strokes > Realtime. This sets the record method 
for stroke start times and pauses between strokes to playback in realtime.

See Contextual Menus > Shift Paint Record Strokes for more information 
regarding these options.

9. Set the current time (in the Time Layout window) to the frame where you want 
to begin painting. For this exercise set the current time to 0:00.

10. Press the Shift key (hold it down) and begin writing your signature.

11. When you have finished, let go of the Shift key.

12. Notice that the signature disappears after you let go of the Shift key. This is 
because the current time is set to 0:00. The strokes are set to animate (by 
choosing Animate Strokes in Step 6) and have not yet been drawn into the 
frame.

13. Press the Spacebar to play back your animation, or press 0 on the keypad to 
build a realtime preview.

See Controls > Playback Speed for information regarding adjusting the 
speed of the playback.

14. You should see a fully animated signature. Congratulations! You have just 
completed your first project in CE Paint. Set a work area for the duration of 
your stroke animation, and render.

15. Continue reading for more information regarding CE Paint’s features, 
controls, tools and menu options. Try the referenced CE Paint tutorials to 
explore more cool ways to use CE Paint.
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Effect Controls

Brush Settings

This first control is an interface to control the brush settings for painting. It 
contains the settings listed below.

Radius

Controls the size of the brush. Set the brush’s Radius by clicking on the 
underlined Radius value and entering an amount into the dialog box, or 
by clicking and dragging on the scrubber (↔). Scrub to the left to 
decrease and to the right to increase the brush Radius.

Feather

Controls the softness of the brush edges. Set the Feather amount by 
clicking on the underlined Feather value and entering an amount into the 
dialog box, or by clicking and dragging on the scrubber  (↔). Scrub to the 
left to decrease and to the right to increase the Feather amount.

Feather amount is adjustable only for Paint and Square Brushtypes. 
Although the Feather control is disabled (gray) when other Brushtypes 
are selected, you can still adjust the Feather amount. The amount you 
enter is stored and used when you next select a Brushtype that uses 
Feather.

Tip: Set the brush Radius and Feather interactively by pressing Cmd 
(Mac) or Crtl (Windows) and clicking in the Comp window, dragging in 
or out to resize the brush. For brushes with Feather (Paint and Square), 
release the Cmd or Ctrl key and drag inward to resize the Feather.
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Opacity

Controls the opacity of the brush strokes. Increase or decrease the 
Opacity used when drawing strokes by clicking on the underlined Opacity 
value and entering an amount into the dialog box, or by clicking and 
dragging on the scrubber (↔).Scrub to the left to decrease and to the 
right to increase the Opacity amount.

Tip: Scrubber Hints:

• Press Option (Mac) or Alt (Windows) while using the Radius, 
Feather or Opacity Scrubbers (↔) for finer adjustments. (Slows the 
scrubbing for single value or percent adjustments).

• Press Shift while using the Radius, Feather or Opacity Scrubbers 
(↔) for larger adjustments. (Increases the scrubbing to adjust the 
value by steps of 10.)

Brushtype

Choose the style of brush to paint with by clicking on the underlined 
Brushtype. Clicking here will toggle through the four available 
Brushtypes: Solid, Paint, Air and Square. Notice that the Brushtypes on 
the toolbar become highlighted as you do this.

Solid

Paint with hard edged strokes using a round brush. There is no Feather 
available for this Brushtype.

Paint

Paint with a paint brush. Adjust the feather to manipulate the softness of 
the strokes’ edges. When Opacity is set to less than 100% Paint brush 
strokes behave like a coats of paint, building up on each other. Opacity 
increases where the strokes overlap.
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Air

Paint with soft edged strokes, simulating an airbrush. Opacity builds as 
you cross a stroke over itself. There is no Feather available for this 
Brushtype.

Note: Notice that at 100% Opacity and 100% Feather the Paint and 
Air brushes look almost identical. However, as mentioned in the 
descriptions above, their behaviors when overlapping strokes are 
different. Air brush strokes build up opacity as you cross a single 
stroke over itself. Paint brush strokes will not build up opacity 
within the same stroke. Multiple strokes must be overlapped (like 
multiple coats of paint being applied) to increase opacity in an area 
when using the Paint brush.

Square

Paint with a square shaped brush. Adjust the Feather to manipulate the 
softness of the strokes’ edges. Behaves like the Paint brush (see above).

Note: Each of these Brushtypes are also available for the Eraser 
tool. When the Eraser tool is selected in the Toolbar, the Brushtype 
names appear with an -E after them in the Effect Controls window. 
Also, if a tablet is installed and the stylus has eraser support, CE 
Paint will automatically switch to eraser mode when the stylus 
eraser is used.

Color

This Color swatch represents the paint color used to draw strokes. Select 
the Color to paint with by clicking once on the Color swatch to use the 
Color Picker, or by using the Eyedropper to sample a Color from the 
desktop.

When a stroke or strokes are selected, this swatch will display the Color 
of those strokes. The Color of the selected strokes can be changed by 
clicking on the Color swatch or by using the Eyedropper.

If the selected strokes are different colors, a “-?-” will replace the Color 
swatch. Click on the “-?-” or use the Eyedropper to replace each of the 
original stroke Colors with the new Color.
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Colorclone

Click on the underlined Colorclone toggle to turn Colorclone on or off.

Turn Colorclone on to pick the paint Color from the brush position on the 
source layer. When Colorclone is turned on the brush behaves like a 
combination eyedropper and brush. The color of the stroke is determined 
by the pixels at the position where the stroke begins. As you click to begin 
the stroke, the pixels below the brush are sampled and that color sample 
is used to draw the stroke until the mouse is released. The Color swatch 
in the Effect Controls Brush Settings updates to reflect the new sampled 
color. When you begin a new stroke a new group of pixel are sampled 
and used as the stroke color for that stroke. 

The Colorclone only affects strokes while drawing them, it has no effect 
on a selection.This is the only Brush Setting that can not be changed in 
retrospect.

Tip 1: Use Colorclone to create the look of brushstrokes over an 
image. Enable Wiggling to animate these strokes.

Tip 2: If you paint your strokes left to right, begin painting at the right 
side of an image to continue sampling from the left. This way you 
continue sampling the original color(s) rather than the stroke color 
as you move across the image.

Stylus Settings

When Stylus check boxes for Radius and Opacity are checked, and a 
supported tablet is connected to the system,  Radius and Opacity 
amounts become sensitive to the tablet’s pressure stylus and erase 
functions. If they are un-checked, the amounts set for Radius and Opacity 
are used.

Note: CE Paint supports Wacom and Creation Station tablets 
pressure stylus and erase functions.

See CE Paint Preferences or Options>Edit Preferences for more Stylus 
controls.
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Stylus Radius

When checked, changing the pressure of the pen on the tablet varies the 
weight of the stroke as it’s drawn. Lighter pressure results in a smaller 
Radius value or thinner stroke, whereas increased pressure increases 
the Radius, widening the stroke. The current Radius value will be used as 
the maximum Radius amount. Use the tablet settings to adjust the 
pressure/width sensitivity for the pen.

Stylus Opacity

When checked the variation in pressure of the pen on the tablet alters the 
opacity of the stroke as it’s drawn. Light pressure results in lower opacity 
values, while increased pressure creates more opaque strokes. The 
current Opacity value is used as the maximum Opacity amount.

Note: If a tablet is not installed these flags will be dimmed. They 
can however, still be checked and un-checked. Checking these 
flags while dimmed affects strokes when wiggling is enabled. See 
Wiggle Controls: Pressure Settings for more information.

Editing Brush Settings

After strokes are drawn, their Brush Settings can be edited by selecting them 
with the Selection tool (Arrow). Click and drag the arrow across a stroke to 
select it.

When a single stroke or strokes with the same Brush Settings are selected 
you can edit the enabled Brush Settings in the Effect Controls window. 
Changes made will be reflected in strokes in the Comp window.

When more than one stroke is selected, and the strokes contain varying 
Brush Settings, a “-?-” appears next to that Brush Setting. If you edit that 
value, all of the selected strokes will be reset to the new value. 

For example, if you select strokes with different Radius values, a “-?-” 
appears in place of the Radius setting. Click on the Radius setting and enter 
5.0. All of the selected strokes now have a Radius value of  5.0.
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Editing the Radius using Relative Values

Relative values allow you to edit the Radius settings of selected strokes 
based on their original values.

If you press Option (Mac) or Alt (Windows) when clicking on the “-?-”Radius 
value, CE Paint will allow you to enter a Relative Radius percentage value. 
The default value is 100%, which produces no change in the strokes’ Radius. 

For example, if you have selected three strokes with Radius values of 5, 10 
and 20, press Option/Alt and click on the “-?-” Radius value in the Effect 
Controls window. A Relative Radius dialog box appears. Enter a percentage 
amount. The original Radius value of each stroke will be multiplied by the 
percentage entered here, setting a new value for the Radius of each stroke. 

If you enter a Relative Radius value of 200%, each stroke will be increased 
2x. The strokes will now have Radius values of 10, 20 and 40. In the Comp 
window, each of the strokes double in width. 

If you enter a Relative Radius value of 50%, the Radius of each stroke will be 
decreased by half of the original Radius value. The strokes will now have 
Radius values of 2.5, 5 and 10. In the Comp window, each of the strokes will 
be half of their original widths.

Normal Relative Radius value 200% Relative Radius value 50%

Playback Mode

Choose from the pop-up menu how the strokes will playback. This setting 
determines how painted strokes appear onto the frame during playback.

When you draw strokes, CE Paint records information for the stroke start time 
and the timing of each stroke. The Playback Mode that is chosen determines 
when a stroke will start and for how long it will appear. The speed at which  
the strokes are played back can later be modified using Playback Speed.

Playback your strokes by using the Spacebar or RAM Preview, or by 
reviewing the results of a rendered Comp.
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The Playback Mode chosen affects what you see during playback. However, 
it also determines what you see while you are drawing strokes. Onion Skin 
mode, for example, is used primarily while drawing strokes, and another 
option is chosen before rendering.

Remember that regardless of how you’ve recorded your strokes, and which 
Playback Mode was selected when recording, you can always switch to 
another Playback Mode at any time. 

Original Strokes

The following illustration represents 9 strokes used to draw a simple house 
animation. Strokes 1,2 and 3 were drawn at current time 0:00, Strokes 4,5, 
and 6 at 2:27, and 7, 8 and 9  at 5:15. The red solid lines represent the 
strokes' original start times and recorded durations. In the illustrations that 
follow, note the effect of each Playback Mode on the start time and duration 
of the strokes.

IMPORTANT: Notice the position of the Current Time Marker when 
you begin drawing strokes.

Stroke 1, 2, 3 Stroke 4, 5, 6 Stroke 7, 8, 9

1

4

7

2

5

8
3

6
9
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All Strokes

Displays all strokes at all times. All strokes appear for the entire duration of 
the layer on which they are drawn.

Past Strokes

Strokes cut in at the time they were recorded and are displayed (along with 
any previously drawn strokes) until the end of the layer. In other words, 
strokes appear from the frame on which they are drawn until the layer’s out 
point. As more strokes are added, they build up over one another until the 
end of the layer or Comp.

Hold Strokes

Displays strokes from the frame they are drawn on until the time when the 
next stroke is drawn. Treats strokes like Hold keyframes, the strokes appear 
one replacing the next, like a slide show.

Stroke 1, 2, 3
Stroke 4, 5, 6

Stroke 7, 8, 9

Stroke 1, 2, 3
Stroke 4, 5, 6

Stroke 7, 8, 9

Stroke 1, 2, 3
Stroke 4, 5, 6

Stroke 7, 8, 9
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Animate Strokes

Animate Strokes will begin drawing the stroke at the current time (i.e. the 
frame where the Current Time Marker was sitting when you drew the stroke). 
The stroke will animate on as it was drawn. 

Current Frame

Current Frame is the default Draw Strokes setting. Displays the stroke only 
at the frame (timecode) on which it was painted.

IMPORTANT: Whenever you draw a stroke, CE Paint records in 
realtime the speed at which the stroke is drawn (as well as the shape 
of the path and any pressure data). When other Draw Strokes options 
are selected, this recorded speed information is not utilized. 
However, when Animate Strokes is selected the way that you draw 
the stroke controls the speed at which it will be drawn onto the 
Composition frame.

Stroke 1, 2, 3

Stroke 4, 5, 6

Stroke 7, 8, 9

Stroke 1, 2, 3
Stroke 4, 5, 6

Stroke 7, 8, 9
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Onion Skin

Displays dimmed strokes on forward or backward frames from the current 
frame for reference. Onion skinning is very useful in frame by frame 
animation of strokes. The strokes are drawn as they are in Current Frame, 
existing only at the frame when they are drawn, however previous and 
forward reference frames are also displayed according to Onion Skin 
Options.

Access Onion Skin Options by clicking on the underlined “Options... “ in the 
upper right corner of the Effect Controls window, or by selecting Options > 
Edit Preferences from the CE Paint contextual menu.

See CE Paint Preferences: Onion Skinning Options for more information.

Playback Speed

Controls the playback speed of painted strokes. A Playback Speed value of 
1.00 (default value) equals the original duration of the strokes. Increasing this 
value speeds up the playback of strokes, while decreasing this value slows it 
down.

Note: Playback Speed is enabled only when using Past Strokes, Hold 
Strokes and Animate Strokes Playback Mode options.

To adjust the Playback Speed do one of the following:

1. Use the slider (preset to values between 0.2 and 5.0) 
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2. Click on the underlined Playback Speed value and enter an amount 
between -100 and 100.

The following illustrations indicate the effects of adjusting strokes' Playback 
Speed.

Original Strokes

Original stroke durations.  Playback Speed set at 1.00. Strokes and gaps (or 
pauses) are represented with original Playback speeds. Stroke 1 begins at 
0:00, Stroke 2 at 2:10, and Stroke 3 at 5:15.

Increase Playback Speed

Playback speed set at 2.00. Strokes and gaps (or pauses) are sped up, and 
will playback twice as fast. Stroke durations and gaps (or pauses) are now 
half their original length. Note that Strokes 2 and 3 begin earlier as a result.

Stroke 1 Stroke 2 Stroke 3
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Decrease Playback Speed

Playback speed is set at 0.80. Strokes and gaps (or pauses) are slowed 
down, and will playback at 80% of their original speed. Stroke durations and 
gaps (or pauses) are now lengthened. Note that Strokes 2 and 3 begin later 
as a result. Stroke 3 is cut off by the original layer's out point.

Tip 1: Always begin painting strokes at a layer’s in point, especially 
when adjusting the Playback Speed. Doing this locks the “in point” or 
first stroke’s start time to the in point of the layer making it easier to 
locate the beginning of the animation. Then, simply place the layer’s in 
point where you want the animation to begin in the composition.

Tip 2: To change the speed of a “Current Frame” animation, switch the 
Playback Mode to “Hold Strokes” and then adjust Playback Speed. 
Playback Speed is not enabled while using “Current Frame” Playback 
Mode, as the strokes are “locked “ to each frame. Switching to “Hold 
Strokes” allows you to lengthen (slow down) the animation by 
decreasing Playback Speed to less than 1.0, or speed up the animation 
by increasing Playback Speed to greater than 1.0.

Note: If working with a frame by frame animation (a different stroke 
drawn on each frame using “Current Frame”), some frames will be 
skipped when speeding it up, this may cause a slight jerkiness in the 
playback.

Wiggle Control

Enable Wiggling

When strokes are drawn in CE Paint, they are made up of many tiny 
points which create the stroke’s path. Although these individual points 
cannot be isolated and adjusted individually by the user, they are utilized 
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by CE Paint in features like the Smoother and Wiggling. The wiggling of 
a stroke is created by manipulating and displacing these points along the 
stroke’s path.

When Enable Wiggling is checked, all strokes on that layer are set to 
wiggle using the Wiggle Control values set in the Effect Controls window 
(described below).

Wiggles/sec

This value determines the number of Wiggles per second of Composition 
time. Wiggling is spline based morphing of paint strokes. Wiggles/sec 
controls the speed at which the morph completely shifts shape. Lower 
values result in a smooth animation of morphing strokes. Higher values 
create more rapid wiggling.

Example: In a 30fps Comp, setting the Wiggle/sec value to 30 will create 
one wiggle per frame.

Set the Wiggle/sec value by using the slider in the Effect Controls window 
(preset to values between 0 and 30) or by clicking on the underlined 
Wiggle/sec value and entering an amount between 0 and 1000 into the 
dialog box.

Displacement Variation

Determines how far the stroke will move from it’s original position while 
wiggling. Greater values will produce greater distances of movement 
from the stroke’s original position. Lower values create smaller stroke 
movements while wiggling.

No Displ. Variation Medium Displ. Variation High Displ. Variation

Set the Displacement Variation value by using the slider in the Effect 
Controls window (preset to values between 0 and 100) or by clicking on 
the underlined Displacement Variation value and entering an amount 
between -30,000 and 30,000 into the dialog box.
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Displacement Detail

Determines how much the original shape of the path is altered while 
wiggling (i.e. how many points along the path will be displaced, or moved 
from their original positions). Greater values increase the detail of 
displacement (or change in shape) in the stroke, by moving more points. 
Lower values produce less displacement, leaving the path closer to it’s 
original shape. 

When Displacement Detail values are set very high, the stroke may not 
resemble its original shape at all. This is useful in creating randomly 
animated strokes.

Low Displacement Detail Medium Displacement Detail High Displacement Detail

Set the Displacement Detail value by using the slider in the Effect 
Controls window (preset to values between 0 and 100) or by clicking on 
the underlined Displacement Detail value and entering an amount 
between 0 and 1000 into the dialog box.

Pressure Settings

Note: Strokes that do not have either Stylus Radius or Stylus 
Opacity options enabled are not affected by the Wiggle Pressure 
Settings. However, note that these options can be enabled even 
when a tablet is not installed. 

Checking the Stylus Radius and Stylus Opacity flags for mouse-drawn 
strokes simply allows the Radius and Opacity of these strokes to wiggle. 
(Note: The flags appear grayed out, but can still be checked.)

Checking the Stylus Radius and Stylus Opacity flags for strokes drawn 
with a pressure sensitive pen allows the pressure information to be 
recorded. This information then contributes to the variation of the stroke 
while wiggling is enabled.
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Note: Pressure Variation and Pressure Detail are influenced by the 
number of points on a stroke. The fewer points the less influence 
the Pressure Variation and especially Pressure Detail will have on 
the wiggled stroke(s). Points are reduced by Smoothing a stroke.

Pressure Variation

The Pressure Variation value determines how much the Radius and 
Opacity values of the stroke vary while wiggling. For strokes that have 
Stylus: Radius enabled, the Radius wiggles. For strokes that have Stylus: 
Opacity enabled, the Opacity wiggles. The amount of variation in either 
the Radius or Opacity value while wiggling is set according to the value 
entered for Pressure Variation.

The Radius and Opacity settings in the Brush Settings act as maximum 
amounts. These values will not be exceeded while wiggling. 

No Pressure Variation Low Pressure Variation High Pressure Variation

Set the Pressure Variation value by using the slider in the Effect Controls 
window (preset to values between 0 and 100) or by clicking on the 
underlined Pressure Variation value and entering an amount between       
-30,000 and 30,000 into the dialog box.

Pressure Detail

The Pressure Detail value determines how many points along the path 
are effected by the wiggle.

Increasing this amount results in quirkier strokes, as more points have 
their values being wiggled.
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Low Pressure Detail Medium Pressure Detail High Pressure Detail

Set the Pressure Detail value by using the slider in the Effect Controls 
window (preset to values between 0 and 100) or by clicking on the 
underlined Pressure Detail value and entering an amount between 0 and 
1000 into the dialog box.

Individual Stroke Seeds

When checked creates a different random wiggle seed for each stroke on 
a layer.

Because the Wiggle Controls apply to all strokes on a layer, the wiggle 
parameters are always the same. To randomize the wiggling of the 
individual strokes, check the Individual Stroke Seeds check box.

If un-checked, all strokes use the same wiggle seed, and they all end up 
with the same spatial wiggle values. For example, two strokes that lay 
exactly on top of each other will be equally wiggled. By setting individual 
seeds for each stroke, that "homogeneity" of stroke animation is avoided  
(i.e. two identical strokes will not be wiggled the same).

Original Individual Stroke Seeds Individual Stroke Seeds 
Off On
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Composite Paint

The following Composite Paint options determine how strokes are 
composited with the original image and it’s alpha channel. As previously 
mentioned, CE Paint strokes are non-destructive, strokes can be added and 
erased without altering the source image layer.

Tip: Start over at anytime, by deleting all strokes or the effect itself. The 
layer will return to its original appearance. To delete all strokes press 
Shift+A to select and Delete (Windows) or Backspace (Mac) to remove. 
To delete the effect select CE Paint in the Effect Controls window and 
press Delete/Backspace.

Composite Paint Options

In this section, the following illustrations are used to demonstrate each of  the 
Composite Paint options. The blue rectangles on the left represent the 
original layer which is being painted on. The green strokes on the right 
represent the paint and erase strokes which have been drawn onto that layer.  
Note the effect of both the paint and erase strokes on the RGB and alpha of 
the original as each of the Composite Paint options is described.

Original layer Strokes

IMPORTANT:  Whether created with a paintbrush or the eraser, both 
Paint and Erase strokes are just that: strokes. Erase strokes can be 
selected and deleted just like Paint strokes. The Composite options 
determine how both Paint and Erase strokes are composited in 
relation to the original layer and its alpha channel.

Paint strokes Erase strokes
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Only

Displays strokes only. The original source layer is not displayed. 

In Original

Paints strokes on the original layer. Erase strokes erase the original layer and 
any added Paint strokes.

Note: Again, remember that CE Paint is always non-destructive. 
Although it may appear that you are erasing your original layer, this is 
just a composite. The Composite mode can be switched at any time. 
Return to the original layer at any time by turning off the effect, deleting 
strokes or deleting the effect.
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Over Original

Composites Paint/Erase strokes on a virtual layer above the original. Erase 
strokes only erase the paint strokes, they do not effect the original image.

Under Original

Composites Strokes under the original layer. Erase strokes only erase the 
paint strokes, they do not affect the original image.

Track Original matte

Strokes are only visible inside of the original layer’s alpha channel. The 
original layer’s RGB is turned off. Erase strokes erase only the paint strokes, 
they do not affect the original image.

This option is useful if you want to paint strokes inside a logo or title’s alpha, 
or in using any image’s alpha channel as a stencil to paint within. 
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Track Original Matte Visible

Same as Track Original Matte except that the RGB of the original layer is left 
turned on.

Again, erase strokes only erase the paint strokes, they do not affect the 
original image.

As Matte

Paint strokes are used to reveal the original image only, and operate only 
within that layer's existing alpha channel. New areas of transparency cannot 
be added using this option. Erase strokes only erase the paint strokes.

As Inverse Matte

Paint strokes are used only to  block out  the original image.They operate only 
within that layer's existing alpha channel, creating an inverse matte for the 
original image layer. Erase strokes only erase the paint strokes.
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In Original Alpha Only

Allows painting on the original image layer’s alpha channel. Use paint strokes 
to add areas of transparency, and use erase strokes to block areas of 
transparency in the original alpha channel. Any color paint can be used, even 
gray, as Opacity and Feather values set for the strokes will determine the 
transparency of the painted area. 

Note: This option is the same as In Original except that only the alpha 
channel is affected, RGB is left untouched.

Under Original Alpha Only

The original layer’s alpha channel is left as is. This option allows painting only 
in addition to the original layer’s alpha channel.

Use paint strokes to add areas of opacity. Areas of transparency cannot be 
added using this option. Any color paint can be used, even gray, as Opacity 
and Feather values set for the strokes will determine the opacity of the 
painted area. Use erase strokes to erase paint strokes, they will not effect the 
original alpha.

Note: This option is the same as Under Original except that only the 
alpha channel is affected, RGB is left untouched.
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Toolbar

You can switch tools in the Toolbar shown in the Composition window or in the 
Contextual Menus.

Selection Tool (Arrow)

Select a stroke in the Composition window by clicking and dragging the 
Selection tool across the stroke.

Eyedropper Tool

Use the Eyedropper to sample a color to paint with from anywhere on the 
desktop. Press the Escape key to cancel the Eyedropper. 

Note: Eyedropper default samples a 3x3 pixel average. Hold down the 
Command (Mac) or Control (Windows) key to sample single pixels. 
Hold down the Shift key to sample pixels that the cursor is dragged 
over. 

IMPORTANT: When Rulers are enabled, the CE Paint tools will be 
obscured. Turn off Rulers to see the Paint tools.
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Paint Tool

Enables the Paintbrush tool. Settings are defined by Brush Settings in the 
Effect Controls window. The Paintbrush tool is represented as enabled in the 
Comp window by the cursor changing to a circle (or square) the size of the 
actual brush.

Eraser Tool

Enables the Eraser tool. Settings are defined by Brush Settings in the Effect 
Controls window. When the Eraser is enabled, the circular brush cursor 
appears with an X through it in the Comp window. 

Note: If a tablet is installed and the stylus has eraser support, CE Paint 
will automatically switch to eraser mode if the stylus eraser is used.

Color Swatch

Displays the Color that will be used to paint with. Click on the Color Swatch 
to choose a color from the Color Picker. This Color Swatch corresponds to 
the one in the Effect Controls window.  However, if opacity is set to less than 
100% in the Brush Settings, this swatch will appear like a checkerboard 
reflecting the opacity setting. 

Tip: Shift-Click the Color Swatch to set Opacity numerically.

Note: If Colorclone is turned on this swatch represents the sampled 
color, and you will not be able to access the Color Picker. See Brush 
Settings: Colorclone for more information.
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Undo

Click here to undo an undo-able action in CE Paint. If no undo is available, 
this tool will be disabled (gray).

Brushtypes

These four Brush tools represent and reflect the four Brushtypes also 
selectable under Brush Settings in the Effect Controls window. The selected 
Brushtype is highlighted. Click on the desired Brushtype to paint or erase with 
that brush.

Solid Paint Air Square
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Contextual Menus

CE Paints’ Contextual Menus contain commands and settings that are not 
otherwise accessible in the Comp window. Access these menus by holding down 
the control key  (Mac) or right clicking (Windows) and clicking with the mouse 
anywhere in the Comp window. 

Edit > Select >

All

Selects all strokes on a layer.

None

Deselects all strokes on a layer. Only enabled if strokes are selected.

Visible

Selects all strokes visible at the current time.

Current Time

Selects strokes that were originally drawn at the current time in the time line. 
(Playback Speed does not affect the original start time of strokes.)

Last Painted

Selects the last painted brush stroke, including erase strokes.

IMPORTANT: The effect’s name CE Paint must be selected in the Effect 
Controls Window to access the CE Paint Contextual Menus. Otherwise, 
you will be accessing After Effects’ contextual menus.
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Similar

With one or more strokes selected, Select > Similar selects strokes with 
similar Brush Settings properties. If strokes with dissimilar properties are 
initially selected, the range of what gets selected is broadened.

Inverse

Toggles to a selection of all un-selected strokes, leaving the previously 
selected strokes un-selected.

Edit > Delete >

Selected

Deletes all selected strokes on a layer.

All

Deletes all strokes on a layer.

Visible

Deletes all strokes visible at the current time.

IMPORTANT: Noticing Strange Behaviors?

After using RAM Preview (i.e. after AE has cached frames) one or 
more of the following strange behaviors may sometimes occur:

• A stroke may not be selectable with the selection tool. 

• Choosing Edit >Select Visible might select strokes from last cached 
frame (perhaps the last frame of the Preview) rather than the current 
frame.

If either of these occurs, use After Effects’ Purge Image Caches found 
in the Edit menu under Purge > Image Caches.
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Current Time

Deletes strokes that were originally drawn at the current time in the time line.

(Playback Speed adjustments do not affect the original start time of strokes.)

Last Painted

Deletes the last painted brush stroke, including erase strokes.

Edit >Destructive

The Smoother and Stroke Re-timer are listed under the menu heading 
Destructive because these are the only ways to actually destroy recorded  
information; by deleting recorded vector points on a stroke, or overwriting the 
recorded timing of a stroke.

Edit >Smoother...

The Smoother removes points from a selected stroke or strokes. Removing 
points simplifies the path of the stroke(s), smoothing the curves. 

When you select a path and choose Edit > Smoother... a dialog box will 
appear asking you to enter a Set Max Error amount. This sets the tolerance 
for the smoothing. The greater the value the more points on the path that will 
be removed, resulting in a "smoother" stroke. 

Set values within the range 0 - 100. The default value, 1.0, removes 
redundant points, maintaining detail in the stroke(s).

Next, a warning appears letting you know that removing these points may 
alter the shape of the path, and that this action cannot be undone. If you 
perform this on delicate strokes, press cancel and perform this action on a 
duplicate layer to make sure you do not end up with an unsatisfactory result. 
This really can not be undone!

After clicking OK, the path(s) of your stroke(s) will reflect the smoothing in the 
Comp window.

Note: When you have a very large number of strokes in a project, the 
After Effects project file will get very large. (For example, a project 
containing 8,000 strokes may require 6 MB of storage). Use the 
Smoother to cut this size by as much as half. 



CE 1.5 Manual

www.culteffects.com 238

Orginal Smoother value 1.0 Smoother value 10.0

Edit >Stroke Re-timer...

This feature requires a selection and will only affect the playback when using 
the Animate Strokes Playback Mode. Stroke re-timer lets you change the 
selected strokes duration with a relative value. Although the selected strokes’ 
durations are sped up or slowed down, their start times remain at their 
original positions on the timeline.

Select the strokes whose duration you would like to speed up or slow down. 
Choose Edit > Destructive > Stroke Re-timer from the CE Paint Contextual 
menu. Stroke re-timer then asks for a relative value by which to change the 
duration of each stroke.

The "Set Relative Duration (%)" dialog box appears. Entering 50(%) will 
change the duration to half the previous duration. Entering 100(%) will 
change nothing. Entering 200(%) will stretch all strokes (individually) to twice 
the previous duration.

This action can not be undone using undo, it is “destructive” because it 
overwrites the recorded timing of the stroke. However, it can be undone by 
applying Stroke Re-timer again, using the relative inverse of the previous 
value. For example, to undo a value of 50%, type in 200% to return to the 
previous duration.

IMPORTANT: Be sure to create a copy of the project before running 
the Smoother in case you are not happy with the effect of the 
smoothed strokes. Again, you can NOT use Undo after applying the 
Smoother.
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The following illustrations indicate the effects of using Stroke Re-timer.

Original Strokes

Original Stroke durations. Strokes are represented as recorded with original 
durations and start times.

Stroke Re-timer Increased

Strokes re-timed  to playback at double speed. Stroke start times remain at 
their original positions.

Stroke Re-timer Decreased

Strokes have been re-timed to playback at 80% of their original speed. Stroke 
start times remain at their original positions.

Stroke 1 Stroke 2 Stroke 3
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Undo

Undoes the last undo-able action. (Add/Delete of strokes, changing of Brush 
Settings). If no undo is available, this item will be disabled (gray).

Select

Highlights and enables the Selection tool in the Toolbar.

Eyedropper

Activates the Eyedropper in the Composition window.

Paint

Highlights and enables the Paintbrush tool in the Toolbar (obeys Brush 
Settings in Effect Controls window).

Eraser

Highlights and enables the Eraser tool in the Toolbar (obeys Brush Settings 
in Effect Controls window).

Options>Shift-Paint Records Strokes>

The Shift-Paint Records Strokes options control the start time of the strokes 
when you are in QuickPaint mode. QuickPaint mode is enabled by pressing 
the Shift key while you paint strokes. Each stroke is played back as it was 
drawn, but their start times are determined by the selection in this menu.

What is QuickPaint Mode?

QuickPaint allows for fast continuous recording of a sequence of strokes 
without redraw delays after each one. As the Shift key is held down, enabling 
QuickPaint Mode, all strokes you draw are recorded in realtime. Mouse-down 
events indicate the start time of a stroke, and mouse-up events indicate the 
end of a stroke's duration. The pauses, or interrupts, you make between 
strokes while drawing are not literally "recorded", but will result in a gap 
between a stroke's end time and next stroke's start time. The Shift-Paint 
Records Strokes option you select determines how to treat these gaps 
between strokes, and how that affects the recorded start time of each stroke. 
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Note: This is different than altering a stroke’s Playback Speed. 
Playback Speed increases or decreases the speed at which a 
stroke is played back once it’s been drawn. The Shift-Paint 
Records Strokes options adjusts where each stroke’s start time is 
placed on the timeline.

To Current Frame

All strokes will start at the current frame. (The frame where the Current Time 
Marker is sitting when they are drawn.)

To Sequential Frames

All strokes’ start times will be offset one frame each. The next frame is 
calculated according to the Comp’s frame rate at the time of drawing.

IMPORTANT: The Shift-Paint Records Strokes must be selected 
before drawing the strokes, and the Shift key must be depressed 
while the strokes are being drawn to enable QuickPaint mode.

Stroke 1 Stroke 2 Stroke 3
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Example: If current time marker is at 0:00 and three strokes are drawn in 
succession:  Stroke #1 will begin at 0:00, Stroke #2 will begin at 00:01 and 
Stroke #3 will begin at 00:02.

In Realtime

Strokes’ start times are determined by how they are drawn. The strokes are 
recorded and played back in realtime even if you mouse/pen-up while 
drawing. Strokes will play back exactly as they were recorded, including any 
time allowed between each stroke.

Example: If you draw a stroke and then pause for 2 seconds before drawing 
the next stroke, this time gap will be obeyed in playback. NOTE: The Shift key 
must remain held down during this pause.

Stroke 1 Stroke 2 Stroke 3

Stroke 1 Stroke 2 Stroke 3



CE 1.5 Manual

243 www.culteffects.com

Continuously

Strokes start times follow one another. When one stroke is finished drawing 
on the next one begins. The playback will not display time gaps allowed 
between strokes, even if you paused while drawing them.

Options > Stylus Radius

Select this menu item to turn Stylus pressure sensitivity to effect stroke 
Radius on or off. A diamond appears to the left of this menu item when it is 
on. This setting corresponds to the Stylus Radius setting in the Brush 
Settings in the Effect Controls window. 

Also see Brush Settings: Stylus Radius under Effect Controls.

Options > Stylus Opacity

Select this menu item to turn Stylus pressure sensitivity to effect stroke 
Opacity on or off. A diamond appears to the left of this menu item when it is 
on. This setting corresponds to the Stylus Opacity setting in the Brush 
Settings in the Effect Controls window.

Also see Brush Settings: Stylus Opacity under Effect Controls.

Stroke 1 Stroke 2 Stroke 3
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Options > Colorclone

Select this menu item to turn Colorclone on or off. A check mark appears to 
the left of this menu item when Colorclone is on. This setting corresponds to 
the Colorclone toggle in the Brush Settings in the Effect Controls window.

Also see Brush Settings: Colorclone under Effect Controls.

Options > Edit Preferences...

Access the CE Paint Preferences by selecting Edit Preferences... from the 
Options menu or by clicking on the underlined “Options...” at the upper right 
of the Effect Controls window.
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CE Paint Preferences

Access CE Paint Preferences by 
clicking on the underlined “Options...“ 
in the upper right corner of the Effect 
Controls window, or by selecting 
Options > Edit Preferences from the 
CE Paint Contextual Menu.

Stylus Vendor

If a tablet is installed, vendor information is displayed here. If no tablet is 
detected by the system, “No stylus detected” is displayed (this feature             
is Mac only).

Stylus Options

These options only apply when a stylus is connected.
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Use High Res. Coordinates

When checked, data is recorded with high resolution (if supported by the 
stylus). This setting overrides normal mouse coordinates to utilize the 
higher resolution of the tablet, recording strokes with greater precision 
and sub-pixel accuracy.

Note: Wacom currently does not support High Res. Coordinates if 
set to Proportional mode in the Wacom control panel. Use "One to 
One" or "to Fit" instead.

Disable Mouse Drawing

When checked, the mouse is disabled in CE Paint, allowing you to draw 
with the stylus only.

This feature allows you to navigate the After Effects interface with the 
mouse and to use the Stylus for drawing strokes. For example, use the 
mouse to click and drag on a layer to change it’s position, but click and 
drag on a layer with the pen to draw strokes.

IMPORTANT: If you experience offset coordinates with your pen, 
try the following:

• Check that screen resolution and monitor settings haven’t 
changed.

• If using Wacom tablet, make sure your tablet mapping aspect 
isn't set to Proportional. Use To Fit or One to One instead.

• Restart your system.

• If all else fails, turn off High Res. Coordinates. (Sub-pixel 
accuracy will be lost, Pressure and Eraser modes will still be 
available.)
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Interface Options

Better Preview While Drawing

When checked enables drawing of an anti-aliased preview in the Comp 
window. If un-checked CE Paint will draw a very rough preview that will 
work with any graphics card.

Note: If the preview does not appear to be drawing correctly, you 
may have an incompatible graphics card.

Show Actual Brush Size

When checked the brush size is represented in the Composition window 
by the cursor changing into a circle or square of the same size. If un-
checked, the normal cursor arrow is used.

Show Toolbar

When checked displays the Toolbar in the Composition window.

Swedish UI

An aesthetic improvement of the interface.

Onion Skinning Options

These settings apply when using the Playback Mode –Onion Skin.Use Onion 
Skin Options to set the number of backward or forward frames that are 
displayed. Onion Skinning will display BOTH backward and forward frames 
unless one of these values is set to 0.

Frames Backward/ Frames Forward

Sets the number of frames backward or forward that are displayed by 
onion skinning. Both backward and forward frames will be displayed 
unless one of these values is set to 0.
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Color Backward/Color Forward

Set’s the color of the display of onion-skinned backward and forward 
strokes.

Skin Opacity

Sets the opacity of the onion-skinned frames.
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Keyboard Shortcuts

General

Shift + Z:  Undo

Option/Alt + click: Bypass Paint.

Opt/Alt + Cmd/Ctrl + click: Access the After Effects Contextual Menus.

Selections

Shift + A:  Selects all strokes.

Shift + D: De-selects strokes.

Shift + W: Select visible strokes.

Shift + T: Select current time

Backspace: Deletes all selected strokes.

Shift + select: Toggle selection.

Command/Ctrl + select: Deselect.

Command/Ctrl + Shift + select: Add to selection.

Tools

Shift + C: Switch to Eyedropper tool (returns to the previous tool when done).

Command/Ctrl + click drag: Set Radius and Feather for Brush Settings.

Shift + Painting: QuickPaint using the selected mode in CE Paint’s Contextual   
                            menus

IMPORTANT: To enable keyboard shortcuts, CE Paint must be selected 
in the Effect Controls window and the Comp window must be the 
frontmost window.
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Transformations

Note the following when using the transformation keyboard shortcuts:

• All geometrical transformations (below) require a current selection.

• Holding down Shift increments all geometric transformations by 10 times.

• Holding down Command (Mac) or Control (Windows) performs scaling/
rotation on selected strokes individually as opposed to a group.

• Holding down both Shift and Cmd/Ctrl performs transformations on strokes 
individually by increments of 10.

Scale selected strokes

Option/Alt + (plus, on the numeric keypad):  Scale up by 1%.

Option/Alt  - (minus, on the numeric keypad):  Scale down by 1%.

Option/Alt + ↑ :  Increases the vertical scale (height) by 1%.

Option/Alt + ↓ :  Decreases the vertical scale (height) by 1%.

Option/Alt + →:  Increases the horizontal scale (width) by 1%.

Option/Alt + ←:  Increases the horizontal scale (width) by 1%.

Rotate selected strokes

+ (on the numeric keypad):  Rotates clockwise by 1°.

- (on the numeric keypad): Rotates counter-clockwise by 1°.

Re-position selected strokes

↑↓→← :  Nudges the position up, down, right or left by 1 pixel.
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General Overview

CE Radial Shadow creates a shadow 
from a point light source over the 
layer it’s applied to, rather than from 
an infinite light source (as with AE 
Drop Shadow). The shadow is cast 
from the alpha channel of the source 
layer, allowing the color of that layer 
to influence the color of the shadow 
as light passes through semi-
transparent areas. 

The shadow’s opacity, color, 
softness, as well as the positioning 
and distance of the light source are all 
adjustable and animatable. This filter 
is useful for simulating realistic 
(colored or black) shadows from a 
point light source over a layer.
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Controls

Shadow Color

Use the eyedropper or the Color Picker to choose the color of the shadow.

Note: This setting may be overridden by the color(s) of the layer if you 
choose the Glass Edges render option. See Glass Edges and Color 
Influence controls for more information.

Opacity

Determines the transparency of the shadow. 

Change the opacity of the shadow by adjusting the Opacity slider, or by 
clicking on the underlined opacity value and entering a percentage into the 
dialog box.

Animate the transparency of the shadow by setting keyframes for Opacity, 
causing it to become more or less opaque over time.

Light Source

Use the Light Source cross hair to position the point from which light is cast 
over the layer to create the shadow. Remember, you are setting the light 
source not the direction of the shadow, the shadow will fall in the opposite 
direction.

To adjust this control use one of the following methods:

1. Click once on the cross hair and drag the mouse in the Composition 
window to the desired position for the Light Source. Click once to place. 
A point control appears at that location. Drag the point control to make 
adjustments.

The Light Source control point

Note: The point control is visible only when the name of the effect (CE 
Radial Shadow) is highlighted in the Effect Controls window.
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2. Click once on the underlined X,Y coordinate values and enter 
coordinates numerically into the dialog box. (In After Effects the 
coordinates 0,0 indicate the upper left corner of the comp.)

Setting keyframes for the Light Source control allows you to animate the 
position of the shadow by moving the Light Source over the layer. For 
example, simulate a shadow cast from a spotlight traveling over the layer, or 
create a time lapse effect as if the sun were rising or setting over the layer.

Tip: Copy and paste position keyframes from another effect’s control 
point (for example: Lens Flare or FE Spotlight) to quickly create a 
shadow that matches another effect’s light source.

Projection Distance

This control determines the distance of the background surface (on which the 
shadow falls) from the layer and the light source. This distance affects the 
size of the shadow. 

In CE Radial Shadow, the distance between the light source and the layer 
remains fixed. The Projection Distance control allows you to move the 
background closer or further away (from the lightsource and the layer), 
making the shadow smaller or larger respectively. For example, think of the 
background surface as a projection screen, the light source as the projector 
and the layer as an object placed between the two.

Increasing the Projection Distance increases the size of the shadow, as it 
also increases the shadow’s distance from the source layer.

Low projection distance High projection distance
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To adjust the Projection Distance control do one of the following:

1. Use the Projection Distance slider in the Effect Controls window (preset to 
values between 0 and 50).

2. Click on the underlined Projection Distance amount and enter a value 
between 1 and 50 into the dialog box.

Animating this control allows you to increase or decrease the distance of the 
shadow from the layer over time.

Softness

The Softness control adjusts the softness or sharpness of the shadow’s 
edges. In the “real world” if a light source is very large, the edges of a shadow 
naturally appear more soft. Whereas, if the light source is very small, the 
shadow edges are sharper or more defined. This control allows you to adjust 
the softness of the shadow’s edges to simulate realistic shadows. Match the 
softness based on the size of the light source, or, if you choose, simply play 
with the definition of the edges of the shadow cast from the layer.

To adjust the Softness control use the Softness slider in the Effect Controls 
window (preset to values between 0 and 50), or click on the underlined 
Softness value and enter an amount between 0 and 100 into the dialog box.

Set keyframes for Softness to animate the definition of the edges of the 
shadow.

No softness High softness (Glass edge)
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Render

Choose the type of shadow you wish to render. 

Regular

Creates a shadow based on the Shadow Color and Opacity controls’ settings 
regardless of semi-transparent pixels in the original layer. 

Note: If this option is chosen the Color Influence control will be 
disabled.

Glass Edge

Creates a colored shadow based on the color and opacity of the original 
layer. If there are semi-transparent pixels in the source layer, the shadow 
rendered will be colored by the original color(s) and transparency of the layer. 
(Example: Think sun shining through a stained glass window.) 

The more transparent the pixels in the source layer, the closer the shadow 
color will match the colors of the original layer. Less transparent areas of the 
source layer are more influenced by the color chosen for the Shadow Color 
setting. 

Tip: Increase the semi-transparency of the edge pixels by increasing 
Softness, allowing more of the layer’s original colors to shine through.

Note: Anti-aliased edges will produce colors in a shadow when the 
Glass Edge option is selected, even when the layer is fully opaque. 
Selecting the Glass Edge option for a layer with an alpha channel, 
although it is 100% opaque (type, for example), will produce colored 
edges. The layer’s edges are anti-aliased, and therefore contain a bit 
of semi-transparency. The layer’s original colors will shine through 
these anti-aliased edges, while the Shadow Color fills the center of the 
shadow.
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If there are no semi-transparent pixels in the source layer, the Glass Edge 
option will have very little effect on the layer. The shadow’s color will be 
determined by the Shadow Color setting, with the exception of any semi-
transparent edge pixels around the edge of the layer. If the layer has an alpha 
channel or a blur applied the edges of the shadow will take on the color of the 
original layer.

If the Glass Edge option is selected the Color Influence control will appear 
enabled. See Color Influence control for more information.

Regular Glass Edge
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Color Influence

Note: This control is disabled when Render is set to Regular

Controls the amount of the source layer’s color values that appear in the 
shadow.  At the default setting for this control (100%) the shadow takes on 
the color of any semi-transparent pixels in the layer. If this layer contains no 
semi-transparent pixels, Color Influence has little or no effect, and the 
shadow is colored by the Shadow Color setting. (See NOTE below.)

Decreasing the Color Influence value blends the colors of the original layer in 
the shadow with the color chosen for the Shadow Color. Increasing Color 
Influence reduces the influence of the Shadow Color.

Animate Color Influence to reduce or increase the blending of the original 
layer’s colors with the Shadow Color over time.

Low color influence High color influence

Note: In some areas of a layer the Color Influence control may have 
little effect on the color of the shadow. As mentioned above, less 
transparent areas of the layer will take on the Shadow Color setting. 
As a result, the shadow for areas of the original layer containing higher 
opacity values will appear more blended with the Shadow Color rather 
than the source layer’s original color regardless of the Color Influence 
value.
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Composite Shadow

This check box determines whether or not the original layer will appear with 
the shadow. If checked, the original layer is displayed over the shadow. If un-
checked only the shadow is displayed. This control makes it possible to 
perform separate operations or Transfer Modes on the shadow itself, without 
influencing the original layer.

Resize Layer

The Resize Layer check box controls whether or not the original layer’s 
bounding box is obeyed as the edge of the layer when the shadow extends 
beyond it. If the shadow falls off the edge of the layer this check box is used 
to determine whether or not that area of the image is displayed. 

If the box is checked, the shadow area outside of the original layer’s bounding 
box is displayed, allowing the effected area to extend beyond the layer 
boundaries – the layer is “Resized”. If the box is un-checked, any area of the 
shadow falling outside of the original layer’s bounding box is cropped by the 
layer’s boundaries, obeying the layer’s original size. 

Resize amount is limited to four times the original layer’s size, or the 
maximum image size allowed in After Effects.

Resize layer off Resize layer on

Note: Checking Resize Layer will in most cases increase render time. 
It is not necessary to check Resize Layer if the shadow’s edges fall 
outside of the Comp frame. The edges will not be visible, therefore, 
there’s no reason to increase the layer’s size to include a shadow 
beyond the layer’s edges.

REFERENCE: For more information and examples, see the Basic Tutorial for 
CE Radial Shadow.
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General Overview

Deteriorates the edges of the source 
layer using fractal calculations to 
introduce structure to the alpha 
channel of a layer. Use CE Roughen 
Edges to give rasterized text or 
graphics a naturally “rough” look, 
such as eroded metal or typewriter 
text. Choose from various fractal 
types, and manipulate numerous 
controls to produce the desired static 
or animated edge treatment.
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Controls

Types

Select one of the following edge Type options from the pop-up menu.

Roughen Roughen Color Cut

Spiky Rusty Rusty Color

Cerox Cerox Color

Edge Color

Fill the affected areas with this color. Click on the Edge Color swatch to 
choose a color from the Color Picker, or use the Eyedropper to sample a 
color from the desktop. 

This control is disabled unless a Type with coloring options is selected 
(Roughen, Rusty, and Cerox).
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Border

Controls how far from an alpha channel edge the effect is introduced.

To set the Border width do one of the following:

1. Adjust the Border slider in the Effect Controls window (preset to values 
between 0 and 32.)

2. Click on the underlined Border value and enter an amount between 0 and 
500 into the dialog box.

Low Border High Border
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Edge Sharpness

This control determines how sharp or soft the roughened edge will appear.

Low values create softer edges, high values create sharper edges.

In cases where the original layer’s alpha channel is very sharp and the Border 
value is set low, use this control (set to a lower value) to soften the otherwise 
sharp edge.

To set the Edge Sharpness do one of the following:

1. Adjust the Edge Sharpness slider in the Effect Controls window (preset 
to values between 0 and 2.00.)

2. Click on the underlined Edge Sharpness value and enter an amount 
between 0 and 10 into the dialog box.

Low Sharpness High Sharpness

Fractal Influence

The Fractal Influence control determines how much of the introduced 
roughness should be influenced by fractal calculations.

To set Fractal Influence adjust the slider in the Effect Controls window, or 
click on the underlined value and enter an amount between 0 and 1.

Low Influence High Influence
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Scale

Scale the fractal used to calculate the roughness.

To set the Scale do one of the following:

1. Adjust the Scale slider in the Effect Controls window (preset to values 
between 20 and 300.)

2. Click on the underlined Scale value and enter an amount between 10 and 
1000 into the dialog box.

Low Scale High Scale

Stretch Width or Height

Stretch the width or height of the fractal used to calculate the roughness.

To set the Stretch Width or Height amount do one of the following:

1. Adjust the Stretch Width or Height slider in the Effect Controls window 
(preset to values between -5 and 5.)

2. Click on the underlined Stretch Width or Height value and enter an 
amount between -100 and 100 into the dialog box.

Width Height
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Offset (Turbulence)

The Offset control determines the portion of the fractal shape that is present 
in the Composition window, altering the shape of the distortion or roughness 
applied to your layer.

As mentioned above, the noise used to create roughness in CE Roughen 
Edges is generated by fractals. Because the fractal shapes are infinite in all 
directions, what appears in the Composition frame at any given time is only 
a small portion of the entire fractal. The layer’s bounding box behaves like a 
fixed viewing area, and the Offset control allows you to reposition the fractal 
within that view. Animating the Offset control repositions the fractal, bringing 
a different portion of it into view. This alters the shape and texture of the 
roughness.

To alter the Offset  do one of the following:

1. Click on the Offset cross hair, position it the in the Comp window, and 
click once to place. The Offset control point appears. Once it has been 
placed, click and drag to reposition it.

The Offset control point

2. Click on the underlined Offset value and enter new X,Y coordinates into 
the dialog box.
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Complexity

The Complexity control adjusts the level of detail in the roughness. 
Increasing the Complexity value increases the detailed definition in the 
texture of the roughness. Lower Complexity values result in smoother 
roughness. 

To adjust Complexity do one of the following:

1. Move the Complexity slider to the desired value (preset between 1 and 6). 

2. Click on the underlined Complexity value and enter a value (between 1 
and 10) into the dialog box. 

Animate the Complexity control to increase or decrease the visible level of 
detail in the roughened edges over time.

Note: Increasing Complexity will result in longer rendering times. If 
appropriate, try reducing the Scale control value rather than increasing 
Complexity to achieve similar results and to avoid a rendering hit.

Low Complexity High Complexity

Evolution

The Evolution control effects subtle changes in the shape of the roughness. 
Animating this setting will result in smooth changes or “evolution” of the 
roughness over time.

To change the Evolution setting do one of the following: 

1. Adjust the Evolution dial in the Effect Controls window.

2. Click on the underlined Evolution value and enter amounts for revolutions 
and degrees into the dialog box.
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In the case of Evolution (as with a few other effects’ controls, such as Twirl 
Angle in AE Twirl), the image continues to change with each added 
revolution. The appearance when set to a value of 0° is different from that at 
1 revolution, which is different from that at 2 revolutions, and so on. The 
Evolution state continues to progress infinitely at each new value. The only 
way to force the Evolution setting to return gracefully to its original state 
(necessary to create a seamless loop) is to use the Evolution Option, Cycle 
Evolution, explained below.

Set keyframes for Evolution to determine how much the roughness will 
“evolve” over the period of time allowed between keyframes. The more 
revolutions that are made within a given amount of time (between keyframes) 
the more rapidly the roughness will change. Higher Evolution values may 
result in flashing rather than smooth changes in the roughness.

IMPORTANT: Although the Evolution value is set in units called 
“revolutions”, it is important to realize that these revolutions are 
progressive. The term “revolution” usually refers to a setting that 
returns to the same value at the same point on the dial control every 
360°. For example, the value set at 0° usually appears the same as 
the value at 1 revolution (i.e. As with the transform property Rotation 
or the “Direction” control in AE Drop Shadow). 
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Evolution Options

Because of the complexity of the fractal noise that generates the roughness 
pattern in the Roughen Edges effect, render time can be consuming. For this 
reason, the Evolution Options provide controls that allow you to render the 
effect for one short(er) cycle and then simply loop it to repeat for the duration 
necessary for your project.

Cycle Evolution

Checking the Cycle Evolution check box creates a cycle of evolution that 
loops over the set amount of time. Cycle Evolution forces the evolution 
“state” to return to it’s starting point in order to create a looping animation.

Although copying and pasting Evolution keyframes will return Evolution 
to the same value, the animation will act like a ramp rather than a 
smoothly transitioning cycle, repeating itself as it interpolates between 
the keyframes. Use Cycle Evolution and the Cycle controls to create a 
smooth, progressive cycle, non-repeating cycle (or loop segment).

This control can save a great deal of rendering time. Use it to create one 
short seamless evolution cycle (where the last frame matches up to the 
first) to be pre-rendered and looped as a new source layer in a 
composition, rather than setting Evolution to animate over a greater 
number of frames. (See Creating a Seamless Loop below.)

Cycle

Note: This control is only available when the Cycle Evolution check 
box is checked.

The Cycle value determines the number of revolutions (of the Evolution 
setting) that the fractal noise will cycle through before it repeats. The 
timing or speed of these Evolution cycles is determined by the amount of 
time allowed between Evolution keyframes.

Note: The Cycle control affects only the state (Evolution) of the 
fractal, not geometrics or other controls. (e.g. Two identical states 
of the fractal will not appear the same if viewed with different Size 
or Offset settings.)
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Random Seed

This control sets a unique random value from which to generate the 
roughness texture.

Animating the Random Seed will result in flashing from one set of fractal 
shapes to another (within that fractal type). For smooth transition of the 
roughness use the Evolution control.

Tip: Easily create new roughness animations, by re-using 
previously created Evolution cycles and changing only the Random 
Seed value. Entering a new Random Seed value alters the noise 
pattern without disturbing the evolution animation. The Evolution 
keyframes and Evolution Options can be left untouched.

REFERENCE: For further examples of how to use the Evolution Options, see 
To Create a Seamless Loop (at the end of this chapter), the Evolution 
Options Appendix, and the Basic Tutorial for CE Roughen Edges.
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To Create a Seamless Loop

Follow the steps below to walk through the Evolution Control and Evolution 
Options.

1. Set two keyframes for Evolution. 

2. Adjust the time allowed between keyframes, and the number of Evolution 
revolutions until you are satisfied with the animation of the noise.

3. Check the Cycle Evolution Check box.

4. Set a value for Cycle.

The evolution will now cycle the number of revolutions determined by the value 
set for Cycle. This cycle will take place within the time allowed for that number of 
revolutions between the Evolution keyframes.

Determine the value for cycle by considering the following: How much of this 
cycle do you need to render before it repeats? The length of your piece and your 
use of the roughened texture created will determine this. Do you need 5 seconds 
of a non-repeating animated roughness for your edges? Is 3 seconds enough? 
You will want to choose the shortest length appropriate for your project to save 
rendering time.

A cycle is created. Initially, however, the last frame of a cycle is identical to the 
first frame. To create a seamless loop, you want to skip the last frame to avoid a 
duplicate frame in the loop. To do this, set the out point of the layer one frame 
before the last frame of the cycle. Continue following the instructions below. 

IMPORTANT:

1. When using Cycle Evolution to create a seamless loop set Evolution 
keyframes using full revolutions only. Avoid using degrees, as partially 
completed revolutions may create hiccups in your seamless loop. 

2. Choose a value for Cycle that either matches or is evenly divisible by 
the number of revolutions set for Evolution. This will ensure that your 
cycle is able to complete full revolutions rather than partial ones, again, 
avoiding any glitches in the cycle.

3. If you have set keyframes for any of the other controls, you must return 
them to their initial settings at the point on the timeline where the cycle 
begins to repeat. Otherwise, these properties will not loop. 
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5. Move the time marker to the point on the timeline where your Cycle 
completes. (i.e., if your Cycle value is 2, find the frame on the timeline where 
your Evolution value is 2 revolutions.

6. Move the time marker back one frame.

7. Trim the layer’s out point at this frame.

8. Pre-render this layer, and import it into your project. 

9. Set this pre-rendered footage item to loop by selecting it in the Project 
window and choosing File> Interpret footage. Find the Loop field at the 
bottom of the Interpret Footage dialog box, and set the number of loops 
required for the duration of the layer within your project.

REFERENCE: For further examples of how to use the Evolution Options, see the 
Evolution Options Appendix and the Basic Tutorial for CE Roughen Edges.
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General Overview

CE Turbulent Displace uses fractal 
noise to create turbulent distortions in 
an image. This effect is great for 
adding distorted movement to a layer. 
For example, use it to create flowing 
water, funhouse mirrors, and waving 
flags.
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Controls

Displacement

This menu allows you to select the type of turbulence used to create your 
distortion. 

Choose the Displacement type that best suits the distortion you wish to 
create from the pop-up menu. 

Turbulent, Bulge, and Twist have both basic and Smoother options available. 
The Smoother options use more advanced calculations for higher quality. 
Note that using the Smoother options will increase rendering time.

Vertical Displacement warps the image only vertically.

Horizontal Displacement warps the image only horizontally.

Cross Displacement warps the image both vertically and horizontally.

Below are some illustrations of the Displacement types: 

Turbulent Bulge Twist

Turbulent smoother Bulge smoother Twist smoother
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Horizontal Vertical Cross

Amount

Use the Amount control to set the amount of displacement in the layer. Higher 
Amount values will result in more distortion in the layer.

To adjust the Amount control do one of the following:

1. Use the Amount slider in the Effect Controls window (preset to values 
between 0 and 100).

2. Click on the underlined Amount value and enter a number (between -
10,000 and 10,000) in the dialog box.

Animate the Amount control by setting keyframes. Animating this control will 
increase or decrease the amount of distortion in the turbulent areas over 
time.

Size

Use the Size control to set the size or radius of the displaced or distorted 
areas in the layer. Higher Size values will result in larger areas of distortion.  

To use the Size control do one of the following:

1. Drag the Size slider in the Effect Controls window (preset values between 
5 and 400).

2. Click on the underlined Size amount and enter a value (between 2 and 
1000) in the dialog box.

Set keyframes for the Size control to cause the areas of turbulence to grow 
or shrink over time.
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Offset

The Offset control determines the portion of the fractal shape that is present 
in the Composition window, altering the shape of the distortion on your layer.

As mentioned above, the turbulence used to create distortions in CE 
Turbulent Displace is generated by fractals. Because the fractal shapes are 
infinite in all directions, what appears in the Composition frame at any given 
time is only a small portion of the entire fractal. The Comp window behaves 
like a fixed viewing area, and the Offset control allows you to reposition the 
fractal within that view. Animating the Offset control repositions the fractal, 
bringing a different portion of it into view. This alters the shape of the 
distortion.

To alter the Offset  do one of the following:

1. Click on the Offset cross hair, position it the in the Comp window, and 
click once to place. Once it has been placed, click and drag to reposition 
it.

Offset control point

2. Click on the underlined Offset value and enter new X,Y coordinates into 
the dialog box.

Complexity

The Complexity control adjusts the level of detail in the turbulence. 
Increasing the Complexity value increases the detailed definition in the 
displacement pattern. Lower Complexity values result in smoother 
distortions. 

To adjust Complexity do one of the following:

1. Move the Complexity slider to the desired value (preset between 1.0 and 
10.0). 

2. Click on the underlined Complexity value and enter a value (between 1 
and 20) into the dialog box. 

Animate the Complexity control to increase or decrease the visible level of 
detail in the fractal shapes over time.
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Note: Increasing Complexity will result in longer rendering times. If 
appropriate, try reducing the Size control rather than increasing 
Complexity to achieve similar results and to avoid a rendering hit.

Low complexity High complexity

Evolution

The Evolution control effects subtle changes in the shape of the turbulence. 
Animating this setting will result in smooth changes or “evolution” of the 
turbulence over time. (Example: flags waving, water flowing)

To change the Evolution setting do one of the following: 

1. Adjust the Evolution dial in the Effect Controls window.

2. Click on the underlined Evolution value and enter amounts for revolutions 
and degrees in the dialog box.

IMPORTANT: Although the Evolution value is set in units called 
“revolutions”, it is important to realize that these revolutions are 
progressive. The term “revolution” usually refers to a setting that 
returns to the same value at the same point on the dial control every 
360°. For example, the value at 0° is usually the same as the value at 
1 revolution (i.e. As with the transform property Rotation or the 
“Direction” control in AE Drop Shadow). 
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In the case of Evolution (as with a few other effects’ controls, such as Twirl 
Angle in AE Twirl), the image continues to change with each added 
revolution. The appearance when set to a value of 0° is different from that at 
1 revolution, which is different from that at 2 revolutions, and so on. The 
Evolution state continues to progress infinitely at each new value. The only 
way to force the Evolution setting to return gracefully to its original state 
(necessary to create a seamless loop) is to use the Evolution Option, Cycle 
Evolution, explained below.

Set keyframes for Evolution to determine how much the turbulence will 
“evolve” over the period of time allowed between keyframes. The more 
revolutions that are made within a given amount of time (between keyframes) 
the more rapidly the turbulence will change. Higher Evolution values may 
result in flashing rather than smooth changes in the turbulence.

Evolution Options

Because of the complexity of the turbulent noise that generates the 
displacement patterns in the Turbulent Displace effect, render time can be 
consuming. For this reason, the Evolution Options provide controls that allow 
you to render the effect for one short(er) cycle and then simply loop it to 
repeat for the duration necessary for your project.

Cycle Evolution

Checking the Cycle Evolution check box creates a cycle of evolution that 
loops over the set amount of time. Cycle Evolution forces the evolution 
“state” to return to it’s starting point in order to create a looping animation.

Although copying and pasting Evolution keyframes will return Evolution 
to the same value, the animation will act like a ramp rather than a 
smoothly transitioning cycle, repeating itself as it interpolates between 
the keyframes. Use Cycle Evolution and the Cycle controls to create a 
smooth, progressive cycle, non-repeating cycle (or loop segment).

This control can save a great deal of rendering time. Use it to create one 
short seamless evolution cycle (where the last frame matches up to the 
first) to be pre-rendered and looped as a new source layer in a 
composition, rather than setting Evolution to animate over a greater 
number of frames. (See Creating a Seamless Loop.)
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Cycle

Note: This control is only available when the Cycle Evolution check 
box is checked.

The Cycle value determines the number of revolutions (of the Evolution 
setting) that the fractal noise will cycle through before it repeats. The 
timing or speed of these Evolution cycles is determined by the amount of 
time allowed between Evolution keyframes.

Note: The Cycle control affects only the state (Evolution) of the 
fractal, not geometrics or other controls. (e.g. Two identical states 
of the fractal will not appear the same if viewed with different Size 
or Offset settings.)

Random Seed

This control sets a unique random value from which to generate the 
turbulence.

Animating the Random Seed will result in flashing from one set of fractal 
shapes to another (within that fractal type). For smooth transition of the 
turbulence use the Evolution control.

Tip: Easily create new turbulence animations, by re-using 
previously created Evolution cycles and changing only the Random 
Seed value. Entering a new Random Seed value alters the noise 
pattern without disturbing the evolution animation. The Evolution 
keyframes and Evolution Options can be left untouched.

For further examples of how to use the Evolution Options, see To Create a 
Seamless Loop (at the end of this chapter), the Evolution Options Appendix, 
and the Basic Tutorial for CE Turbulent Displace.
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Pinning

The Pinning control forces the selected edge (or edges) to remain pinned in 
it’s initial position. 

The various options work as follows:

None

Applies no pinning for any of the edges. The edges are freely affected by the 
turbulence.

No Pinning

Pin All

Pins down all of the layer’s edges, minimizing the effect of the turbulence on 
the layer’s edges.

Pin all
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Pin Horizontal

Allows horizontal displacement, but blocks vertical displacement  at the 
horizontal edges. Minimizes the effect of the turbulence on the layer’s 
horizontal (top and bottom) edges.

Pin horizontal

Pin Vertical 

Allows vertical displacement, but blocks horizontal displacement  at the 
vertical edges. Minimizes the effect of the turbulence on the layer’s vertical 
(left and right) edges.

Pin Left, Pin Right, Pin Top and Pin Bottom 

Pins the respective edge of the layer, minimizing the effect of the turbulence 
along that edge.

Pin left
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Locked Options

Absolutely forces the pinning of each of the respective edges of the layer. 
The Locked edges will not react to the applied turbulence. In some cases, 
when using the regular pin options, portions of the pinned edges will still peel 
away from their original positions. (Note the use of the word “minimizing” 
above.) The Locked options force the edges to REALLY remain locked down. 

For example, Pin Vertical Locked blocks both vertical and horizontal 
displacement at the vertical edges. As opposed to Pin Vertical (above) which 
blocks only horizontal displacement at these edges.

Pin all locked

Resize Layer

Allows the distorted image to exceed the layer’s bounding box. Ensures that 
the entire layer is displayed even when the displacement forces it to stretch 
beyond the size of the original.

Resize off Resize on

Note: Does not apply when Pinning is set to Pin All or Pin All Locked.
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Antialiasing

When the layer is set to best quality, use this control to set the antialiasing of 
the displacement pattern to either Low or High. If Low is sufficient for the 
distortion you create, choose this option, as high will increase rendering time. 
Low is sufficient in most cases.



CE 1.5 Manual

285 www.culteffects.com

Example

To Create a Seamless Loop

Follow the steps below to walk through the Evolution Control and Evolution 
Options.

1. Set two keyframes for Evolution. 

2. Adjust the time allowed between keyframes, and the number of Evolution 
revolutions until you are satisfied with the animation of the noise.

3. Check the Cycle Evolution Check box.

4. Set a value for Cycle.

The evolution will now cycle the number of revolutions determined by the 
value set for Cycle. This cycle will take place within the time allowed for that 
number of revolutions between the Evolution keyframes.

Determine the value for cycle by considering the following: How much of this 
cycle do you need to render before it repeats? The length of your piece and 
your use of the turbulence created will determine this. Do you need 5 
seconds of a non-repeating animated turbulent distortion? Is 3 seconds 
enough? You will want to choose the shortest length appropriate for your 
project to save rendering time.

IMPORTANT:
1. When using Cycle Evolution to create a seamless loop set 
Evolution keyframes using full revolutions only. Avoid using degrees, 
as partially completed revolutions may create hiccups in your 
seamless loop. 

2. Choose a value for Cycle that either matches or is evenly divisible 
by the number of revolutions set for Evolution. This will ensure that 
your cycle is able to complete full revolutions rather than partial ones, 
again, avoiding any glitches in the cycle.

3. If you have set keyframes for any of the other controls, you must 
return them to their initial settings at the point on the timeline where 
the cycle begins to repeat. Otherwise, these properties will not loop. 



CE 1.5 Manual

www.culteffects.com 286

A cycle is created. Initially, however, the last frame of a cycle is identical to 
the first frame. To create a seamless loop, you want to skip the last frame to 
avoid a duplicate frame in the loop. To do this, set the out point of the layer 
one frame before the last frame of the cycle. Continue following the 
instructions below. 

5. Move the time marker to the point on the timeline where your Cycle 
completes. (i.e., if your Cycle value is 2, find the frame on the timeline 
where your Evolution value is 2 revolutions.

6. Move the time marker back one frame.

7. Trim the layer’s out point at this frame.

8. Pre-render this layer, and import it into your project. 

9. Set this pre-rendered footage item to loop by selecting it in the Project 
window and choosing File> Interpret footage. Find the Loop field at the 
bottom of the Interpret Footage dialog box, and set the number of loops 
required for the duration of the layer within your project.

REFERENCE: For further examples of how to use the Evolution Options, see 
the Evolution Options Appendix and the Basic Tutorial for CE Turbulent 
Displace.
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Evolution Appendix 

This supplement is meant to serve as a reference providing further explanation 
of the Evolution and Evolution Options controls. You will find these controls within 
the following Cult Effects v1.5 filters:

CE Cell Pattern
CE Noise Alpha
CE Noise Turbulent
CE Noise Turbulent II
CE Roughen Edges
CE Turbulent Displace

The following segments provide examples as to when and how to use the various 
Evolution and Evolution Options controls to achieve a desired result.

EXAMPLE #1: The Evolution Control

The Evolution control effects subtle changes in the shape of the fractals used to 
create whichever type of noise you are working with (e.g. cellular shapes, 
turbulent noise, turbulent displacement). Animating this control results in smooth 
changes or evolution of that noise pattern over time.

In this Example evolution keyframes are set at 0:00 and 4:00. Cycling has not 
been enabled. The result is constantly evolving noise between the times at which 
the keyframes are set. (eaImage01.eps)
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EXAMPLE #2: The Cycle Control

As mentioned in the individual filters’ manuals, the Cycle value determines the 
number of revolutions(of the Evolution setting) that the fractal noise will cycle 
through before it repeats.The timing or speed of these Evolution cycles is 
determined by the amount oftime allowed between Evolution keyframes.

Here, as in Example #1, keyframes are set for Evolution with 0 revolutions at0:00 
and 4 revolutions at 4:00. The Cycle value is set to 4 revolutions. The cycle is 
repeated (the fractal noise returned to it s original state of 0 revolutions) after4 
revolutions. The result: 4 revolutions are completed between 0:00 and 4:00.

Set your end time (the end of the work area in the Time Layout window) to 
oneframe before the last keyframe and render to create a seamless loop of this 
cycle.

Note: The Cycle control affects only the state (Evolution) of the fractal, not 
geometrics or other controls. (e.g. Two identical states of the fractal will not 
appear the same if viewed with different Size or Offset settings.)
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EXAMPLE #3: Changing the Cycle Value

The Cycle value repeats the state of the fractal after the set number of cycles is 
complete. This occurs at the time interval determined by Evolution keyframes.

In this example, as in Example #2, the Evolution keyframes are set at 0:00 
and4:00, however, the Cycle value has been changed to 2. Therefore, the cycle 
repeats after 2 revolutions (of the Evolution control). According to the timing set 
by the Evolution keyframes, the 2 cycles are complete at 2:00. Therefore, we will 
have 2 full evolution cycles of 2:00 each within our 4 seconds.

Set the end time one frame before the cycles are complete, before the cycles are 
complete, render and re-import your seamless loop.
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EXAMPLE #4: Render only what you need

If you have the set up described in Example #3, and need only a 2 second loop 
for your project, you only need to render the first cycle. The second cycle is a 
waste of render time.

Again, set the end time one frame before the first cycle is completed, and render 
and re-import your seamless loop.

Tip: Twirl down Effects > [Effect Name] to view Evolution in the After Effects 
Time Layout window. Here you can watch the Evolution value update as 
you advance/reverse the Current Time Marker along the time-line. Step 
forward or backward a frame at a time (using the page up or page down 
keys) to locate the time where the cycle completes.
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EXAMPLE #5: Changing the Speed of the Evolution Cycle

Altering the timing of the Evolution keyframes adjusts the speed of an Evolution 
cycle.

The following examples show how Evolution speed for a loop can be altered by 
moving the end Evolution keyframe in the timeline.

Original Setup

Keyframes are set and 0:00 and 4:00. Cycling is enabled and set to every 4th 
revolution. The result is 1 cycle between the keyframes set at 0:00 and 4:00. Set 
the end time one frame before the last keyframe and render your seamless loop.

Faster Cycle

Move the end keyframe to 2:25. Set the end time one frame before the last 
keyframe (at 2:24) and render and re-import your seamless loop.
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Slower Cycle

Move the end keyframe to 5:00. Set the end time one frame before the last 
keyframe (at 4:29) and render and re-import your seamless loop.

EXAMPLE #6: Working with multiple layers

When combining two or more layers of fractal noise, with different cycle settings 
over the same amount of time, into a single loop, it may be easier to render out 
one whole sequence, rather than pre-rendering each shorter loop and importing 
it again.

In the illustration below, keyframes are set at 0:00 and 4:00 at the number of 
revolutions shown, for 3 different fractal noise layers. Cycling is enabled for each 
as follows:

- Layer 1:

Keyframe at 4.00 set to 4 Evolutions. Cycle set to every 2nd revolution, resulting 
in 2 cycles between the keyframes.

- Layer 2:

Keyframe at 4.00 set to 6 Evolutions. Cycle set to every 2nd revolution, resulting 
in 3 cycles between the keyframes.

- Layer 3:

Keyframe at 4.00 set to 4 Evolutions. Cycle set to every 4th revolution, resulting 
in 1 cycle between the keyframes. Set the end time one frame before the last 
keyframe (at 3:29), render and re-import your seamless loop.

Set the end time one frame before the last keyframe (at 3:29), render and re-
import.
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In this case, pre-rendering each layer’s cycle would mean 3 separate pre-
renders. Although Layers 1 and 2 could be pre-rendered, re-imported and looped 
after the first cycle, it makes more sense in this case to render all three cycles at 
once. The result is one 4 second layer, which can be looped if necessary.

Solid 1

Solid 2

Solid 3
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